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About this guide 1

Intr oduction This guide is designed to help you use the Norstar Manager software. This guide
explains how you:

. set up and maintain the Norstar Manager database
. change a customer's Norstar Business System programming

. maintain Norstar Business Systems

This section explains what is contained in this guide and the conventions used to
show Norstar Manager screens, commands, options, and menus.

Note: Screens in this guide are based on the NA-MICS-DR 1.1,

CDA-MICS-XC 1.1 and USA-MICS-XC 1.1 product line.

How this guide The Norstar Mana ger for Windo ws™ User Guide is divided into 12 sections that
isorganized  cove"

About this guide
This section explains how this guide is organized and the conventions used in the
guide.

Learning about Nor star Mana ger
This section explains how you use the Norstar Manager screens, the different
menus, and the icons.

Installing Nor star Mana ger
This section explains how you install and start the Norstar Manager application on
your personal computer (PC).

Preparing and ad ding Nor star system inf ormation

This section explains how to complete a Norstar Mana ger for Windo ws™
Programming Recor d and add Norstar system information to the Norstar
Manager database.

Microsoft is a registered trademark and Windows is a trademark of Microsoft Corporation.
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Other documents

Making an on-line connection
This section explains how you make an on-line connection to a Norstar system.

Programming a Norstar System
This section explains how you add Norstar programming information to a Norstar
system.

Backing up and restoring Nor star system inf ormation

This section explains how you copy programming from a Norstar Key Service Unit
(KSU) and store it in the Norstar Manager database. This section also explains
how you send a copy of Norstar system programming, stored in the Norstar
Manager database, to a Norstar KSU.

Copying Nor star systems
This section explains how you copy Norstar system programming to other Norstar
systems and how to perform an upgrade.

Norstar Mana ger repor ts
This section explains how to print Norstar Manager reports. It also describes how
to access the Inventory Summary screen and how to print key labels.

Maintaining a Nor star KSU
This section explains what is involved in maintaining a Norstar KSU.

Applications of Nor star Mana ger
This section gives examples of common uses for Norstar Manager.

Appendix A: Programming Recor ds
The appendix contains the Norstar Mana ger for Windo ws™ Programming
Records and a table of various software versions and KSU types.

For more information about Norstar Manager, refer to:

. Norstar Mana ger for Windo ws ™ Reference Guide
. RAD Installation Guide
. Norstar Mana ger for Windo ws ™ Programming Recor ds

. Norstar Companion Alarm and Event Code Man ual
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Conventions This guide uses certain conventions to present information about Norstar
Manager. These conventions address:
. pressing keys
. choosing action buttons
. highlighting text
. selecting items
. choosing items
Pressing ke ys
As you work through this guide you will notice some words appear in smaller type,

surrounded by a square box. These words represent keys found on a PC
keyboard.

For example: Press

Choosing action b uttons

Words that appear with grey boxes behind them represent action buttons. They
perform the task they are labeled with or change the display to a different Norstar
Manager screen.

For example: Choose

Highlighting te xt

Certain conventions are also used in the steps describing how you perform a task.
When a step describes a field as being highlighted, it means the text appears in
inverse video. When you move the cursor to a field, the color of the text and back-
ground in that area changes. The exact color depends on your Windows setup.

For example:

10 |221 Monique M7324

102 222 Carol M7324

In the example above, the line of text with the set Monique is highlighted.

Selecting items

Frequently, a step will ask you to select an item. When you select an item, you are
preparing it for some other task, such as editing. To select an item, use the
mouse, cursor keys or to place the selection cursor on the item. Selected
items are either highlighted, surrounded by a dotted rectangle, or both.

Choosing items

Choosing an item is different from selecting it. When you choose an item, you
perform a task or pick a value or option. To choose an item, use the mouse or
press (tan ] and [enter ] OF [Space ]
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Learning about Nor star Mana ger 2

Intr oduction Norstar Manager is a software package that assists you in administering, main-
taining, and programming a Norstar KSU (Key Service Unit). Norstar Manager
helps you perform programming tasks, such as programming feature keys on sets.

Before you can begin using Norstar Manager, you need to know:

. how Norstar Manager works
. the different screens and menus
. about selecting tasks from a screen

. how to use the Norstar Manager Help screens

This section explains how to move within the Norstar Manager program.

System Norstar Manager is designed to help you program and support a Norstar system
Overview more efficiently. The application is installed on a personal computer (PC) located
at the Norstar Key Service Unit (KSU) site, or at your office. Norstar Manager
allows a PC to communicate with a KSU.

PC and KSU communication occurs through a Remote Access Device (RAD).
There are four types of device: the RAD, Global RAD, FastRAD, and Internal RAD.
Each RAD allows a PC and KSU to exchange information. This information
exchange can occur in three ways:

1. The RAD is connected directly to the PC through the RAD’s RS-232 port.
This is known as a direct connection.

2. The PC uses a modem or DCI to make a remote connection with a RAD.
This connection is used when a PC is not located at the customer site.

3. The PC uses a modem or DCI to make an operator assisted connection with
a RAD. This connection is used when a PC is not located at the customer
site and Norstar Manager needs assistance from the customer to connect to
the RAD.

Norstar Manager for Windows™ User Guide



2-2 Section 2: Learning about Norstar Manager

Norstar KSU programming and system information are stored on a database in
the PC. This database acts like a central file for all Norstar information and
programming. Figure 2.1 shows the different components of the Norstar Manager
system, and how the components are connected.

TCM cord connects the RAD to the
distribution block (maximum 100 feet)

Norstar KSU

RAD

RS-232 cable connects the PC and
the RAD (maximum 50 feet)

Personal Computer

Figure 2.1 — System overview of a direct connection
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Section 2: Learning about Norstar Manager 2 -3

How Nor star Norstar Manager works through a series of screens and menus. These allow you
Manager works to navigate through the different areas of the application and easily enter Norstar
information and programming.

About the screens Screens are like information forms that you fill out on the PC. These screens
contain some information you can edit and some information you can view only.
The information you can choose or select, you can edit.

Note: How to choose or select information is discussed later in this section.

Norstar Manager screens consist of four basic parts: a title bar, a menu bar, a
status bar and a main body.

The title bar is at the very top of the screen and normally contains the title of the
screen. On system, line or set programming screens, the actual title of the screen
is in the main body of the screen and the title bar lists the programming section
you are in (e.g. Norstar Manager-Line Programming).

The menu bar is directly below the title bar and lists the menus available for the
screen.

The status bar is at the bottom of the screen and lists status information such as
the date and time.

The main body is between the menu bar and the status bar. This is the area where
you read and edit information about the Norstar system and its programming.

[ Title bar

E Morsisr Maonsgei-fuld Syabam

B Spitem Spuiem 10 [2775055527 | 4e S Menu bar
Cuptonms Wame: W5 10
K51 Losslbsn [Laa
Ao Iizlnmum

Contact: [P
Plhame pamber. [F2206I7 ——— Main body
el st L mmt el
Al phose number |!‘E'.'".-T1-E‘.|-?i

RAD pamampiid |35 I55855 20 |
Femzln hme dffmence (=00 =| e o lecal se

Tppaz &l epciem Ill M cadulan d Frs

Bidlsi & weis b | CIA-WICE=E 1.0 :I 4

Sypatum langmage [+ Ergics,fracch =
thlrF#H-:-e pueitlpd ] 5 bor hoan ool et winie =]
|

-
|ﬂ'-'=' ML BEAhAE %1445 Ak — Status bar

Figure 2.2 — The screen components
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Dialog bo xes If Norstar Manager needs more information on a specific field, or has a message
for you, a dialog box appears on the screen.

For example, when you choose the Start On-line Session... menu item from the
File menu on the Systems Director y screen, a dialog box appears prompting you
to enter information about the method of connection.

| Norstar Manager-Systems Directory =] 5 [
File Edit Change wiew Scheduler Preferences Help

Systems Directory

Customer Database Path
| C:\WNORS3 |

Customer

Last Backup

-

Compact

MICS 1.1 Start On-line Session

COM Port: | T TR -
Connect typpe: IbHemute ;lJ
Baud rate: | » 9500 LIJ

BAD phone number: | 2225555522
Modem init string: |AFQ0V1EC14D257=85450

Connection device: | » Modem J
Dial mode: [ * Tone ;Ij
| Cancel I | Done I

Ready [ NUM | | [06/02/98 9:31:26 AM

Figure 2.3 — Example of a dialog box
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Moving within a Moving within a screen is easy. Use the mouse to move to any field or button
screen shown on the screen. If a mouse is not available, use keyboard commands to
move around the screen. Table 2.1 shows the key commands that move the cursor
to different areas of a screen.

Key commands Function

Press or or or move within a field, or between fields in a
list

Press [tab move from field to field

or press

Press and move back to the previous field

or press

Press move down a page in a list

Press move up a page in a list

Press move to the top of a list or the beginning
of a line in a scroll region

Press [end move to the bottom of a list or the end of
a line in a scroll region

Table 2.1 — Key commands for navigating through a screen

Selecting items Before performing a function on an item, such as a text box or list box, the item
must be selected. To select an item, use the mouse (or key commands) to place
the selection cursor on the item. When an item is selected, that item will change
appearance to indicate that it is selected. When selected:

. list boxes are highlighted or surrounded by a dotted rectangle

. text boxes are highlighted or have the insertion cursor within the box

To select an item using the mouse, move the mouse pointer onto the item and
press the mouse button.

To select an item using key commands, press (rab until the desired item is
highlighted or surrounded by a dotted rectangle.

After you select an item, it is ready for you to choose one of the options or edit the
field.

Note: In this manual, choosing an item is different from selecting the item. When
you select an item, the item is being prepared for another action. For example,
selecting a text box moves the cursor into the text box so you can enter new text or
edit the old text. When you choose an item, you are performing the task or acti-
vating the option the item represents. For example, choosing the Done action
button will end the current task.

Norstar Manager for Windows™ User Guide



2-6 Section 2: Learning about Norstar Manager

Selecting m ultiple
items

Choosing tasks

Using action b uttons

Using quic k keys

In some list boxes, multiple options can be selected.
To select multiple options using the mouse:

1.  Select the first option.

2.  Press and hold while you select each of the other options. To remove
the selection of an option, select it a second time while holding

There are four ways to choose tasks and navigate through the Norstar Manager
application. You can use:

. action buttons

. quick keys

. accelerator keys

. screen and cascade menus

Action buttons appear on screens. These buttons are labeled with the task they

perform or the screen that will be displayed. For example, is an

action button that appears on the Add System screen. When you choose this
action button, you cancel the task of adding a new Norstar system to the
database.

To choose an action button using the mouse:

1. Move the mouse cursor onto the action button and press the left mouse
button.

To choose an action button using the cursor keys:

1. Press until the desired action button is selected.
Note: When a button is selected, the border around the button becomes
darker.

2. Press [enter ] Or [space ] When the button is selected.

Sometimes action buttons appear with the label shown in light grey type. When
this occurs, you cannot select the button.

For example: | Update status

A quick key is a combination of two keys used together. Quick keys allow you to
quickly choose action buttons and menu items. The quick key is a combination of
Alt and another key. The other key appears underlined in a menu or on an
action button.

For example: File

When you press and you have chosen the File menu.

Norstar Manager for Windows™ User Guide
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Using accelerator Accelerator keys are similar to quick keys in that they allow you to quickly choose
keys menu items. To use an accelerator key, type the key combination that is shown
with the menu item. For example, on the System Director y screen you can type
[P] to choose the Chang e Customer P ath... menu item from the File
menu.

About the men us Menus are lists of options that are available for a field or screen. There are two
types of menus: screen menus and cascade menus.

Screen men us

Screen menus provide you with options for accessing different programming,
communication, and maintenance task screens. To open a screen menu, select
the name of the menu from the menu bar using the mouse or the accelerator keys.
Once the menu is open, choose the desired menu item using the mouse or the
arrow keys and Figure 2.4 shows a sample screen menu from the
Systems Programming Over view screen.

[E Morstar Manager-System Programming Overview
File Program  Maintenance  Reports Help
[EopySet. ShiftHEt e Target Lines
Copy Line... Shift+Ctel+0 Type =] The Recd # Name l;l
E Inifigie System.. Shitecuy PSR- [ Line121  —
: | itralize Set ShiftHEt =S wised 122 Linel122
1 Initialize Line Shift+Ctel+ wizged 122 Line123
*  SotbyPart AleShitsp  [vised 124 Line124
¢ SotbyDMandLline Al+Shit+D  [vised 125 Line125
F Sort by Mame Alt+5hife+ wized 126 Line126
: Update Addons Alt+5hift+L1 wised 127 Linel27
208 003 Linel0%  Unsupervised 128 Line128
209 009 Line0D9  Unzupervised = 129 Linel29 -
Sets
Port DH Mame Type =]
101 221 221 M7310 —
102 2222 2222 M7310
103 2223 2223 Unequipped
104 2224 2224 Unequipped
MICS 1.1 105 2225 2225 Unequipped
Syztem: Modular 106 2226 2226 Unequipped
Customer Mame: MICS 1.1 107 2227 2227 Unequipped
KSU Location: Telephone room 108 2228 2228 Unequipped -
System ID: 1115551235 <1 ;I_I
Ready [ [ [ | 1047796 10:51:18 AM |

Figure 2.4 — Example of the System Programming Overview screen menu

Norstar Manager for Windows™ User Guide



2-8 Section 2: Learning about Norstar Manager

Entering Nor star
system
information

Diff erent types of
fields

Screen menus often show different symbols beside the menu items. These
symbols represent an instruction. Table 2.2 shows the symbols and explains what
each symbol means.

Symbol Indicates

> If you choose this option, a cascade menu appeatrs.

This icon indicates a dialog box is available for this field.

accelerator key When you press the key sequence shown, the menu item

(e.g. Ctrl+Q) is chosen.

Table 2.2 — Menu symbols

Cascade menus

A cascade menu is part of a screen menu. This menu provides an additional set of
options to the screen menu. A cascade menu appears when you choose a menu
item that has a p- symbol beside it.

For example, if you choose the System menu item from the Program menu, a
cascade menu of system programming options appears beside the screen menu.

Norstar information and programming is entered into the Norstar system through
the Norstar Manager screens. Before you enter Norstar information and program-
ming in the Norstar system, you should know:

. what the different types of fields are

. how to use check boxes

The kind of information you enter into a field, and how you enter it in, is deter-
mined by the type of box that surrounds the field. These boxes determine whether
the data is entered directly or by choosing an item from a list box.

The cursor also tells you how data is entered into fields. The cursor appears as a
flashing black, vertical bar. When the cursor is positioned on a field and is
flashing, you can type information directly from the keyboard. When the cursor is
not visible, you must select a value from the list box. Table 2.3 shows the different
types of fields.
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Field appearance

Type of entr y allo wed

direct entry from the keyboard

1 .
choose one or several of the options
shown

¥
| o choose one of the options shown when

the drop list arrow is chosen

choose one of the options shown when
the drop list arrow is chosen or enter an
option directly from the keyboard

\Drop list arr ows

Table 2.3 — The different types of Norstar Manager fields and entries allowed

When you are typing information into a field, you can move around within the field
and make corrections, or change the information you have entered. The easiest
way to move around in these fields is to use the mouse. If a mouse is not avail-
able, you can also use key commands. Table 2.4 shows the different key
commands you can use to move within a field.

Key commands

Function

Press or or or

move within a field

Press

toggle between insert and overwrite data

Press [Del ] or [Backspace

delete data

Press

move to the beginning of a field

Press [end

move to the end of a field

Press

moves the cursor down one line in a
multi-line direct entry field (e.g. Address
field on Add System screen)

Table 2.4 — Field editing key commands
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Using ¢ heck boxes

Using the Help
screens

Check boxes allow you to select parameters. Check boxes appear as squares and
are usually in groups.

All, several, or none of the boxes can be chosen. For example, when you are
choosing features for a set you may want to choose several.

Set abilities:

Full Handsfree

(] Auto handsfree
Handsfree answerback
[ Priority call
I Auxiliary ringer
[J Redirect ring

When you choose one of the boxes in the group, the symbol [0 appears in the
box. This indicates that the feature beside this box is on or active. In the example
above, the set will have Full Handsfree and Handsfree answerback active.

To choose a check box using the mouse:

1. Move the mouse cursor on the box you want to choose.

2. Press the mouse button.
To choose a check box using key commands:

1. Press to move to the desired check box.
2. Press

Also use this procedure to clear a chosen check box.

When you forget how to select an item, move within a screen, or want to know
what a Norstar Manager symbol means, you can find out by using the help
screens. Four help screens are available at any time while you are using Norstar
Manager.

The Help screens provide you with information about:

. function keys
. screen navigation
. icons and color coding

To access the Help screens, choose the Help menu. When you request help, your
current work is replaced with the Help screen. This screen covers your work, but

does not remove your work. Choosing takes you to the next Help
screen. Choosing returns you to your work in progress.
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Intr oduction Before you can begin using Norstar Manager, the software must first be installed
on your personal computer (PC). Installing Norstar Manager involves:
. making sure your PC has the correct requirements to run the application
. installing the software on the PC's hard drive
. logging on
. setting the default configuration and operation parameters for the PC and
Norstar Manager

This section explains how you install and start up Norstar Manager. For more
information on setting Norstar Manager up, refer to Section 2 of the Norstar
Manager for Windo ws™ Reference Guide .

Before you star t  The Norstar Manager software is installed on the hard disk of your PC. Before you
install Norstar Manager, make sure your computer is a 100% IBM compatible PC,
equipped with:

a 486 or higher microprocessor

at least 16 Mbytes (MB) of Random Access Memory (RAM)

400+kilobytes of conventional memory available in Windows™

20 MB of virtual memory

a hard disk (minimum 100 MB of free space)

a 1.44 MB inch floppy drive

MS-DOS® 5.0 or later

Microsoft® Windows™ 3.1; Windows™ for Workgroups 3.11; or Windows ™95,

O o oooooo o

a VGA color monitor (640 X 480 pixels or higher resolution. If a higher reso-
lution is used, the Windows™ font setting should be “Small Fonts” by default.)

0 aWindows™ compatible mouse

Microsoft is a registered trademark and Windows is a trademark of Microsoft Corporation.
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Section 3: Installing Norstar Manager

Upgrading
Norstar
Manager

Upgrading to
Release 3.4

0 aHayes compatible modem

O  if you have ordered Norstar Remote Utilities on compact disc, you need a
CD-ROM drive to install the program

Note: If you are installing Norstar Manager on a LAN, refer to Section 3 of the
Norstar Mana ger for Windo ws™ Reference Guide .

Note: For all remote connections, you require a Hayes compatible modem
capable of operating at 1200, 2400, 4800, 9600, or 19,200 baud. The modem
should also have a separate line port and phone port.

When you are upgrading a previous version of Norstar Manager to Release 3.4,
there are several steps that you should take to an ensure optimum configuration.

Upgrading to Release 3.4 allows you to open the Remote Tools window from
Norstar Manager.

This section applies to upgrading to Norstar Manager for Windows™ Release 3.4
from Release 2.xx, Release 3.0, Release 3.1, Release 3.2, or Release 3.3.To
upgrade Norstar Manager for Windows™ to Release 3.4:

1.  Start the Norstar Manager for Windows™ release you are currently using.

2. Gotothe Preferences screen and write down the pathnames entered in the
Job Queue path and Default customer path fields.

3.  Exit from Norstar Manager.

4. Install Norstar Manager for Windows™ Release 3.4 using the steps
described in Installing Nor star Mana ger, later in this section.
Note: In step 5 of the installation procedure, select the Path field and
change the pathname of the directory where you want Norstar Manager
installed. The pathname should be the same as the name of the previous
software release. Be sure to type the full pathname, including the disk drive
to be used. The default directory for Release 2.xx and 3.0 is
C:\WNORSMGR. The default pathname for Release 3.1 or higher is
C:\WNORSS3.

5.  Start Norstar Manager for Windows™ Release 3.4.

6. Goto the Preferences screen and change the pathnames entered in the
Job Queue path and Default customer path fields to the pathnames you
wrote down earlier.

Note: All the fields on the Preference s screen return to default values when you
install or re-install any version of Norstar Manager for Windows™.
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Installing Use this method if you are installing Norstar Manager for Windows™ Release 3.4
Release 3.4 and and want to keep Norstar Manager for Windows™ Release 2.xx.
keeping

You may want to keep Release 2.xx because using the Automatic database
updates feature in conjunction with database programming allows faster access to
the KSU than on-line programming alone. Therefore, using Release 2.xx to
program systems supported by Release 2.xx may be faster than using

Release 3.4.

Release 2.xx

To install Norstar Manager for Windows™ Release 3.4:

1.  Start the Norstar Manager for Windows™ release you are currently using.

2. Gotothe Preferences screen and write down the pathnames entered in the
Job Queue path and Default customer path fields.

3.  Exit from Norstar Manager.

4. Install Norstar Manager for Windows™ Release 3.4 using the steps
described in Installing Nor star Mana ger, later in this section.

5.  Start Norstar Manager for Windows™ Release 3.4.

6. Goto the Preferences screen and change the pathnames entered in the
Job Queue path and Default customer path fields to the pathnames you
wrote down earlier.

Note: All the fields on the Preference s screen return to default values when you
install or re-install any version of Norstar Manager for Windows™. The customer
path and other preferences of Norstar Manager for Windows™ Release 3.4 do not
affect any of the previous releases except Release 3.2. Release 3.2 and higher
will use the preferences of Release 3.4 and higher.

When using Release 2.xx and Release 3.4 side by side, we recommend that the
systems created in one release are backed up and restored with the same
release. For ease of use, ensure that each system in the Systems Director y
screen is named to reflect the type of system and Norstar Manager Release to be
accessed.

Note: If you want to use the Automatic database updates feature in Release 2.xx
check that the feature is turned on when you start Release 2.xx.

Note: When Norstar Manager is installed, the customer path is set to the same
directory as your installation path. For Norstar Manager Release 3.1 or higher, the
installation path is the default of C:\WNORS3 or the path you enter when you
install. If you want to keep using your customer databases from Release 2.XX,
you need to access the Preferences screen and change the Default customer
path field.
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Installing
Norstar
Manager

The Norstar Remote Utilities software is contained on a CD-ROM or is available
from the World Wide Web site for download on to multiple 3.5-inch floppy disks.

If you are using disks, you should make a backup copy of the originals before you
install the software. For instructions on how to copy a disk, refer to the MS-DOS
manual that came with your PC.

The InstallShield® Wizard guides you through the installation process. Follow the
directions in each window to complete the installation. You can cancel the
installation at any time and return to it later.

Note: If the installation fails for any reason, delete any files which were placed in
the “temp” folder in the Windows folder or in your defined “temp” directory during
the installation attempt. The next installation attempt will not work unless these
files are removed. Do not delete the “temp” folder.

To install Nor star Mana ger

1. Uninstall any previous versions of Norstar Remote Ultilities using the Add/
Remove Programs Control panel (Windows 95), or the uninstall icon in the
Remote Utilities program group (Windows 3.1).

Note: The uninstall process does not remove your Norstar Manager
customer database, preferences, or backup files from a previous installation
of Norstar Remote Utilities.

2. Insert the Norstar Remote Utilities CD-ROM, or insert the Norstar Remote
Utilities disk labeled “Disk 1".

3. For Windows 95:
Click the Start button, then choose the Run command. The Open dialog box
appears.

For Windows 3.1 (and Windows for Workgroups 3.11):
From the File menu of the Program Manager, choose Run. The Run dialog
box appears.

4. Click[ Baws=_]and choose the drive that is designated for your CD-ROM or
floppy drive.
5. If you are using CD-ROM, double-click the “DISK1" folder.

Click once on setup.exe. Click[_Gpen_] (Windows 95) or[ K] (Windows
3.1). Click[_ok_]to start the installation.

The Norstar Remote Utilities installation banner appears, along with a Setup
window. The window shows the progress of the InstallShield Wizard setup.
When setup is complete, the Welcome window appears.

7. Follow the directions given by the wizard.

During the installation process, you are asked to confirm the directory where
you want the application installed. For Norstar Manager, the default directory

is c:\\WNORSS3; for Norstar Remote Tools, it is ¢:\\NRU . Choose if
you wish to select another directory.

If you are installing Norstar Manager and your PC has an older version of the
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application on its hard drive, change the directory to the old Norstar
Manager directory name so the new release will replace the old one.

When the installation is complete on Windows 95, the Norstar Remote Utili-
ties component folders appear, ready for use. On Windows 3.1, the Norstar
Remote Utilities program group appears.

If you are running Windows 95 and any of the Norstar Remote Utilities
components you selected for installation fails to install, no folders (even the
folders of the components which did install) appear when the install is
complete. You can open the folders for the successfully installed components
using the Start menu.

If you are running Windows 95, installation creates a folder for Norstar Remote
Tools (if installed) and a folder for Norstar Manager.

If you are running Windows 3.1, installation creates a Norstar Remote Utilities
program group that contains icons for

. Remote Tools, if it is installed

. Remote Tools help, if Remote Tools is installed

. Norstar Manager and Norstar Manager error messages

. uninstall programs

Now that Norstar Manager is installed on the PC’s hard drive, store the original

software and backup disks in a safe location. Make sure all disks are write-
protected so no one can accidentally replace or delete the information on them.

If you need to uninstall either Norstar Manager or Remote Tools, use Add/Remove
Programs in the Contr ol Panel window (Windows 95), or double-click the uninstall
icon included in the program group (Windows 3.1). You have to manually remove a
few files (such as Wnors.ini and NRU.ini) from the Windows folder after the unin-
stall. These remaining files are not useful without the rest of the program files.

Note: The uninstall process does not remove your Norstar Manager customer
database, preferences, or backup files from a previous installation of Norstar
Remote Utilities.

Star ting Once you have installed the Norstar Manager software, you can start Norstar
Norstar Manager.
Manager o start Norstar Manager in Windows 3.1:
1. Make sure the Windows Program Manager appears on your monitor.
2. Open the Norstar Remote Utilities program group.

3. Double click the Norstar Mana ger icon. The Log On dialog box appears.

To start Norstar Manager in Windows 95:
1. Click Start.
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2. From the Program menu, point to Norstar Remote Utilities

3. Point to Norstar Mana ger. The Log On dialog box appears.

NORSTAR MANAGER for Windows (TM)

Copynght 2 1993-1998 Northern Telecom
All Rightz Rezerved

Releaze 3.4 Field Tral (MICS W 3.07]

Uszer |D:||

Password: I

Current customer path: IE: \WHORS3

Sys Admin I | Cancel I | gune I

Figure 3.1 — The Log On dialog box

Once the Log On screen appears on your monitor, you can log on to the applica-
tion. There are two passwords that you will use: the General user password and
the Administrator password. When you first start Norstar Manager, the General
user password is password and the Administrator password is

adminpassword

Note: If you enter an incorrect password, Norstar Manager will remain at the Log
On screen. Try entering the password again.

The General user password provides access to all of the functions in Norstar
Manager except changing passwords. The Administrator password provides
access to all of the functions in Norstar Manager including changing passwords.

Passwords can contain any alphanumeric character and must be from 1 to 17
characters long.

Norstar Manager passwords are case sensitive. This means that upper case
letters are considered different from lower case letters. For example, the default
General user password is “password ”. If you type “Password ", Norstar Manager
will not recognize the password because the letter “P” is capitalized.

Impor tant: For security reasons, it is strongly recommended that you change the
default passwords when starting Norstar Manager for the first time.

The Current customer path field contains the pathname of the directory shown
when Norstar Manager starts. It is important that the pathname specified in this
field is the pathname of a directory your PC has access to. If the pathname speci-
fies a directory your PC cannot access, such as a network drive you are no longer
connected to, Norstar Manager will not start.
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Log ging on Before you log on, make sure the Log On dialog box appears on your monitor.
To log on to Norstar Manager:

1. Select the User ID field and type your user ID.
2. Select the Password field and type the General user password.

3.  Select the Current customer path field and type the path of the directory
you want to start working in.

4 Choose

The Systems Director y screen appears.

Logging off ~ When you have finished with Norstar Manager, you should log off and return to
the Windows operating system.

Before you log off, make sure the Systems Director y screen is displayed on your
monitor. To log off:

1. Choose the File menu and then the Quit menu item.
A dialog box appears asking if you are ready to exit the program.

Note: If you want to cancel logging off, choose
2. Choose

Your monitor shows the Windows operating system.

Note: Do not exit from Norstar Manager in any method other than the one
described above. If Norstar Manager exits to DOS or the Windows operating
system by any means other than logging off, perform the steps described in
Troubleshooting Nor star Mana ger in Section 2 of the Norstar Mana ger for
Windo ws ™ Reference Guide .

Changing the Before you change the passwords, make sure your monitor shows the Log On
password screen and you have chosen an Administrator and General user password.

To change the password:

1. Select the User ID field and type your user ID.

2. Select the Password field and type the Administrator password.
Note: The default Administrator password is adminpass word.

3. Choose

The Norstar Mana ger Passwords dialog box appears.
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Morstar Manager Passwords

General user: I
Administrator: I

| Cancel I | Done I

Figure 3.2 — The Norstar Manager Passwords dialog box

4.

Select the General user text box and type a new General user password.

Select the Administrator text box and type a new Administrator password.

Choose

The dialog box disappears and the Log On screen re-appears.

Impor tant : Be sure to write down the new passwords exactly as you entered
them, including capitalization. Remember that Norstar Manager passwords
are case sensitive. Put the written passwords in a safe place. Lost pass-
words cannot be recovered. If these passwords are lost, you must re-install
Norstar Manager and change the default passwords.

Norstar Manager for Windows™ User Guide



Section 3: Installing Norstar Manager 3-9

Norstar Several of the Norstar Manager preference default settings can be customized to
Manag er suit your specific application.

default settings Note : Norstar Manager preference default settings are provided to ease the use of
Norstar Manager. Most of the parameter defaults can be changed on the program-
ming screens when non-default settings are required.

Listed below are the default settings that can be changed and a description of
what each setting affects. Instructions on how to change default settings immedi-
ately follows the list of descriptions.

COM port: This is the communication port on the personal computer that Norstar
Manager uses to communicate with the KSU. You can select COM1, COM2,
COM3 or COM4. COML1 is the default.

Connect type : Norstar Manager uses three different ways to connect to the KSU:
Direct, Remote, and Operator Assisted. The connection type used depends on
where the KSU is located relative to the PC, and the type of assistance required at
the far end to connect to the RAD. Remote is the default. For more information
about connection types, see Section 5, Diff erent wa ys to make an on-line
connection .

Baud rate: This is the communication rate used by Norstar Manager to communi-
cate with the KSU in an on-line session, a backup, or a restore. The default is
19200. If you are using a direct connection, the local baud rate at the RAD must
match the baud rate chosen for the direct connection in Norstar Manager. If you
are using a remote type of connection, 1200, 2400, 4800, 9600 or 19200 baud
can be used. If you choose a baud rate for a remote connection that is higher than
the rate supported by the RAD, your modem will “auto-baud down” to the modem
speed of the RAD. For more information about connection types, see Section 5,
Diff erent wa ys to make an on-line connection

Connection de vice: This is the device used by the PC to communicate with the
RAD. You can choose either a modem or a Norstar Data Communications Inter-
face (DCI) as the connection device. If you choose a DCI, you must change the

Modem init string . See Using a DCI in Section 4 of the Norstar Mana ger for

Windo ws™ Reference Guide for more information.

Note: The DCI is not supported by T1 Release 1, Compact ICS, CDA-MICS-XC
1.0, USA-MICS-XC 1.0, NA-MICS-DR 1.1, CDA-MICS-XC 1.1, and USA-MICS-
XC 1.1 systems. On these systems you must use a modem.

Dial mode : The dial mode used by Norstar Manager can be either pulse or tone,
depending on the CO line type used by Norstar Manager.

Norstar Mana ger Modem init string : Some modems require special codes to be
sent to them before they are ready to communicate. Use this field to enter any
special codes that Norstar Manager must send to your modem before it is ready to
communicate with the RAD.

Note: For on-line help, click on the icon called Norstar Mana ger Error
Messages. This brings up a file in Write (Windows™ 3.1) or WordPad
(Windows™ 95). See Modem Initialization String Pr oblems.
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The default value for the Modem init string is “&FQOV1&C1&D2S7=85&S0". If
your modem cannot connect to a RAD, you may have to change this string. Refer
to your modem manual for information on what codes must be included in the
Modem init string.

There is a default or existing internal string that the application automatically
displays in the Modem Init String field which contains the following elements:

&F Load default factory configuration

QO Return response codes

V1 Return verbal response codes

&C1 Set the carrier detect (CD) high when the remote carrier is detected

and drop the CD when the remote carrier is lost

&D2 Accept commands only when data transfer ready (DTR) is high and
drop the call when DTR is low

S7=85 Wait up to 85 seconds for the remote carrier to be detected
&S0 Data set ready (DSR) always on

If your modem cannot connect to a RAD, you may use the modem init string field
to include additional commands at the beginning or end of the string, or to edit the
existing string to be sent to your modem. Refer to your modem manual for infor-
mation on what codes must be included in the Modem init string, and whether the
codes you add should be sent before or after the default ones.

Note: In general, you should not delete or alter any of the commands in the
default string. However, the modem wait for carrier delay (S7) must be set to
include both the delay before the RAD auto-answers and the time for the call to be
dialed and connected. Some modems have a maximum wait of 60 seconds. If this
is the case, you may set S7 in the modem init string to a lower value. If you lower
the S7 value and also want the RAD to auto-answer before the modem times out,
you must ensure that the seconds to wait before answering at the RAD is less
than the S7 value. For best results, set the maximum modem speed to the
maximum connect speed.

Note for US Robotics modem user s: Be sure to add &I0 and &B1 to your
modem init strings.

&I10 Software flow control disabled
&B1 Fixed serial port rate

Refer to your modem documentation for the maximum carrier delay time. The
recommended S7 setting is 85 seconds if the RAD is set to auto-answer after 60
seconds.

Note: For on-line help and other modem init strings, click on the icon called
Norstar Mana ger Error Messa ges. This brings up a file in Write (Windows™ 3.1)
or WordPad (Windows™ 95). See Modem Initialization String Pr oblems.
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Langua ge: Norstar Manager is designed to provide all of the screens and
prompts in either English or French. Use this field to change the language
displayed by Norstar Manager. The language will change after you exit from
Norstar Manager and log on again.

Job Queue path : Enter the path for the directory where the Job Queue will be
run. To run a local Job Queue, enter the path for a directory on the hard drive of
your PC. To run a network Job Queue, enter the path for a directory on the
network drive. If you are using a network Job Queue, you should enter the same
path on each PC running Norstar Manager. For more information about the Job
Queue, see Section 7, Job Queue.

Default customer path : Enter the path for the default directory where the
customer databases are stored. The default for this field is the directory where
Norstar Manager was installed.

Backup speed dialer s: When you perform a backup of a Norstar system, all of
the information stored in the KSU is copied to the Norstar Manager database. On
certain systems, you may want to backup all of the Norstar system information
except the personal speed dial numbers. To backup all of the information except
the personal speed dialers, make sure this check box does not contain an X.

To change the preference default settings:

1. Make sure the Systems Director y screen is displayed.

2. Choose the Preferences menu.
The Preference s screen appears.

I Norstar Manager-Preference Settings =] B
Help

FPreferences

rConnection Preferences rScreen Preference
COM port: |1 ;I
Connect type: IbHemule ;IJ Language:
Baud rate: I *» 9600 ;lJ * English LI
Connection device: II-Mm:Iem ;lJ
Dial mode: Ip]’gne ;J
Morstar Manager modem init string: I&FIJIN1 &C15D257=85%50

-Database Preferences

Job Queue path; |[::\W'NI]HS3

Default customer path: IE:\W’NIJFIS3

[X Backup speed dialers

Cancel I | Done I

Ready [ MHUM | [ D4/02/98 9:57-54 AM |

Figure 3.3 — The Preferences screen
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Choose the drop list arrow of the setting you want to change.

4.  Choose the new default setting from the list of settings shown.
Note: If you are changing the Modem init string, Job Queue path, or Default
customer path, no list of settings is available. After you select any of these
fields, type in the appropriate path or string.

Choose to exit this screen and implement your changes.
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Preparing and ad ding 4
Norstar system Inf ormation

Intr oduction Norstar Manager stores Norstar system information and programming in a central
location on your PC, known as a database. This database contains a record of site
information, KSU configuration, inventory, and programming for each Norstar
system.

Preparing to add Norstar system information to the database involves:

. collecting Norstar system information
. completing a Norstar Mana ger for Windo ws™ Programming Recor d

After these steps are completed, you can add Norstar system information to the
database.

This section explains how you complete the steps required to add Norstar system
information to the Norstar Manager database.

CoIIecting The first step in adding Norstar system information to the Norstar Manager data-
Norstar system base is to collect the following information:
information . the name and address of the company that owns the Norstar system
. where the Norstar system is located
. what type of Norstar KSU is installed
. programming preferences

Once you have collected this information, you can begin filling in the Norstar
Manager for Windo ws™ Programming Recor d.
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Completing the
programming
record

System Inf ormation

Norstar information and programming is recorded on the Norstar Mana ger for
Windows™ Programming Records. The programming records consist of several
pages divided into system, line, and set programming.

Before you enter any Norstar information programming, you should fill in a
programming record.

Norstar Mana ger for Windo ws™ Programming Recor ds are found in Appendix
A of this guide. These programming records are designed to follow the Norstar
Manager screens. Each section of information is written in the order it appears on
the Norstar Manager screens.

To keep writing to a minimum, most areas of the programming record provide
choices that you circle or check. Default settings are shown in bold .

Before you begin writing down information on the programming record, make sure
you:

. are using the correct programming record for the Norstar system.
Appendix A contains programming records for Modular DR5, Modular ICS
and Centrex systems.

. are equipped with any necessary reference materials, such as the Modular
DR5 Installer Guide , to help you complete the programming record.

. know if a KSU is already installed and running, or if this is a new installation.

Impor tant: If a KSU is already installed and running, you will not enter program-
ming information from a programming record. However, you must still add the
Norstar system information to the Norstar Manager database to be able to back
up the Norstar system programming. For instructions on backing up Norstar
system information, refer to Section 7.

The first area to complete on the programming record is the System Information
section. This area, found at the top of page 2, provides general information about
the Norstar system.

When you are adding a new Norstar system to the Norstar Manager database,
this general information should be entered in the database before you enter any
Norstar programming information. Norstar Manager uses this information to set up
a database file for the Norstar system.

The information you need for the system information section is listed in the
following paragraphs.

System Identifi cation (ID)
This is a unique 10 digit number that identifies a Norstar system. This is a number
that you assign.

No two systems can have the same System Identification number. When a
company has several Norstar systems stored in the database, this number allows
you to distinguish between systems.
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Note: To ensure each system has a unique ID, we recommend you use the
Norstar system’s main phone number as the ID number.

Customer name
This is the name of the company or business that owns the Norstar system.

KSU location

This is where the Norstar KSU is located on site, such as the telephone room. The
KSU location is not always the same as the customer’s address. You should know
where the KSU is located in case a problem occurs on site.

Note: Since the information stored in the KSU location field is shown on many of
the Norstar Manager screens, it may be helpful to store other important informa-
tion in this field. Examples of other information are: Service contract level, Mainte-
nance contract number, etc.

Address
This is the customer’s business address. The address can be three lines long.

Contact
This is the name of person at the customer site who coordinates Norstar program-
ming and troubleshooting.

Phone n umber
This is the phone number of the contact person. Remember to include an area
code if the phone number is outside your local calling exchange.

Install date

This is the date that the KSU was installed, or will be installed, at the customer
site. This date should contain eight digits in the format YYYY-MM-DD. Any single
digit month or day must be preceded by a zero.

RAD phone n umber
This is the number Norstar Manager dials to make contact with the RAD at the
customer site.

RAD password
This is the number Norstar Manager uses to identify itself as a valid user to the
RAD. This password can be a maximum of 10 digits.

Impor tant: When the RAD is initially programmed, the RAD password is assigned
in two different manners:

. On the Global RAD, the RAD password is entered through the RADMIN pro-
gramming feature. The RAD password shown on this screen must be the
same as the password entered in RADMIN programming. For information
about RADMIN programming, refer to the RAD Installation Guide

. On RADs other than the Global RAD, the RAD password defaults to the
System ID. Therefore, for initial installation the RAD password shown on this
screen must be the same as the customer's Norstar System ID.

After the initial installation, the RAD password can be changed to another number
in an on-line programming session. For more information about on-line RAD
programming, see Section 6, Programming a Nor star system .
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System Star tup

Note: To change the programming for a FastRAD, use the Remote Set tool and
(9] [*] [*]. If you use Norstar Manager to program a FastRAD, any pass-
word that does not use 10 digits is rejected, and the baud rate settings do not
match the values you are shown. Avoid problems by using the Remote Set tool
option.

Remote time diff erence

This is the difference in time between your location, or the location of the PC
running Norstar Manager, and the location of the Norstar system. The remote time
difference can range from +3.5 to -3.5 hours.

Type of system

This is the kind of Norstar KSU the customer is using. Norstar Manager supports
Compact, Compact Disconnect, 3X8, and Modular ICS (MICS) systems. For any
other type of system, choose CICS/MICS2.0/Other.

Software version

This is the type of software the KSU is running. Norstar Manager supports DR5,
T1 Release 1, Centrex+, Centrex Release 1, CDA-MICS-XC 1.0, USA-MICS-XC
1.0, NA-MICS-DR 1.1, CDA-MICS-XC 1.1, and USA-MICS-XC 1.1 systems. For
any other type of system, choose CICS/MICS2.0/Other.

Note: For more information about system types, software version types and
product names, refer to Appendix A .

System language

This is the language combination the Norstar system uses. Norstar DR5 KSU soft-
ware versions are available in English/French or English/Spanish. All 0X32 KSU
software versions are available in English/French/Spanish only.

Note: The system language for 0X32 KSUs only shows English/French but does
support English/French/Spanish.

Note: The System ID, Type of system , and Software ver sion fields cannot be
changed after the Norstar system has been added to the database.

After you have gathered the above information, write it down in the System
Information section of the programming record. After you complete the System
Information section of the programming record, you can fill in the remaining
pages. The remaining pages of the programming record are devoted to the actual
configuration and administration programming of the Norstar system.

The System Startup command applies a template to the KSU. On all systems
other than a CDA-MICS-XC 1.1, USA-MICS-XC 1.1, CDA-MICS-XC 1.0, USA-
MICS-XC 1.0, Centrex+ and Centrex Release 1, the default template is the square
template.

You can use Norstar Manager to change a template set up by the installer. If you
are going to apply a template to the system, write down the type of template you
are going to use and refer to Initializing a system in Section 6 of this guide for
instructions on changing a template.

On T1 Release 1 systems you can also specify or change the starting DN using
the System Startup command. The default starting DN is 221.
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Note: On Centrex+ and Centrex Release 1 systems, the Centrex template is the
only option available. On CDA-MICS-XC 1.0 systems, the PBX template is the
only option available.

Impor tant: If you change the system template or the starting Directory Number
(DN), the on-line session is immediately terminated and you are returned to the
Systems Director y screen. For more information about on-line connections, see
Section 5 of this guide.

Installed Equipment In the Installed Equipment section, write down the port number, DN, name or loca-
tion, and type of equipment attached to the Norstar KSU. Names or locations of
sets or other peripheral equipment can be a maximum of seven characters long.

When you are completing a 3X8 DR5 or Compact DR5 programming record, you
need only one copy of this page. If you are completing other programming
records, more than one copy may be necessary. If the system you are recording
programming for has additional equipment, make copies of this page before you
start filling it out.

System, Line, and Set When you are completing the System, Line, and Set Programming sections
programming remember, there are several differences between the different types of system
programming parameters.

Before you write down any programming preferences, make sure you are using

the correct programming record for the Norstar system. If you are unsure of any
area in System, Line, or Set Programming sections, refer to the Norstar Installer
Guide for the type of system you are programming.

After you complete the Norstar Mana ger for Windo ws™ Programming Recor d,
you can add the Norstar system programming information to the KSU. Before you
start:

. write the date, your name, and the total number of pages in the programming
record on the first page of the Norstar Mana ger for Windo ws ™ Program-
ming Recor d

. make a photocopy of the completed programming record and store it in a
safe place

It is important that you file the programming record in a safe place because it
contains the original system configuration.

e Systems Director y screen is the first screen you see after you log on to
Systems  Thes Di is the fi ft |
Director y Norstar Manager. This screen lists all of the Norstar systems in the current direc-

tory. The maximum number of Norstar systems in a directory is 2500.
screen
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When you first start Norstar Manager, the Norstar systems are organized alpha-
betically by the customer name. To list the Norstar systems numerically by System
ID, choose the Chang e view menu. To change the list back to an alphabetical
order, choose the Chang e view menu again.

[E Morstar Manager-Systems Directory HAEE
File Edit Change wiew Scheduler Freferences Help
Systems Directory

Customer D atabasze Path

| C:\WNORS3 |

Customer Hame Location System ID Last Backup -]

|3X3 Electrical room 2226663456

Compact Electrical room 6661234567

MICS 1.1 Telephone room 1115551235

MA-CICS-DR 1.0 Clozet 1115555678

T1 Release 1 Electrnical room 1115554545
Ready [ [ [ | 1047796 10:24:32 AW

Figure 4.1 — The Systems Directory screen

Before you can perform any function on a Norstar system, you must select the
system. To select a Norstar system, use the mouse or and the cursor keys
to highlight the desired system. After the system is highlighted, choose the func-
tion you want to perform from the applicable menu.

Norstar systems can also be selected by typing the first letter of the customer
name. When you type a letter, the first customer name that starts with that letter is
highlighted. For example, if you want to select the customer “Zoo” type

The Systems Director y screen lists all of the Norstar systems for a single direc-
tory, but not all of the Norstar systems available to Norstar Manager. Other Norstar
systems can be accessed by changing the directory.

To change the directory:

1. Choose the File menu and then the Chang e Customer P ath... menu item.

2. Type the new database pathname.
Note: If the directory you wish to display is on a disk drive other than the
one Norstar Manager is installed on, you must include the drive name. For
example: D:\CUSTOMER The maximum length for the full pathname of the
database directory is 127 characters. For more information about directo-
ries, see your DOS manual.
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3. Choose

The list of Norstar systems for the new customer database is shown.

Note: Databases other than the default database created when you installed
Norstar Manager are not available until you create them. To create a new data-
base directory, use the steps shown above to enter the name of the new directory
into the Enter customer data base path field. After you have chosen

Norstar Manager will ask you to confirm the creation of the new

directory.

Impor tant: Do not change the customer path to the directory

c:\wnor s3\template . If you use this directory, you may corrupt the blank database
files used to add new systems. If these files become corrupted you must re-install
Norstar Manager.

Adding a Nor star When you add a Norstar system, you must enter the system information, recorded
system to the on page 2 of the Norstar Mana ger for Windo ws™ Programming Recor d, into
database the Norstar Manager database. Adding a Norstar system to the database
involves:

. grouping Norstar systems

. entering the system information into the database

Grouping Nor star Similar Norstar systems can be collected into a single group and placed in a
systems specific database directory. This provides you with quick access to customers who
share a similar business. For instance, a department store might be in a group
called Retalil.

When you have decided what database directory the Norstar system should be
entered into, you must access, or create, that database directory from Norstar
Manager.

Adding a Norstar Before you can add any Norstar programming or make a backup copy of a Norstar
system system's existing programming, you must add the Norstar system information to
the Norstar Manager database.

Before you begin, make sure your monitor displays the Systems Director y
screen. To add Norstar system information:

1. Choose the Edit menu and then the Add System menu item.
The Add System screen appears.
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[ Morstar Manager-Add System HAEE
Help
Add System System ID: (11155612356 | <«

Customer Name: IHICS 1.1

K5U Location: ITeIephune room

Address: |327 Main Street

Contact: |Monique
Phone number: 1115551235
Install date [pypy/mm./dd): @l
RAD phone number: [1115551235

BAD pazsword: 1115551235
Remote time difference: I *0.0 j hours from local time

Type of system: | * Modular J s
Software version: | MICS 1.1 [NA/CDA/USA) j] €
System language: | » E nglish/French j] <<
| Pl i=l [N otify Monique before performing a backup or restore | |j
Cancel I | Done I
Ready [ [ | 10/7/96 9:50:29 AM |

Figure 4.2 — The Add System screen

All the information you need for the Add System screen is found on page 2 of the
programming record.

Reminder : When you are entering information in the Add System screen, use
the mouse to move from field to field. You can also press to move from
field to field, and and to move back a field. To move the cursor

down one line within the Address field, press

To add Norstar system information, select each of the fields listed on the Add
System screen and enter the information specified on the programming record.
For some of these fields, such as Customer Name, you must type in the informa-
tion. For other fields, such as Type of system, you choose an option from a list
box. See System Inf ormation section , earlier in this section, for a description of
each of the fields on this screen. If desired, select the Note field and type any
information you want to add about the customer's Norstar system.

Note: System ID, Type of system, Software version, and System language are
mandatory fields. Valid information must be entered into these fields before a
Norstar system is added to the database. The other fields may be left blank if
necessary.

Choose to return to the Systems Director y screen.

After a Norstar system is added to the Norstar Manager database, you can initiate
an on-line session, or make a backup copy of an existing system.
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If you are adding Norstar programming, refer to Section 6 of this guide for more
information. If you are making a backup copy of a customer's existing system,
refer to Section 8 for more information.

Deleting a Nor star When you delete a Norstar system from the Norstar Manager directory, all record
system fr om the of programming for this system is removed from the directory. To delete a Norstar

director y ~ System:
1. Select the Norstar system you want to delete.

2. Choose the Edit menu and then the Delete System(s) menu item.
3. Choose

The Norstar system is removed from the Norstar Manager directory.

Changing Nor star When a customer's name or address changes, you must alter the information
system stored in the Norstar Manager database. You alter this information by accessing
information the Edit System Details screen.

The Edit System Details screen is similar to the screen used to add a customer
to the Norstar Manager database. The Edit System Details screen differs,
because you cannot alter the System ID, Type of system, or Software version.

Before you change Norstar information, make sure the Systems Director y
screen appears on your monitor. To change Norstar system information:
1. Select the Norstar system to edit.

2. Choose the Edit menu and then the Edit System Details menu item.
The Edit System Details screen appears.
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[E Morstar Manager-E dit System Details HAEE

Help
Edit System Details System I1D: 1115551235
Cusgtomer Name: IHICS 1.1

K5U Location: ITeIephune room

Addrezs: |327 Main Street

Contact: |M onigque
Phone number: |1115551235

Install date [pppp/mm/dd): 1996501708

RAD phone number: [1115551235

BAD pazsword: 1115551235
Remote time difference: j hours from local time

Type of system: |Modula[
Software version: |MICS 1.1 [NASCDAJUSA]
Sypstem language: I English/French J

Note: [Notify Monique before a backup or restore. |j

Cancel I | Done I

Ready [ [ [ [10/7/96 10:37:14 AM |

Figure 4.3 — The Edit System Details screen

The Edit System Details screen is similar to the Add System screen. For
instructions on moving around this screen, refer to Adding a Nor star system ear-
lier in this section.
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Intr oduction To change Norstar system programming with Norstar Manager, you must first
make an on-line connection. In an on-line connection, the Norstar Manager PC is
connected to the Norstar system using a Remote Access Device (RAD) and, in
some cases, a modem.

To use Norstar Manager, you must make an on-line connection. A RAD acts as a
communication bridge between the KSU and the Norstar Manager software
running on your PC.

After you have made an on-line connection, you can change the Norstar program-
ming parameters. This section explains how to make an on-line connection.

Changing An on-line connection with a Norstar KSU allows you to change a Norstar KSU's
information line, set, and system programming. When your PC has an on-line connection with

) ; the Norstar KSU, any changes you make on a Norstar Manager screen are also
with an on-line  made at the KSU.

connection
Note: You should perform, or schedule, a backup of the Norstar system when you
are finished programming. Backing up the Norstar system you have just made
changes to updates the copy of the Norstar programming stored in the Norstar
Manager database. Refer to Section 7 for instructions.

Do not connect or disconnect equipment from the KSU when you are in an on-line
session. When an on-line session is initiated, Norstar Manager scans the KSU to
determine what devices are connected. Norstar Manager does not scan the KSU
again during that on-line session. If someone adds or removes a set during an on-
line session, you must exit from the on-line session and start another session
before Norstar Manager will recognize the change.
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Different ways to
make an on-line
connection

When you make an on-line connection to the Norstar KSU, you have three
choices on how the connection is made:

. remote
. operator assisted

. direct

Remote connection
A remote connection means the PC communicates with the RAD at the remote
site using a modem and a telephone line.

In this case, Norstar Manager uses the modem to dial the KSU line using the
phone number you specify in the connect dialog box. This KSU line must be set to
be answered by the RAD after a configurable number of seconds. Once the RAD
answers, Norstar Manager transmits the RAD password and gains access to the
Norstar KSU.

This type of connection is used when the Norstar KSU is at a remote site and the
RAD can be accessed by Norstar Manager.

Operator Assisted connection

Like the remote connection, an operator assisted connection uses a modem to
link your PC to the RAD. The difference is that you must get assistance from the
customer site before Norstar Manager can make a connection.

To make an operator assisted connection, use the telephone connected to your
PC's modem to call the receptionist and have your call transferred to the RAD. The
receptionist can transfer the call to the RAD by pressing (o] [0].
After you hear the high pitched tone which indicates the transfer is completed,
press and hang up the telephone. Norstar Manager completes the
connection to the RAD.

An operator assisted connection is used when:

. the Norstar KSU is located at a remote site and Norstar Manager software
cannot access the RAD directly

. or if you wish to talk to someone on-site before you make the on-line connec-
tion

. or if the RAD is not set up to Auto-answer calls

You must have access to a separate line port and phone port on the modem.
These two ports are either equipped by the modem itself or are obtained by
inserting a commercially-available dual phone port device into the modem phone
port. One port is connected to a public network line, and the other is connected to
an analog telephone that you use to make the call.

Caution : Modems that require a dual phone port device to perform operator
assisted calls are susceptible to noise generated when you hang up your tele-
phone. For operator assisted calls, it is highly recommended you use a modem
that has a separate line port and phone port instead of one that requires a dual
phone port device.
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Opening Remote
Tools fr om
Norstar Mana ger

Making a remote
or direct on-line
connection

Direct connection
A direct connection means the PC is connected to the RAD by an RS-232 cable.
Refer to Section 2, Figure 2.1 for a diagram of a direct connection.

This type of connection is used when you are running Norstar Manager on a PC at
the site of the Norstar KSU.

Note: The RAD password specified in the Edit System Details screen must
match the password of the RAD.

When you are using Norstar Manager, open the Remote Tools window by
selecting Open Remote Tools from the File menu. The Remote Tools window
uses the connection settings for the current customer as they are stored in the
Norstar Manager database. Remote Tools is the only option for connecting to
Compact ICS, Modular ICS 2.0, or any other ICS not supported by Norstar
Manager.

Before you begin, make sure the Systems Director y screen appears on your
monitor. To make an on-line connection with a Norstar KSU using a remote or
direct connection:

1. Select the Norstar system you want.

2. Choose the File menu and then the Start On-line Session... menu item.
The Start On-line Session dialog box appears.

Norstar Manager - Start Online Session E

Start On-line Session

COM Port: |» COM1 =l
Connect type: | » Eemote LIJ
Baud rate: | » 9500 ;I]

RAD phone number: |2225555522
Modem init string: |&FQOV1LCT1ED257=85850

Connection device: | » Modem ;IJ
Dial mode: [* Tone LI]
| LCancel I | Done I

Figure 5.1 — The Start On-line Session dialog box
3. Choose the drop list arrow beside the COM Port field and choose the PC
communication port Norstar Manager will be using.

4.  Choose the drop list arrow beside the Connect type field and then choose
either Direct or Remote connection.
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Making an
operator assisted
on-line connection

5.  Choose the drop list arrow beside the Baud rate field and then choose the
appropriate baud rate.
Note: The default is 19200. If you are using a direct connection, the local
baud rate at the RAD must match the baud rate chosen for the direct
connection in Norstar Manager. If you are using a remote type of connection,
1200, 2400, 4800, 9600 or 19200 baud can be used.

6. If you chose Remote connection, select the RAD phone n umber text box
and type the RAD's phone number.
Note: The default for this field is the RAD phone number you entered on the
Edit System Details screen.

7. If you are using a modem as the connection device, you may have to enter
an initialization string in the Modem init string field. This is an optional field
that is not required for all modems. Check the documentation for your
modem to see if an initialization string is required. Refer to Section 3,
Norstar Mana ger default settings .

Note: If you are using a DCI as a connection device, you must add S7=55 to
the end of the modem init string.

8. Choose the drop list arrow beside the Connection de vice field and then
choose either Modem or DCI.
Note: This field is not required for Direct connection.

9. Choose the drop list arrow beside the Dial mode field and then choose
either Pulse or Tone.
Note: This field is not required for Direct connection.

10. Choose [ Dene .

When the PC to KSU connection is established, the System Pr ogramming
Overview screen appears.

Impor tant: Wait for five minutes (ten minutes on CDA-MICS-XC 1.0, USA-MICS-
XC 1.0, NA-MICS-DR 1.1, CDA-MICS-XC 1.1 and USA-MICS-XC 1.1 systems)
before attempting to use Norstar Manager to reconnect to a Norstar system that
has been restarted in any manner. This allows the Norstar system to startup and
get ready to answer calls. This includes warm restarts, cold restarts and startup
programming.

If the RAD is connected to the KSU at a remote site and can only be reached
through the receptionist, you must select the Operator Assisted option. With the
Operator Assisted option you must phone the receptionist at the remote site and
ask this person to reroute the call to the RAD.

For an operator assisted connection, you must have access to a separate line port
and phone port on the modem. These two ports are either provided by the modem
itself or are obtained by inserting a commercially-available dual phone port device
into the modem phone port. One port is connected to a public network line, and
the other is connected to an analog telephone that you use to make the call.

Caution : For operator assisted calls, it is highly recommended you use a modem
that has a separate line port and phone port instead of one that requires a dual
phone port device.
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Before you use the Operator Assisted option, make sure the Systems Director y
screen appears on your monitor. To make an Operator Assisted connection:

1. Select the Norstar system you want.
2. Choose the File menu and then the Start On-line Session... menu item.
The Start On-line Session dialog box appears.
Morstar Manager - Start Online Session [ ]
Start On-line Session
COM Port: [ » COM1 =
Connect type: | Operator Assisted LIJ
Baud rate: | » 9500 LI]

BAD phone number: [22255556522
Modem init string: |XFO0V1&C1&D257=85450

Connection device: | » Modem jJ
Dial mode: | » Tone ;Ij
| LCancel I | Done I

Figure 5.2 — The Start On-line Session dialog box

3.

10.

Choose the drop list arrow beside the COM Port field and choose the PC
communication port Norstar Manager will be using.

Choose the drop list arrow beside the Connect type field and then choose
Operator Assisted .

Choose the drop list arrow beside the Baud rate field and then choose the
appropriate baud rate.

Note: For an operator assisted connection, 1200, 2400, 4800, 9600, or
19200 baud can be used. The default is 19200. If you are using a direct
connection, the local baud rate at the RAD must match the baud rate chosen
for the direct connection in Norstar Manager. If you are using a remote type
of connection, 1200, 2400, 4800, 9600 or 19200 baud can be used. If you
choose a baud rate for a remote connection that is higher than the rate
supported by the RAD, your modem will “auto-baud down” to the modem
speed of the RAD.

Select the RAD phone n umber text box and type the RAD's phone number.
Note: The default for this field is the RAD phone number you entered on the
Edit System Details screen.

Enter an initialization string in the Modem init string field, if necessary. This
is an optional field that is not required for all modems. Check the documenta-
tion for your modem to see if an initialization string is required. Refer to
Section 3, Norstar Mana ger default settings .

Choose the drop list arrow beside the Connection de vice field and then
choose Modem.
Note: You cannot use a DCI with an Operator assisted connection.

Choose the drop list arrow beside the Dial mode field and then choose
either Pulse or Tone.

Choose A dialog box appears.
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Call custemar from the febgphone comascied 1o Ty same Bne s e modem, Regues! the call in be rmemuied s the B

[Festere 3*0]. Wihken you hear the mesdem toee, dick on (E. RAD Phone Bumbes: 7777755555

Lanenl || gk |

Making a Quick
connect

Figure 5.3 — Operator Assist dialog box

11. Use the telephone attached to the modem to dial the number of the remote
Norstar system.

12. When your call is answered, ask the receptionist to transfer the call to the
RAD by pressing
P & 0.

Note: You must place the customer call from the telephone connected to the
same line as the modem.

13. When you hear the carrier signal (a high pitched tone), choose
and hang up the phone.

When the PC to KSU connection is established, the System Pr ogramming
Overview screen appears.

Impor tant : Wait for five minutes (ten minutes on CDA-MICS-XC 1.0, USA-MICS-
XC 1.0, NA-MICS-DR 1.1, CDA-MICS-XC 1.1 and USA-MICS-XC 1.1 systems)
before attempting to use Norstar Manager to reconnect to a Norstar system that
has been restarted in any manner. This includes warm restarts, cold restarts and
startup programming.

If you want to start an on-line session with a Norstar system not listed in the
Norstar Manager database, use the Quick Connect feature. The procedure used
to make a Quick Connect is the same as the procedure used to start a normal
on-line session, except you must specify the RAD password. For remote connec-
tions you must also specify the RAD phone number in the RAD phone n umber
field. Figure 5.9 shows the Quick Connect dialog box.

Before you use the Quick connect option, make sure the Systems Director y
screen appears on your monitor. To make a Quick connect:

1. Choose the File menu and then the Quick Connect... menu item.
The Quick Connect dialog box appears.
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5-7

Changing Nor star
programming

Quick Connect

MNorstar Manager - Quick Connect

COM Port: | » COM1 ;J
Connect type: | » Remote ;Ij
B aud rate: |p93|]|] jJ

RAD phone number: I?????55555
RAD password: |?????55555 |

Modem init string: I&FQU\H EC1&D257=85E50

Connection device: | » Modem LIJ
Dial mode: |k Tone ;Ij

| LCancel I | Done I

Figure 5.4 — The Quick Connect dialog box

2.

3.

Enter the correct information into each field on this dialog box.

Note: The RAD password and RAD phone n umber fields do not have any
default values listed. The information in these two field is unique for each
system and must always be entered when using the Quick Connect feature.

Choose (B,

When the PC to KSU connection is established, the System Pr ogramming
Overview screen appears.

Note: If the KSU is not supported by Norstar Manager, try establishing a connec-
tion with Remote Tools.

Changing Norstar programming is easy. When a change is requested:

use the Norstar Mana ger for Windo ws ™ Programming Recor d or
Figure 6.3, Overview of Norstar programming, to determine which screen
contains the information you need to change

go to the page in Section 6 that describes the appropriate screen and follow
the procedure given to open the screen in Norstar Manager

change the appropriate data within the screen

For example : Mr. Brown of Clark and Company asks you to add seven new
system speed dial numbers to his company's Norstar system. He also wants the
background music feature enabled, the DRT to prime delay set to four rings, and
full handsfree enabled for all sets on the system.

You would perform the following steps to carry out Mr. Brown's requests:

1.

Refer to Figure 6.3 and note which screens contain the information you need
to change.
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2. The screens you would note are:

. System Programming, System Speed Dials (for the seven new system
speed dial numbers)

. System Programming, Miscellaneous 1 (for enabling background
music)

. System Programming, Call Handling (for the DRT to prime delay)
. Set Programming, Set Abilities (for full handsfree for each set)

3.  Refer to this guide's Table of contents to determine which pages give instruc-
tions on accessing these screens.

4,  Start an on-line session with the KSU.

5. Access the screens and make the necessary changes.
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Exiting from an To exit from an on-line session:

On-“.ne Session Choose the File menu and then the Exit System... menu item.
using Nor star The End On-line Session dialog box appears.

Manager

Exiting this screen will terminate the online
session. Do you wizh to continue?

| Exit System I | Cancel I

Figure 5.5 — The End On-line Session dialog box

2. Choose to exit from the on-line session.

The Systems Director y screen appears.
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Intr oduction Norstar programming defines how a Norstar KSU and its peripheral devices work
together.

Adding Norstar programming involves entering the information that is in the
Norstar Mana ger for Windo ws ™ Programming Recor d into the Norstar KSU.

This section explains how to add Norstar programming, written down in the
programming record, to the Norstar KSU.

Note: If the Norstar system is already installed and running, you can use the steps
described in this section to change the existing programming. If you are installing

Norstar Manager for Windows'™" and programming Compact ICS, refer to the
Remote Tools User Guide. Refer to the Compact ICS Programming Record .

Connecting to a Before you begin entering programming information, make sure you have:
Norstar system
. completed a copy of the appropriate Norstar Mana ger for Windo ws™
Programming Recor d, found in Appendix A

. read the related Norstar Installer Guide or Norstar System Coor dinator
Guide.

Before you can add programming to the Norstar system, you must first select the
Norstar system that you want to program and start an on-line session. You select
the Norstar system on the Systems Director y screen. The Systems Director y
screen is the first screen your monitor shows after you log on.

Before you begin, make sure the Systems Director y screen appears on your
monitor. To connect to a Norstar system:
1. Select the Norstar system you want to program.

2. Start an on-line session.
The System Pr ogramming Over view screen appears.
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System

Programming
Overview
screen

Note: For information on starting an on-line session, refer to Section 5,
Making an on-line connection

File Edit Program Maintenance Beports Help
Trunks Target Lines
Port Line Hame Type = Line Rec'd # | Name l;l
|2I]1 001 Line001 Unszupervised 121 Linel121 =
202 002 Line002  Unsupervised 122 Line122
203 003 Line003 Unsupervised 123 Linel123
204 004 Line004  Unsupervised 124 Linel24
205 005 Line005 Unzupervised 125 Linel125H
206 006 Line0D6  Unsupervised 126 Linel26
207 oo7 Line007  Unsupervised 127 Line127
208 008 Line00D8  Unsupervised 128 Linel128
209 009 Line009  Unsupervised = 129 Linel129 -
Sets
Port DN MName Type =]
1o 221 221 M7310 —
102 2222 2222 M7310
103 2223 2223 Unequipped
104 2224 2224 Unequipped
MIC5 1.1 105 2225 2225 Unequipped
System: Modular 106 2226 2226 Unequipped
Customer HName: MICS 1.1 107 2227 2227 Unequipped
K5U Location: Telephone room 108 2228 2228 Unequipped =
System ID: 1115551235 0| L|—I
Ready [ [ [ | 1047796 10:46:23 AM |

Figure 6.1 — The System Programming Overview screen

When you first access a Norstar system, Norstar Manager shows the System
Programming Over view screen. This screen provides access to system, line and
set programming.

The System Pr ogramming Over view screen shows you all of the lines and sets
that are connected to the Norstar KSU. Any KSU port that does not have a line or
set connected will be shown as unequipped. In the Sets data box you also see
other pieces of Norstar equipment that can be connected to a station port, such as
an ATA.

Note: The System Pr ogramming Over view screen will show only the pieces of
Norstar equipment that use the KSU memory (NVRAM) and can be administered
by Norstar Manager. Some equipment, such as RADs and StarTalk, use their own
memory and thus do not appear on this screen. Other equipment, such as the
DCI, are not shown because they cannot be programmed by Norstar Manager.

On the System Pr ogramming Over view screen you can view information about
trunks, target lines and sets. For trunks you can see the port number, line number,
line name and trunk type. For target lines you can see the line number, received
number and line name. For sets you can see the port number, DN, set name, set
type, and addon device (CAP and BLF).
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Note: To view the addon devices, choose the Edit menu, and choose Update
Addons, then scroll to the right in the Sets data box.

The System Pr ogramming Over view screen allows you to change some of the
information shown. You can change the trunk name, the target line name, the
received number, and the set name. The set type can be changed when the set is
not physically connected to the port.

You can change how the items in the Sets or Trunks data boxes are sorted. The
sets shown can be sorted by DN or by port number. The trunks shown can be
sorted by name.

To view the sets by DN number, choose the Edit menu and then the Sort by DN
and Line menu item.

To view the sets by Port number, choose the Edit menu and then the Sort by Port
menu item.

The devices shown in the Addons field of the Sets data box are not automatically
updated when you access the System Pr ogramming Over view screen. To
update the addon devices, choose the Edit menu and then the Update Ad dons
menu item.

Hardware Info  The Hardware Info dialog box provides additional information about the lines and
sets that are connected to the Norstar KSU. For the lines connected to the KSU,
the Hardware Inf o dialog box shows the port number, line number, name, type
and version number. For the sets connected to the KSU, the Hardware Inf o dialog
box shows the port number, DN, name, type, version number, add-on device (eg.
CAP and BLF), and add-on version number.

Before you open the Hardware Inf o dialog box, you must select one or more lines
or sets on the System Pr ogramming Over view screen. The Hardware Info
dialog box will then show details about the lines and sets connected to the
selected modules.

To view the Hardware Inf o dialog box:

1. Choose the lines or sets you want to view additional information about.
Note: You cannot view lines and sets at the same time.

2. Choose the Maintenance menu and then the Hardware Info menu item.
The Hardware Info dialog box appears.
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Adding
programming
information

Hardware Info

Port DM /Line Type Yersion | Add-ol n
1011 2221 Monique M7324 OGPEED3 Mone
101-2 Mone Unequipped Hone
1021 2222 Carol M7310 OGREBO0 Mone
102-2 MNone Unequipped Mone
106-1 2226  Patick M7310 OGPCEDE  Mone
106-2 Mone Unequipped Mone
110-1 2230 James M7310 1 None
110-2 Mone Unequipped Hone n

Figure 6.2 — The Hardware Info dialog box

There may be a delay before the Hardware Inf o dialog box appears. The length of
the delay becomes longer if you select more lines or sets.

Note: The Hardware Info dialog box can also be accessed from the Port Status
screen. For information about the Port Status screen, refer to Section 1 0,
Querying the P ort status .

Choose to return to the System Programming Overview screen.

Adding Norstar programming involves entering information about:

. installed equipment

. system programming

. line programming

. set programming

. RAD programming

. voice mail programming

Refer to Figure 6.3 for an overview of the different areas of Norstar programming.
This Figure provides a conglomerate summary of all options. For information

about specific applicable options, refer to Appendix A and the Programming
Record that applies to the KSU you are programming.

The information you need for adding programming to the Norstar system is found
in the programming record.

Norstar Manager for Windows™ User Guide



Section 6: Programming a Norstar system 6-5

Norstar Mana ger-System Pr ogramming Over view

File Edit Program  Maintenance  Reports Help
System Pr ogramming Line Pr ogramming Set Programming Mobility Pr ogramming Maintenance

Call handling

held reminder

held line reminder delay
DRT to prime

DRT to prime delay
page tone

page timeout

directed pickup

voice message center
telephones

transfer callback delay
park prefix

park mode

call park timeout delay
camp timeout delay
on hold feedback

Miscellaneous 1

direct dial number
alarm set

DISA DN

auto DN

link time

supervision time
host delay

external line code
daylight savings time
receiver volume
background music
set relocation

line pool access codes

Miscellaneous 2
« enhanced CAPs
« direct dial extensions

System Centre x
« Centrex codes
« Centrex delays
« beyond Centrex access

Service modes

* ringing groups

* name

ring serv

TAFAS

day

start and stop time
extra-dial set DN
rest serv

rout serv
overflow

Date and Time

System Filter s

System P asswords

« configuration password
« administration password
* COS passwords

System speed dials

« system speed dial numbers

(codes 1 through 70)

Line data

* line type
 incoming line group
* prime set

* auto privacy

* auxiliary ringer

Trunk data
trunk mode
answer mode
answer with DISA
dialing mode
full autohold
loss package
signal

ANI number
DNIS number
TC gain

Abilities and Call Ser vices
* line filters

» VMsg center #

* auto call info

Service mo de options
* service control set

* ringing group

* auxiliary ringer

System pr ogramming

(cont'd)

Remote access pac kages
» package number

« line pool access

* remote page

KSU Trunk Car tridg es
disconnect timer
answer timer

carrier fail

framing format

line coding

I/F level

internal CSU

CSU line build

DSX1 build

Module Trunk Car tridg es
« disconnect timer
* answer timer

Destination Codes
Routing Tables

* route number

« facility

« dial out number

Chang e individual DNs

Chang e DN length

Line access

lines assigned
ringing lines

line/set filter

line pool access
incoming line groups
answer DNs
intercoms

prime line

Set abilities

full handsfree

auto handsfree
handsfree answerback
priority call

auxiliary ringer

redirect ring

allow redirection

ATA tones

pickup group

page

page zone

set lock

call forward on busy to
call forward no answer to
forward to delay

set filters

control set ID

direct dial set

hotline programming
DND on busy

link feature access (Link)
last number redial (LNR)
saved number redial (SNR)
ATA answer timer
message indicate

Buttons and status
do not disturb
pre-dial mode
background music
ring volume

ring type

contrast

language

button assignment

Personal speed dials

« personal (set) speed
dial numbers (codes
71 through 94)

Call ser vices

line assigned for auto log
calls

line assigned for show
external VMSG

logging option

first display

log password

log space

auto bumping

Figure 6.3 — Conglomerate Overview of Norstar programming

Portable registration

« registration password
« allow registration

« registration status

Mobility setup

* system LID

« radio

« antenna type

Cells
« cell neighbors
« cell radio neighbors

Re-evaluate

Software Codes

RAD Programming

system ID

RAD password

automatic answer of
all incoming calls

number of rings to
answer

KSU line number

automatic reporting of
alarms

interval between retries

number of retries

baud rate

parity

system name

report alarms on line
number

« answer on line number

Voice Mail
Programming

alarm monitoring number

System ver sion
Port status
Module status
Provision status
Hardware inf o
System test log
System admin log
Network log
Clock sour ces
Loopbac k tests

CSU statistic s

Norstar Manager for Windows™ User Guide



6-6 Section 6: Programming a Norstar system

Installed
equipment

Programming line
and set names

Changing the
received n umber
of a tar get line

Programming set
types

The first task in adding programming to the Norstar system is to define what
equipment is installed on site. This information is found in the Installed Equipment
section of the programming record. Enter the information from the Installed
Equipment section on the System Pr ogramming Over view screen.

Note: On Modular two-port, six-port, and twelve-port systems, you can enter the
names and received numbers of target lines on the System Pr ogramming
Overview screen.

Before you can program the names for the lines and sets on a Norstar system,
you must access the System Pr ogramming Over view screen.

To enter the names:
1. Select the Name field of the trunk, set or target line.

2. Type the name of the line or set.
Line and set names are a maximum of seven characters long.

3. Repeat steps 1 and 2 for each line and set on the Norstar system.

Received numbers are available only on expanded Modular systems. Before you
can change the received number of a target line, you must access the System
Programming Over view screen.

To change the received number:
1. Select the Rec'd # field of the target line you want to change.

2. Type the new received number.
The new received number must be the same length as the old received
number. To change the number of digits required for a received number, refer
to Changing the DN length .

3. Repeat steps 1 and 2 for each received number you are changing.

The set type can be changed when the set is not physically connected to the port.
Before you can program which type of sets will be connected to a Norstar system,
you must access the System Pr ogramming Over view screen.

To program the type of sets connected:

1. Double click on the Type field of the set in the Sets data box.
A menu of possible set types appears.

2. Choose the type of set used on this DN.
Note: You cannot change set type on the port the RAD is currently
connected to.

3. Repeat the steps 1 to 2 for each of the sets to be programmed.
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Initializing
Programming

Initializing a
system

Note: Use care when programming line and set types to expansion modules.
Norstar Manager assumes that you know which type of expansion module has
been added to the KSU and does not check if you are programming the correct
type of device to the module.

Initializing a system returns all programmable options to the default values. If you
just need to make minor changes, initializing may not be necessary. You may want
to change only the required options.

When you initialize a system, you are applying a new template to that system. This
changes all of the programming parameters to their default values.

There are five different types of system templates: Square, Centrex, Hybrid, PBX
and DID. Each template has a different set of default programming parameters.
For detailed listing of what the difference is in programming defaults, see the
appropriate Norstar Installer Guide .

The type of template that you can apply depends on the type of Norstar system
you are programming. Table 6.1 lists the templates available for each type of
Norstar system.

System Square Centre x Hybrid PBX DID
NA-MICS-DR 1.1 g g g g g
CDA-MICS-XC 1.1 g g
USA-MICS-XC 1.1 g g
USA-MICS-XC 1.0 g g
CDA-MICS-XC 1.0 g
T1 Release 1 O O O O O
Modular DR 5 ad ad ad ad
Centrex+ d
Centrex Release 1 O
Compact DR5 g a a
3X8 DR5 g g g

Table 6.1 — System templates
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To initialize a system:
1. Move to the System Pr ogramming Over view screen.

2. Choose the Edit menu and then the Initializ e System menu item.
The Initializ e System screen appeatrs.

[E Morstar Manager-Initialize System HEE
Help

Initialize System

== CAUTION ===

System startup will erase any existing programming

and reset all parameters to their spstem defaults.

Start DN:|2221

Startup template: | [EES d
System: Modular
Customer Name: MWICS 1.1
System ID: 1115551235 Cancel ||  Done |
| Ready [ [ [10/7/96 10:53:36AM |

Figure 6.4 — The Initialize System screen

3. Select the Start DN field and type the DN of the first set. The rest of the set
DNs will number sequentially from this DN.
Note: This field is only available for T1 Release 1, Centrex Release 1, CDA-
MICS-XC 1.0, USA-MICS-XC 1.0, NA-MICS-DR 1.1, CDA-MICS-XC 1.1,
and USA-MICS-XC 1.1 systems.

4.  Choose the drop list arrow beside the Startup template field and choose a
template from the list shown.

5. Choose to implement your changes.

When you initialize a system, the on-line session will terminate automatically.

Note: The DN length does not change when you initialize the system. To change
the DN length to or from its default value, you must use the Chang e DN Length
screen. For more information, refer to Changing the DN length later in this
section.
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Initializing a line When you initialize a line, you are erasing any programming changes that were
made to the line. All of the programming parameters for the line are set to their
default values.

To initialize a line:
1.  Select the line or lines that you want to initialize.

2. Choose the Edit menu and then the Initializ e Line menu item.

Initializing a set When you initialize a set, you are erasing any programming changes that were
made to the set. All of the programming parameters for the set are changed to
their default values.

To initialize a set:
1. Select the set or sets that you want to initialize.

2. Choose the Edit menu and then the Initializ e Set menu item.

System System programming information is found in the System Programming section of
programming the programming record. System programming involves entering information
about:

. Call handling

. Miscellaneous 1

. Miscellaneous 2 (Modular only)

. System Centrex (Centrex+ and Centrex Release 1 only)
. Service modes

. Ringing Groups CDA-MICS-XC 1.0, USA-MICS-XC 1.0, NA-MICS-DR 1.1,
CDA-MICS-XC 1.1, and USA-MICS-XC 1.1 only)

. Date and Time

. System Filters

. System Passwords

. System speed dials

. Remote access packages (Modular only)

. Trunk cartridges (T1 Release 1, CDA-MICS-XC 1.0, USA-MICS-XC 1.0,
NA-MICS-DR 1.1, CDA-MICS-XC 1.1, and USA-MICS-XC 1.1 only)

. Routing table (T1 Release 1, CDA-MICS-XC 1.0, USA-MICS-XC 1.0,
NA-MICS-DR 1.1, CDA-MICS-XC 1.1, and USA-MICS-XC 1.1 only)

. Destination codes (T1 Release 1, CDA-MICS-XC 1.0, USA-MICS-XC 1.0,
NA-MICS-DR 1.1, CDA-MICS-XC 1.1, and USA-MICS-XC 1.1 only)

. Change individual DNs
. Change DN length
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Each area of information is entered into the Norstar system through a dedicated
screen. These screens are accessed by selecting an option from the Program
menu.

After you have entered information in one of these screens, you can:

«  Choose to implement your changes and move to the next pro-

gramming screen.

«  Choose to implement your changes and move to the previous

programming screen.

«  Choose to cancel all new programming changes and return to
the System Pr ogramming Over view screen.

«  Choose to implement the new programming changes and

return to the System Pr ogramming Over view screen.

Note: The steps described in this section assume that you are starting from the
System Pr ogramming Over view screen. If you are not, return to the System
Programming Over view screen or use | Met  Jor|  Back | to move
to the appropriate programming screen.
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Call handling To enter Call handling information:

1. Choose the Program menu and then the System menu item.
2. Choose the Call Handling menu item.
The Call Handling screen appears.
[E Morstar Manager-System Programming HEE
Help
Call Handling
[ Held line reminder delay: »EO d
[X Delayed ring transfer to prime Delayed ring transfer to prime dela_-,-:l 3 j
[¥ Directed pickup
[X Page tone
“Voice Message Center Telephones
VMsag telephone # 1- Tranzfer callback delay: (w2 d
¥Msg telephone i 2- Park prefix: | » 1 j
VMsg telephone & 3: Park mode: | » Lowest j
VMsg telephone # 4: Call park timeout delay: |» 45 d
VMsg telephone # 5 Camp timeout delay: | » 45 d
Reach Through Codes On hold feedback: | » Tone j
F = Link/Flash W = Wait for dial tone Page timeout: I 2700 j
P = Pause R = Programmed Release
System: Modular
Customer Hame: MICS 1.1
KSU Location: Telephone room
System ID: 1115551235 Cancel ||  Done |
Ready [ [ | 1047796 11:05:29 AM |

Figure 6.5 — The Call Handling screen

3.

If Held reminder is to be enabled, choose the Held reminder check box.
Then choose the drop list arrow beside the Held line reminder dela vy field.
A list of delays appears. Choose the desired Held line reminder delay.

If Delayed ring transfer to prime is to be enabled, choose the Delayed ring
transf er to prime check box and then choose the drop list arrow beside the
Delayed ring transf er to prime dela vy field. A list of transfer delays appears.
Choose the desired Delayed ring transfer to prime delay.

If Directed pickup is to be enabled, choose the Directed pickup check box.

If Page Tone is to be enabled, choose the Page Tone check box.
Note: This field is only available for CDA-MICS-XC 1.0, USA-MICS-XC 1.0,
NA-MICS-DR 1.1, CDA-MICS-XC 1.1, and USA-MICS-XC 1.1 systems.

In the Voice Messa ge Center Telephones box, select the text box for VMsg
telephone #1 . Type the telephone number of the voice message center.

Repeat step 7 for each voice message center.

Choose the drop list arrow beside the Transf er callbac k delay field. Choose
the Transfer callback delay from the list shown.
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Miscellaneous 1

10.

11.

12.

13.

14.

Choose the drop list arrow beside the Park prefi x field. Choose the Park
prefix from the list presented.

Note: In early versions of DR5 KSU software, the Park prefix could not be
changed to or from None by Norstar Manager. To avoid potential problems,
we recommend that you do not set the Park prefix to None on KSUs with
early releases of DR5 software.

Choose the drop list arrow beside the Call park timeout dela y field. Choose
the Call park timeout delay from the list shown.

Choose the drop list arrow beside the Camp timeout dela y field. Choose
the Camp timeout delay from the list shown.

Choose the drop list arrow beside the On hold f eedback field. Choose the
desired option from the list shown.

Choose the drop list arrow beside the Page timeout field. Choose the Page
timeout delay from the list shown.

Note: This field is only available for CDA-MICS-XC 1.0, USA-MICS-XC 1.0,
NA-MICS-DR 1.1, CDA-MICS-XC 1.1, and USA-MICS-XC 1.1 systems.

Choose to exit this screen and implement your changes.

To enter Miscellaneous programming information:

1.
2.

Choose the Program menu and then the System menu item.

Choose the Miscellaneous 1 menu item. The Miscellaneous 1 screen
appears.

Note: On Compact DR5 or 3X8 DR5 systems, this screen and menu item
are titled Miscellaneous .
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[E Morstar Manager-5ystem Programming HAEE
Help

Mizcellaneous 1

Line pool access codes

Direct dial number: _j Pool Code
Alarm set: [P727 27921 j Pool A 9
Pool B
DISA DN: Pool C
Auto DN: Pool D

Link time: | » 500 j msec Pool E
Pool F

Host delay: | » 1000 =
ost delay. || msec Pool G

Ezxternal line code: | * None j Pool H
Receiver volume: I *Use system volume J Pool |
Pool J
[~ Background music Poal K
) Pool L
[ Set relocation Pool M
[X Daylight savings Pool H
Pool O
System: Modular
Customer Name: MICS 1.1 | Back I | Next I
KSU Location: Telephone room — —
System ID: 1115551235 [ cancel || Dome |
Ready | | [10/7/96 11:07:04 AM |

Figure 6.6 — The Miscellaneous 1 screen

3. Choose the drop list arrow beside the Direct dial n umber field and then
choose a digit from the list.

4.  Select the Alarm set field and type the DN of the set designated to receive
Norstar alarms. To select one of the default alarm sets, choose the drop list
arrow beside this field and choose the required set.

5.  Select the DISA DN field and type the DN specified in the programming
record.

6. Select the Auto DN field and type the DN specified in the programming
record.

7. Choose the drop list arrow beside the Link time field and then choose the
time specified in the programming record.

8. Choose the drop list arrow beside the Super vision time field and then
choose the time specified in the programming record.
Note: This field is not available for T1 Release 1, CDA-MICS-XC 1.0, USA-
MICS-XC 1.0, NA-MICS-DR 1.1, CDA-MICS-XC 1.1, or USA-MICS-XC 1.1
systems.

9. Choose the drop list arrow beside the Host delay field and then choose the
time specified in the programming record.

10. Choose the drop list arrow beside the External line code field and then
choose the code that will allow a user to access an external line.
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Miscellaneous 2

11.

12.

13.

14.

15.

16.

17.

Choose the drop list arrow beside the Receiv er volume field and then
choose one of the options shown.

Note: This field is only available for T1 Release 1, CDA-MICS-XC 1.0, USA-
MICS-XC 1.0, NA-MICS-DR 1.1, CDA-MICS-XC 1.1, and USA-MICS-XC 1.1
systems.

If Background music is to be enabled, choose the check box beside it.
If Set relocation is to be enabled, choose the check box beside it.

If Daylight sa vings is to be enabled, choose the check box beside it.
Note: This field is only available for CDA-MICS-XC 1.0, USA-MICS-XC 1.0,
NA-MICS-DR 1.1, CDA-MICS-XC 1.1, and USA-MICS-XC 1.1 systems.

Select the field under the heading Code for the line pool you are program-
ming.

Type the line pool access code indicated for the line pool on the program-
ming record.

Repeat steps 15 and 16 for each line pool access code to be entered.

Choose to exit this screen and implement your changes.

The programming information accessed with the Miscellaneous 2 screen only
applies to Modular KSUs. If you are not programming a Modular KSU, skip to
Service Mod es to continue system programming.

To enter additional Miscellaneous programming information:

1.
2.

Choose the Program menu and then the System menu item.

Choose the Miscellaneous 2 menu item. The Miscellaneous 2 screen
appears.

Norstar Manager for Windows™ User Guide



Section 6: Programming a Norstar system 6 - 15

[E Morstar Manager-5ystem Programming HAEE
Help

Mizcellaneous 2
Enhanced CAPs

ECAF Sets
Mone
Mone
Mone
Mone
Direct Dial Extensions
Destination Set External number Resource | M~
Internal 2221 2221 Mone Dié—l
None Hone Mone Dis
None None Mone Dis
None Hone Mone Dis
None None None Dis
K| LI—I

System: Modular

Customer Name: MICS 1.1 | Back I | Next I
KSU Location: Telephone room — —
System ID: 1115551235 [ cancel || Dome |
Ready | | [10/7/96 11:08:12 AM |

Figure 6.7 — The Miscellaneous 2 screen

3. Select the first ECAP Sets field.

4.  Type the DN the CAP is assigned to.
Note: To delete an ECAP assignment, select the ECAP Sets field and
type None

5. Repeat steps 3 and 4 for each ECAP on the system.

6. Select the direct dial field you want to program and type the DN of the direct
dial set. Repeat this step for each direct dial number.
Note: If you are programming a Modular DR5, Centrex+, or Centrex Release
1 system, you are finished programming on the Miscellaneous 2 screen. If
you are programming a T1 Release 1, CDA-MICS-XC 1.0, USA-MICS-XC
1.0, NA-MICS-DR 1.1, CDA-MICS-XC 1.1, or USA-MICS-XC 1.1 system,
complete steps 7 to 12 instead of step 6.

7. Select the Destination field of the Direct Dial set you want to program and
choose either Internal, External or None.

8.  Select the Set field and choose or type the DN of the Direct Dial set.

If this is an external Direct Dial set, select the External n umber field and
type the external number.

10. If this is an external Direct Dial set, select the Resour ce field and choose a
line, a line pool or the routing code.

11. Select the Manual Override field and choose either Disabled or Enabled.

12. Repeat steps 7 to 11 for each Direct Dial set.

Choose to exit this screen and implement your changes.
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System Centre x

Centrex options only apply to Centrex+ and Centrex Release 1 systems. If you are
programming a system other than an Centrex+ or Centrex Release 1 system, skip
to Service Modes to continue system programming.

To enter Centrex options programming information:

1. Choose the Program menu and then the System menu item.

2. Choose the Centre x Access menu item. The Centre x Access screen

appears.
[E Morstar Manager-System Programming HEE
Help
Centrex Access
Feature access codes
Feature Code Centrex delays
Call Forward after link: m Sec
Cancel Call Forward
Ring Again after feature: I 1 j Sec
Cancel Ring Again
Group Call Pickup Beyond Centrex:
Directed Call Pickup
Busy Overnde/Prionty Call [ 2 L3
Make Set Busy a4 5 6
Cancel Make Set Busy 'z '8 £
Anszwer Waiting Call F o
Alternate calls F
F = Link/Flazh
Mote: Please ensure that the feature access
codes match with the host system %
System: Modular
Customer Mame: Centrex | Back I | Mext I
ESU Location: Telephone Room = —
System ID: 1234567890 [ cancetl || Done |
Ready [ [ | 1049796 1:37:17 PM |

Figure 6.8 — The Centrex Access screen

3.  Select the code field of the feature to be programmed and then type the
code specified in the programming record.

4. Repeat step 3 for each feature code you are changing.

Choose the drop list arrow beside the after link field and then choose the
time used for the after link delay.

6. Choose the drop list arrow beside the after f eature field and then choose
the time used for the after feature delay.

7. Choose the Beyond Centre x check box for each digit that can be used for
beyond Centrex access.

Choose to exit this screen and implement your changes.

Norstar Manager for Windows™ User Guide



Section 6: Programming a Norstar system 6 -17

Service modes

To enter Service modes programming information:
1. Choose the Program menu and then the System menu item.

2. Choose the Service Modes menu item. The Service Modes screen

appears.

[E Morstar Manager-System Programming HEE
tode Times  RBinging Groups Help
Service Modes
Mode HName Ring Serv TAFAS Extra-dial zet DM Rest Serv | Rout Serv Dverflow
1 Dizabled
2 Evening Off On 21 221 oFf off Dizabled
3 Lunch Orf On 221 221 OFf aFf Disabled
4 Mode 4 oOff On 211 221 off off Dizabled
5 Mode 5 off On 211 221 oFf off Dizabled
6 Mode 6 Off On 221 221 oFf off Dizabled

System: Modular
Customer Name: MICS 1.1 | Back I | Mext I
ESU Location: Telephone room = —
System ID: 1115551235 [ cancetl || Done |
Ready [ [ | 1047796 11:10:12 AM |

Figure 6.9 — The Service Modes screen
To edit the Service Modes for 3X8 DR5, Compact DR5, Modular DR5, and
Centrex+ systems:

1. Select the Name field and type the name of the service you are program-
ming.

2. Select the Type field and then choose a type of operation.
Note: If you choose Manual or Off, go to step 5.

3. Select the Start time field and type the time the service is to start.
Enter this time in the format HHMM using the 24 hour clock. For example,
11:00 pm would be entered “2300".

4.  Select the Stop time field and type what time the service is to stop.
Enter this time in the format HHMM using the 24 hour clock. For example,
11:00 pm would be entered “2300".

5. Select the TAFAS field and then choose On or Off.
Select the Extra-dial set DN field and type the DN of the Extra-dial set.

Repeat steps 1 through 6 for the remaining service modes.
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To edit the Service Modes for T1 Release 1, CDA-MICS-XC 1.0, USA-MICS-XC
1.0, NA-MICS-DR 1.1, CDA-MICS-XC 1.1, or USA-MICS-XC 1.1 systems:

1. Select the Name field and type the name of the service you are program-
ming.

2.  Select the Ring Ser v field and then choose a type of operation.
Note: If you choose Manual or Off, go to step 8.

3. Choose the Mode Times menu.
The Mode Times screen appears.

4. Select the Start time field and type the time the service is to start.
Enter this time in the format HHMM using the 24 hour clock. For example,
11:00 pm would be entered “2300".

5.  Select the Stop time field and type what time the service is to stop.
Enter this time in the format HHMM using the 24 hour clock. For example,
11:00 pm would be entered “2300".

Repeat steps 5 and 6 for each of the seven days.

Choose to return to the Service Modes screen

6

7

8.  Select the TAFAS field and then choose On or Off.

9 Select the Extra-dial set DN field and type the DN of the Extra-dial set.
10. Select the Rest Serv field and choose either Auto, Manual or Off.

11. Select the Rout Ser v field and choose either Auto, Manual or Off.

12. Select the Overfl ow field and choose either Enabled or Disabled.

13. Repeat steps 1 through 12 for the remaining service modes.

Choose to exit this screen and implement your changes.

Ringing gr oups Ringing groups are part of Service mode programming for T1 Release 1, CDA-
MICS-XC 1.0, USA-MICS-XC 1.0, NA-MICS-DR 1.1, CDA-MICS-XC 1.1, and
USA-MICS-XC 1.1 systems only.

Note: On earlier versions of T1 Release 1 systems the Ringing Gr oups menu
does not appear in the menu bar. You cannot program ringing groups for these
earlier versions.

Before you begin, make sure the Service Modes screen appears on your monitor.
To add ringing groups:

1. Choose the Ringing Gr oups menu. The Ringing Gr oups screen appears.
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[E Morstar Manager-5ystem Programming HAEE
Edit Group Help
Ringing Groups

Ringing Grou, S
ging P j
2
3
Fi
L
6
¥
]
9
10 =
System: Modular
Customer Name: MICS 1.1
K5U Location: Telephone room
Spztem ID: 1115551235
Ready [ [ [10/7/96 11:15:26 AM |

Figure 6.10 — The Ringing Groups screen

2. Select the ringing group you are changing.

3. Choose the Edit menu.
The Edit Ringing Gr oups screen appears showing all of the set assigned to
the group.

To add sets to the ringing group:

1. Choose the Edit menu and then the Assign set(s) menu item.
The Select ringing sets dialog box appears.

2.  Select the sets you want to add to this ringing group.
3. Choose to return to Ringing Gr oups screen.

To delete sets from the ringing group:
1. Select the sets you want to delete from this ringing group.

Choose the Edit menu and then the Delete set(s) menu item.

2.
3. Choose to return to Ringing Gr oups screen.
4.

Repeat steps 2 to 9 for each ringing group you want to edit.

Choose to exit the Ringing Gr oups screen and implement your

changes.

Choose to exit the Service Modes screen.
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Changing the KSU
date and time

System Filters

To enter the KSU date and time:

1. Choose the Program menu and then the System menu item.

2. Choose the Date and Time menu item. The Date and Time screen appears.

[E Morstar Manager-System Programming HEE
Help

Date and Time

K5U date and time

Date [yyyyimmidd] Time [hh:mm)

1995701701 01:21

Time difference from local time 2.0

System: Modular
Customer Hame: MICS 1.1
KSU Location: Telephone room
System ID: 1115551235

hours

Set the KSU Date and Time |

Update Status

| Back Hext I

B J |
| gancel I | Done I

Ready [ [

[10/7796 11:17:36 AM |

Figure 6.11 — The Date and Time screen

3. Choose to get the date and time that is stored in the KSU.

4. Select the KSU date and time field and type in the new date and time.

Type this information in the format yyyy/mm/dd hh:mm

hours/minutes).

5. Choose |  Setthe KSU Date and Time |

(year/month/day

Choose to exit this screen and implement your changes.

Note: You must always edit the KSU Date and Time field in order to set the KSU
date and time successfully. This means you must complete steps 3 and 4 before

performing step 5.

The value in the Time diff erence fr om local time field is the same value as is
recorded in the Remote time diff erence field on the Add new system screen.
This field can be changed from the System Details screen.

To access the System Filter s screen:

1. Choose the Program menu and then the System menu item.
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2.  Choose the System Filter s menu item. The System Filter s screen

appears.
[E Morstar Manager-5ystem Programming HAEE
Edit Help

Sypstem Filters

Filters

Restrictions

System: Modular

Customer: MICS 1.1 | Back I | Next I
KSU Location: Telephone room — —
System ID: 1115551235 [ cancel || Dome |
Ready | | [10/7796 11:11:59 AM |

Figure 6.12 — The System Filters screen

Filter s
To add a filter:

1. Choose the Edit menu and then the Add filter menu item. The Add Filter
dialog box appears. Select the filter you want to add and press

2. The Restrictions dialog box appears with the new filter number displayed in
the Filter n umber field.

3.  Since a filter must have at least one restriction defined, you must enter a
restriction number. Select the Restriction digits field and enter the new
restriction number.

4. Choose to return to the System Filter s screen.

When you enter the maximum number of restrictions and exceptions, a warning
message appears. If you delete some filters, extensions or restrictions and try to
add new ones the error message remains. You must delete some filters, return to
the System Programming Overview screen, and then return to System Filter s
screen and add the new filters.

To delete filters:
1. Select the filter or filters to be deleted

2. Choose the Delete fi lter menu item.
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3.

Choose

When you are editing a filter, you are adding, deleting or changing the restrictions
and exceptions that are assigned to the filter. Refer to the Restrictions and
Exceptions sections for more information.

Restrictions
Before you can add, delete or edit restrictions, you must access the Restrictions
dialog box. To access the Restrictions dialog box:

1.
2.

Select the filter with the restrictions you want to add, delete or edit.

Choose
The Restrictions dialog box appears with the number of the filter you
selected in the Filter n umber field.

Filter number: 1
Number Restriction digits

ol 1]

o2 1

o3 911

04 411

05 976

A =Any

| Delete I | Exceptions I
| Add | | Done |

Figure 6.13 — The Restrictions dialog box

To add restrictions:

1.

Choose

A new restriction is added to the dialog box.

Select the Restriction digits  field and type the restriction number.
Note: If there are exceptions for this restriction, refer to the Exceptions
section for information about adding, deleting and editing exceptions.

Repeat steps 1 and 2 for each restriction you are adding to this filter.

Choose to save your changes and return to the System

Filter s screen.

To edit a restriction:

1.
2.

3.

Select the Restriction digits field for the restriction you are changing.

Type the new restriction digits.

Choose to save your changes.
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Impor tant: When you change a restriction, you must also change the exceptions
that are assigned to that restriction. Therefore, Norstar Manager will automatically
open the Exceptions dialog box after you save your changes to the restriction.

If you press Alt+A and the Exceptions screen appears for different restriction, you

must delete any empty exceptions and choose to return to the

Restrictions screen. Highlight the restriction you want to add and choose
. Choose to add exceptions. Choose

To delete restrictions:

1. Select the restrictions to delete.

2. Choose
3. Choose to save your changes and return to the System

Filter s screen.

Exceptions
Before you can add, delete or edit exceptions, you must access the Exceptions
dialog box. To access the Exceptions dialog box:

1. Select the filter with the exceptions you want to add, delete or edit.

2. Choose

The Restrictions dialog box appears with the number of the filter you
selected in the Filter n umber field.

3.  Select the restriction with the exceptions you want to add, delete or edit.

4 Choose

The Exceptions dialog box appears with the number of the filter and restric-
tion you selected shown at the top of the dialog box.

Filter number: 1
Restriction: 3
Restriction Digits: 911
MNumber Exception digits
oot 911
A= Anyp
| Add | | bpone |

Figure 6.14 — The Exceptions dialog box
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Passwords

To add exceptions:

1.

Choose

A new exception is added to the dialog box.
Select the Exception digits field and type the exception number.

Repeat steps 1 and 2 for each exception you are adding to this restriction.

Choose to save your changes and return to the Restrictions

dialog box.

To edit an exception:

1.
2.

3.

Select the Exception digits field for the exception you are changing.

Type the new exception digits.

Choose to save your changes and return to the Restrictions

dialog box.

To delete exceptions:

1.
2,

3.

Select the exceptions to delete.

Choose
Choose to save your changes and return to the Restrictions

dialog box.

Choose to return to the System Filter s screen.
Choose to exit the System Filter s screen and implement your

changes.

To enter System Passwords and change Administration and Configuration pass-
words:

1.
2.

Choose the Program menu and then the System menu item.

Choose the System P asswords menu item. The System P asswords
screen appears.
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[E Morstar Manager-5ystem Programming HAEE
Help

Spstem Passwords

=*CONFIG password: |[E{SeEE

“*ADMIN password: |23E4B

Pswd Number [CO5 Password User Filter | Line Filter Remote Package |;|
oo Deflt Deflt Deflt H
o Defit Defit Defit
o0z Deflt Deflt Deflt
03 Defit Defit Deflt
04 Deflt Deflt Deflt
05 Deflt Defit Deflt
06 Deflt Deflt Deflt
o7 Deflt Deflt Deflt
o8 Deflt Deflt Deflt
09 Deflt Deflt Deflt -

System: Modular

Customer Name: MICS 1.1 | Back I | Next I
KSU Location: Telephone room — —
System ID: 1115551235 [ cancel || Dome |
Ready | | | [10/7796 11:19:14 AM |

Figure 6.15 — The System Passwords screen
3.  Select the *CONFIG password text box and type the new Configuration
password.

4.  Select the *ADMIN password text box and type the new Administration
password.

5. Select the first COS Password field.
6. Type the password indicated on the programming record.

7. If a User filter is used with this password, select the User Filter field and
type the number of the User filter or choose one of the filters from the list
shown.

8. If a Line filter is used with this password, select the Line Filter field and type
the number of the Line filter or choose one of the filters from the list shown.

9. If a Remote access package is accessed using this password, select the
Remote P ackage field and type the number of the remote package or
choose one of the remote packages from the list shown.

10. Repeat steps 5 to 9 for each password listed on the programming record.

Choose to exit this screen and implement your changes.

System speed To enter system speed dial numbers:

dials 1. Choose the Program menu and then the System menu item.
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2. Choose the System Speed Dials menu item. The System Speed Dials
Screen appears.
Help
System Speed Dials
Code Phone number Line HName Show |Bypass |~
|I]1 Prime Sys Spd Dial 01 Y N
02 Prime Sys S5pd Dial 02 Y ]
03 Prime Syz Spd Dial 03 Y N
04 Prime Sys S5pd Dial D4 Y ]
05 Prime Sys Spd Dial 05 Y N
06 Prime Sys S5pd Dial 06 Y ]
o7 Prime Sys Spd Dial 07 Y N
08 Prime Sys S5pd Dial 08 Y ]
09 Prime Sys Spd Dial 09 Y N
10 Prime Sys S5pd Dial 10 Y ]
1 Prime Sye Spd Dial 11 Y N
12 Prime Syps Spd Dial 12 Y N
13 Prime Sys Spd Dial 13 Y ] =
-Reach Through Codes
F = Link/Flazh P = Pause R = Programmed Release
# = Run/Stop W = Wait for Dial Tone
System: Modular
Customer Na_me: MICS 1.1 | Back I | Next I
KSU Location: Telephone room
System ID: 1115551235 | Cancel ||  Done |
Ready [ [ [ | 10/7/96 11:21:32 AM |

Figure 6.16 — The System Speed Dials screen

Select the Phone number field of the System speed dial to be programmed.

Type the speed dial number indicated on the programming record.

Note: You can enter Link/flash, Wait for tones, Pause, Run/stop, and
Programmed release codes within the number, but remember some of these
codes use up to two spaces within the number. The maximum length for the
speed dial phone number is 24 digits.

Select the Line field and then choose a line, line pool or routing code from
the list.

Select the Name field and then type the name for the speed dial code.

Select the Show field and then choose Y if you want the speed dial number
shown on the set.

Select the Bypass field and then chooseY if the speed dial number is to
bypass restrictions.

Repeat steps 3 through 8 for each speed dial number on the programming
record.

Choose to exit this screen and implement your changes.
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Remote access Use the Remote Access P ackages screen to select the line pools that are
packages restricted from use by remote access packages. On this screen you also assign
whether the remote access package can use the page feature.

Note: Remote access packages are only available on Modular DR5,

T1 Release 1, CDA-MICS-XC 1.0, USA-MICS-XC 1.0, NA-MICS-DR 1.1, CDA-
MICS-XC 1.1, and USA-MICS-XC 1.1 systems.

To assign remote access:

1. Choose the Program menu and then the System menu item.

2. Choose the Remote Access P ackages menu item. The Remote Access
Packages screen appears.

[E Morstar Manager-System Programming HEE
Help

Remote Access Packages

Package Feature D Option 0 Feature 1 Option 1
Line Pool ;
02 Line Pool Pool A Line Pool Pool B Line
03 Line Pool Pool A Line Pool Pool B Line
04 Line Pool Pool A Line Pool Pool B Line
05 Line Pool Pool A Line Pool Pool B Line
06 Line Pool Pool A Line Pool Pool B Line
07 Line Pool Pool A Line Pool Pool B Limne
08 Line Pool Pool A Line Pool Pool B Line
039 Line Pool Pool A Line Pool Pool B Line
10 Line Pool Pool A Line Pool Pool B Line
11 Line Pool Pool A Line Pool Pool B Line
12 Line Pool Pool A Line Pool Pool B Line _
System: Modular
Customer Name: MICS 1.1 | Back I | Next I
KSU Location: Telephone room
System ID: 1115551235 | Cancel || Done |
Ready [ [ [ | 1047796 11:24:04 AM |

Figure 6.17 — The Remote Access Packages screen

3.  Select the Feature field of a line pool that cannot be used with the remote
access package you want to edit. Choose None from the choice list shown.
Note: The line pool designation for this field will also change to none.

4. Repeat step 3 for each line pool that cannot be accessed using the remote
access package.

5. Repeat step 3 for one of the paging features if all of the paging features
cannot be accessed using this remote access package.

6. Repeat steps 3 to 5 for each remote access package to be programmed.

Choose to exit this screen and implement your changes.
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Trunk Car tridg es

The programming information accessed with the Trunk Car tridg es screen only
applies to T1 Release 1, CDA-MICS-XC 1.0, USA-MICS-XC 1.0,

NA-MICS-DR 1.1, CDA-MICS-XC 1.1, and USA-MICS-XC 1.1 systems. If you are
programming a different type of system, skip to Chang e individual DNs to
continue system programming.

The Trunk Car tridg es screen shows the type of cartridges connected to the KSU.
It also provides access to the trunk cartridge parameters. To view the trunk
cartridges:

1. Choose the Program menu and then the System menu item.

2. Choose the Trunk Car tridg es menu item. The Trunk Car tridg es screen

appears.
Cartridge Parameters Help
Trunk Cartridges
Module Cartridge Type =]
|02 1 Loop -
02 2 Loop
o3 1 Loop
03 2 Loop
o3 3 Loop
04 1 Loop
04 2 Loop
04 3 Loop
05 1 Loop
System: Modular
Customer Name: MICS 1.1 | Back I | Next I
K5U Location: Telephone room
System ID: 1115551235 | Cancel || Done |
Ready [ [ [ | 1047796 11:24:58 AM |

Figure 6.18 — The Trunk Cartridges screen

3. Choose the Type field and then choose a trunk cartridge type.
Note: The trunk cartridge must be disabled under Module Status before it
can be changed.

The trunk cartridge parameters are changed using two different screens: the KSU
Trunk Car tridg es screen and the Module Trunk Car tridg es screen.

To change the parameters of the trunk cartridges connected to the core KSU:

1. Choose the Cartridg e Parameter s menu and then the KSU Trunk
Cartridg es menu item.
The KSU Trunk Car tridg e Parameter s screen appears.
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[ System Programming-Trunk Cartridge Parameters

K5U Trunk Cartndge Parameters

Digital Cartridge only
Lines Busy: ll]— Answer Timer: m
Carrier Fail: Im
Framing Format: IbExtended Super Frame J
Line Coding: Im

I/F Level: [*ISDN Levels =]

Disconnect Timer: 'm-j

Internal C5U options

Internal CSU: IPI]n j

CSU Line Build: | =0 dB j [if On]

DSX1 Build: {»0-100 feet j [if OFF)

System: Modular
Customer Hame: MICS 1.1
KSU Location: Telephone room
System ID: 1115551235 Cancel ||

Done I

Ready [ [ [ [10/7796 11:30:36 AM |

Figure 6.19 — The KSU Trunk Cartridge Parameters screen
2. Choose the drop list arrow beside the Disconnect Timer field and choose
one of the times listed.

3.  Choose the drop list arrow beside the Answer Timer field and choose one of
the options listed.

4.  Choose the drop list arrow beside the Carrier F ail field and choose one of
the options listed.

5. Choose the drop list arrow beside the Framing Format field and choose
one of the formats listed.

6. Choose the drop list arrow beside the Line Coding field and choose one of
the coding formats listed.

7. Choose the drop list arrow beside the I/F Levels field and choose one of the
levels listed.

8. Choose the drop list arrow beside the Internal CSU field and choose either
On or Off.

9. Choose the drop list arrow beside the CSU Line Build field and choose one
of the options listed.

10. Choose the drop list arrow beside the DSX1 Build field and choose one of
the distances listed.

Choose to implement your changes and return to the Trunk

Cartridg es screen.
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To change the parameters of the trunk cartridges connected to the expansion
modules:

1. Choose the Cartridg e Parameter s menu and then the Module Trunk
Cartridg es menu item.
The Module Trunk Car tridg e Parameter s screen appears.

[E System Programming-Module Trunk Cartridge Parameters

Module Trunk Cartridge Parameters

Lines Busy: | 0

-Loop Cartridge Only

Dizconnect Timer: 'm-j

-E & M Cartridge only

Answer Timer: |b2 =l

System: Modular
Customer Hame: MICS 1.1
KSU Location: Telephone room
System ID: 1115551235 Cancel ||

Done I

Ready [ [ [ [ 1077796 212:52 PM |

Figure 6.20 — The Module Trunk Cartridge Parameters screen

2. Choose the drop list arrow beside the Disconnect Timer field and choose
one of the times listed.

3.  Choose the drop list arrow beside the Answer Timer field and choose one of
the options listed.

Choose to implement your changes and return to the Trunk

Cartridg es screen.

Choose to exit this screen and implement your changes.
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Routing tab le The programming information accessed with the Routing tab le screen only
applies to T1 Release 1, CDA-MICS-XC 1.0, USA-MICS-XC 1.0,
NA-MICS-DR 1.1, CDA-MICS-XC 1.1, and USA-MICS-XC 1.1 systems. If you are
programming a different type of system, skip to Chang e individual DNs to
continue system programming.

To enter routing codes:
1. Choose the Program menu and then the System menu item.

2. Choose the Routing Table menu item. The Routing Table screen appears.

[E Morstar Manager-System Programming HEE
Help

Routing Table

Route Mo. Facility Dial out Humber -]
oo None
ooz None
003 Mone
004 Mone
005 Mone
006 Mone
o007 Mone
oog Mone
o003 None
P = Pause W ="wait for dial tone

System: Modular

Customer Name: MICS 1.1 | Back I | Mext
KSU Location: Telephone room = —
System ID: 1115551235 [ cCancel ||  Dome
Ready [ [ (10/7/96 11:26:36AM |

Figure 6.21 — The Routing Table screen

Select the Facility field and choose the line pool used by the routing code.

4.  Selectthe Dial out Number field and type the telephone number this routing
code will dial.
Note: You can enter Pause and Wait for dial tone within the number, but
remember these codes use up to two spaces within the number. The
maximum length for the dialing string is 24 digits.

Choose to exit this screen and implement your changes.
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Destination Codes

The programming information accessed with the Destination Codes screen only
applies to T1 Release 1, CDA-MICS-XC 1.0, USA-MICS-XC 1.0,

NA-MICS-DR 1.1, CDA-MICS-XC 1.1, and USA-MICS-XC 1.1 systems. If you are
programming a different type of system, skip to Chang e individual DNs to
continue system programming.

To change the Destination Codes:

1.
2.

[E Morstar Manager-System Programming HEE

Choose the Program menu and then the System menu item.

Choose the Destination Codes menu item. The Destination Codes screen
appears.

Edit Help
Destination Codes

Mo. Code Momal | Mode1 | Mode 2 | Mode 3 | Mode 4 | Mode 5 | Mode 6 | Morm /4]
|l]l]1 a1 999 Mone m7z Mone None Mone None 7
o0z 87 999 025 None Mone None Mone None 7
o003 83 999 Mone None 021 Mone Mone Mone 7

System: Modular Update Table

Customer Name: MICS 1.1 | Back I | Mext I
KSU Location: Telephone room = —
System ID: 1115551235 | cancel || Done |
Ready [ [ [ | 10/7/36 14753FM |

Figure 6.22 — The Destination Codes screen

To add a destination code:

1.

Choose the Edit menu and then the Add Code menu item.

To program a destination code:

1.
2.
3.

Select the Code field and type the number of this destination code.
Select the Normal field and choose a routing code from the list.

Repeat step 2 for each of the Mode fields.

Note: The following three steps are applicable to USA-MICS-XC 1.0,
NA-MICS-DR 1.1, CDA-MICS-XC 1.1, and USA-MICS-XC 1.1 systems only.
If you are programming any other type of system, skip to step 7.

Select the Norm Absorb field and choose the number of digits absorbed
when the system is not using service modes.

Select the Second Mode field and choose the service mode used with digit
absorption.
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6. Select the Second Absorb field and choose the number of digits absorbed
when the system is using the service mode specified in the Second Mode
field.

7. For USA-MICS-XC 1.0, NA-MICS-DR 1.1, CDA-MICS-XC 1.1, and USA-
MICS-XC 1.1 systems, repeat steps 1 to 7 for each destination code. For all
other systems, repeat steps 1 to 3 for each destination code.

Note: Norstar Manager allows you to define routing codes that have not yet
been programmed. The KSU destination codes programming through
Feature **CONFIG does not allow you to do this.

To delete a destination code:
1. Select the code or codes to delete.

2. Choose the Edit menu and then the Delete Code menu item.

Choose to exit this screen and implement your changes.

Chang e individual Use the Chang e Individual DNs screen to change the DN assigned to a set. The
DNs DNs are sorted every time you access this screen, including when you leave this
screen to view the Help screens.

Note: You should warn the customer that the Norstar system may slow down for
about two minutes.

To change individual DNs:

1. Choose the Program menu and then the System menu item.

2. Choose the Chang e Individual DNs menu item.
The Chang e Individual DNs screen appears.
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[E Morstar Manager-5ystem Programming HAEE
Help
Change Individual DNs

[ DR mambers |

[2221
2222
2223
2224
2225
2228
2227
2228

System: Modular
Customer Name: MICS 1.1 |
KS5U Location: Telephone room
Syetem ID: 1115551235 | Cancel

Back Hext I

Ready [ [ [ [10/7/96 11:28:06 AM |

Done I

Figure 6.23 — The Change Individual DNs screen

3.  Select the DN you want to change and type the new DN.
Repeat this step for each DN you are changing.

Choose to exit this screen and implement your changes.

Changing the DN Use the Change DN Length screen to change the DN length and the Received

length number length.

When you change the DN length, you change the number of digits required to
access an internal device, such as a telephone set. The DN length can be from
two to seven digits long. You can only change the DN length on Modular systems.
Compact and 3X8 systems allow only a two digit DN.

Note: If you change the DN length from 2 digits, you cannot change it back to 2.

When you change the Received number length, you change the number of digits
required to make a specific target line ring. The Received number length can be
one to seven digits long. You can only change the Received number length on the
Modular KSUs. Target lines are not supported on Compact DR5 or 3X8 DR5
KSUs.

To change the DN length or Received number length:

1. Choose the Program menu and then the System menu item.
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2. Choose the Change DN Length menu item.
The Chang e DN Length screen appears.

[E Morstar Manager-5ystem Programming HAEE
Help

Change DM Length

DM length: nd Received number length: I 3 d

System: Modular

Customer Mame: MWICS 1.1
KS5U Location: Telephone room
System ID: 1115551235 Cancel ||  Done |

Ready [ [ [ [10/7/96 11:35:16 AM |

Figure 6.24 — The Change DN Length screen

3.  Choose the drop list arrow beside the DN length field and then choose the
number of digits used for the DN.

4.  Choose the drop list arrow beside the Received n umber length field and
choose the number of digits used for the Received number length.

Note: You should warn users that the Norstar system may slow down for up to two
minutes while the DN length is changing.

Impor tant: If you change the DN length, Norstar Manager will automatically

terminate the on-line session and return you to the Systems Director y screen.
For more information about on-line connections, see Section 5 of this guide.

Choose to exit this screen and implement your changes.
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Line
programming

Once you have entered the Norstar system programming information, you can
begin entering line programming information. This information is found in the
programming record. Make sure you follow the programming record for each line
programming screen you use.

For each line on the system, you can enter line programming information on:

. Line data

. Trunk data

. Abilities and call services

. Service mode options

Each area of information is entered into the Norstar system through a dedicated

screen. Refer to Figure 6.3 for an overview of the different areas of line program-
ming.

Before you can access a line programming screen, you must first select the line
you want to program.

To select a line using the mouse, move the mouse pointer onto the line you want
to program and press the mouse button.

To select a line using the keyboard, press and the cursor keys until the line
you want to program is highlighted.

After you have entered information in one of the line programming screens, you
can:

«  Choose to implement your changes and move to the next pro-

gramming screen.

«  Choose to implement your changes and move to the previous

programming screen.

«  Choose to cancel all new programming changes and return to

the System Pr ogramming Over view screen.

«  Choose to implement the new programming changes and

return to the System Pr ogramming Over view screen.

Note: The steps described in this section assume that you are starting from the
System Pr ogramming Over view screen. If you are not, return to the System
Programming Over view screen or use | Met Jor|  Back | to move
to the appropriate programming screen.

Important : Before you begin line programming, you must program the line type.
Refer to Installed equipment earlier in this section for instructions.
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Line data  To enter Line data information:
1. Select the line you want to program.
2. Choose the Program menu and then the Line menu item.

3.  Choose the Line Data menu item. The Line Data screen appears.

[E Morstar Manager-Line Programming HEE
Help
Line Data
Line type: jl
Incoming line group: |[None j|
Prime set: [2221 2221 =]

X Auto privacy
[~ Auxiliary ringer

Line number: 001

Line name: Line001
Cusztomer Name: MICS 1.1 Cancel I |

Done I

| Ready [ [ [10/7/96 11:36:58AM |

Figure 6.25 — The Line Data screen

4. If this line is a public line or is assigned to a line pool, choose the drop list
arrow beside the Line type field and choose Public or the assigned line

pool.
If this line is a private line, select the Line type field and type the DN of the

set the line is private to.

5.  Choose the drop list arrow beside the Incomin g line group field and choose
the line group this line belongs to.
Note: This field is only available for T1 Release 1, CDA-MICS-XC 1.0, USA-
MICS-XC 1.0, NA-MICS-DR 1.1, CDA-MICS-XC 1.1, and USA-MICS-XC 1.1
systems.

6. Select the Prime set field and type the DN of the prime set.
To enter one of the default DNs, choose the drop list arrow beside the Prime
set field and choose one of the options listed.

7. If Auto privacy is to be enabled, choose the Auto priv acy check box.

8. If Auxiliar y ring er is to be enabled, choose the Auxiliar y ring er check box.

Choose to exit this screen and implement your changes.
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Trunk data To enter Trunk data information:

Note: The lines must be idle to program trunk mode data.

1. Select the line you want to program.
2. Choose the Program menu and then the Line menu item.
3.  Choose the Trunk Data menu item. The Trunk Data screen appears.
= Norstar Manager-Line Programming -~
Help
Trunk Data
~Supervised Loop /E & M
Trunk mnde:l * Unzupervised IEI Answer mude:l Manual IEI
X Answer with DISA
Dialing mude:l * Pulse IEI [if Auto)
-Loop Start only DID FE &M
Signal:l *wink start IEI
[ ANI Number
[if not Delay dial)
-Analog Loop only ‘E & M only
TC Eain:l »MNormal IEI
Lozs package:| * Medium CO Loop |EI
[ DHIS Humber
[Manual and not Delay dial)
Line number: 001 | Back I | Mext I
Line name: Line0D1 — —
Customer Hame: | LCancel I | Done I
Ready [ [ [ [ 17/07/96 13:10:39

Figure 6.26 — The Trunk Data screen

4,

Choose the drop list arrow beside the Trunk mode field and choose the
trunk mode specified in the programming record.

Note: Not all of the options shown on this screen are available for all trunk
types. The type of trunk you choose in the Trunk mode field will determine
what fields you need to program.

If the trunk type is Loop or E&M, choose the drop list arrow beside the
Answer mode field. Choose either Manual or Auto.

If the programming record specifies Auto Answer with Direct Inward Station
Access, choose the Answer with DISA check box.

If the trunk type is Loop or E&M, choose the drop list arrow beside the
Dialing mode field. Choose either pulse or tone.

If the trunk type is Loop, and Full autohold is specified in the programming
record, choose the Full autohold check box.

If you are programming an analog line on a T1 Release 1, CDA-MICS-XC
1.0, USA-MICS-XC 1.0, NA-MICS-DR 1.1, CDA-MICS-XC 1.1, or USA-
MICS-XC 1.1 system, choose the drop list arrow beside the Loss Pkg field.
Choose one of the loss packages shown.
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Abilities and Call
Services

10.

11.

12.

13.

If the trunk type is Loop or DID, choose the drop list arrow beside the Signal
field. Choose either Wink start, Immediate, or Delay dial.

If you are programming a T1 Release 1, CDA-MICS-XC 1.0, USA-MICS-XC
1.0, NA-MICS-DR 1.1, CDA-MICS-XC 1.1, or USA-MICS-XC 1.1 system and
ANI number is specified in the programming record, choose the ANI
Number check box.

If you are programming a T1 Release 1, CDA-MICS-XC 1.0, USA-MICS-XC
1.0, NA-MICS-DR 1.1, CDA-MICS-XC 1.1, or USA-MICS-XC 1.1 system and
DNIS number is specified in the programming record, choose the DNIS
Number check box.

If the trunk type is E&M, choose the drop list arrow beside the Gain field.
Choose either Normal or High.

Choose to exit this screen and implement your changes.

To enter abilities and call services information:

1. Select the line you want to program.
2. Choose the Program menu and then the Line menu item.
3. Choose the Abilities and Call Ser vices menu item. The Abilities and Call
Services screen appears.
[E Morstar Manager-Line Programming HAEE
Help
Abilitiez and Call Services
rLine Filters rLine R te Access
Nommal filter: [:E] j Remote package:
Mode 1: 21 -
Am— Remote fiter: [FT—— =]
Mode 2.2 ]
J Mode 1 remote filter: Eﬂj
Mode 3: __E3 M
g Mode 2 remote filter: EZj
Mode 3 remote filter: |33 j
Mode & rj Mode 4 remote filter: (00 j
Mode 5 remote filter: ﬁl] j
rLine Call Services
VM sq Center #: |FI j| Mode & remote filter: ﬁl] j
Auto Call Info: [None j|
Line number: 001 | Back I | Next I
Line name: Line001
Customer Mame: MICS 1.1 | Cancel I | Done I
| Ready | | | [10/7/96 1215:18PM |

Figure 6.27 — The Abilities and Call Services screen

Norstar Manager for Windows™ User Guide



6-40 Section 6: Programming a Norstar system

Service mode
options

10.

Select the Normal filter text box and type the number of the line filter used
with this line.

To enter one of the default line filter numbers, choose the drop list arrow
beside the Normal fi Iter field and choose one of the filter numbers listed.

If you are programming a T1 Release 1, CDA-MICS-XC 1.0, USA-MICS-XC
1.0, NA-MICS-DR 1.1, CDA-MICS-XC 1.1, or USA-MICS-XC 1.1 system,
repeat step 4 for each mode field.

Select the VMsg Center # text box and type the number of the voice
message callback center used by this line.

To enter one of the default voice message callback center numbers, choose
the drop list arrow beside the VMsg Center # field and choose one of the
numbers listed.

Select the Auto Call Inf o text box and type the DN of the set that will show
the call display information for this line.
To enter a default DN, choose the drop list arrow beside the Auto Call Info
field and choose one of the DN's listed.

Select the Remote package text box and type the number of the remote
package specified for this line.

To enter one of the default remote package numbers, choose the drop list
arrow beside the Remote pac kage field and choose one of the remote
packages listed.

Select the Remote filter text box and type the number of the remote filter
used with this line.

To enter one of the default remote filter numbers, choose the drop list arrow
beside the Remote fi lter field and choose one of the filter numbers listed.
Note: Remote packages are only available on Modular DR5, T1 Release 1,
CDA-MICS-XC 1.0, USA-MICS-XC 1.0, NA-MICS-DR 1.1, CDA-MICS-XC
1.1, and USA-MICS-XC 1.1 systems.

If you are programming a T1 Release 1, CDA-MICS-XC 1.0, USA-MICS-XC
1.0, NA-MICS-DR 1.1, CDA-MICS-XC 1.1, or USA-MICS-XC 1.1 system,
repeat step 9 for each mode remote filter field.

Choose to exit this screen and implement your changes.

To assign Service mode options:

1.
2.
3.

Select the line you want to program.
Choose the Program menu and then the Line menu item.

Choose the Service Mode Options menu item. The Service Mode Options
screen appears.
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[E Morstar Manager-Line Programming HAEE
Help
Service Mode Options
Service control set: m—j
Mode 1: Mode 2: Mode 3: Mode 4: Mode 5: Mode 6:
Might Evening Lunch Mode 4 Mode 5 Mode 6

Ringing group: Ringing group: Ringing group: Ringing group: Ringing group: Ringing group:
e = N o o N C—

[ Aux. ringer [ Aux. ringer [ Aux. ringer [ Aux. ringer [ Aux. ringer [ Aux. ringer

Line number: 001
Line name: Line001
Customer Mame: MICS 1.1 | Cancel I | Done I
| Ready [ [ [ | 10/7/96 1:44:39 PM |

Figure 6.28 — The Service Mode Options screen

4.  Select the Service contr ol set text box and type the DN of the Service
control set.
To enter one of the default DNs, choose the drop list arrow beside the
Service contr ol set field and choose one of the DNs listed.

Note: On CDA-MICS-XC 1.0, USA-MICS-XC 1.0, NA-MICS-DR 1.1, CDA-MICS-
XC 1.1, and USA-MICS-XC 1.1 systems, ringing groups, not ringing sets, are
assigned to service modes. If you are programming a CDA-MICS-XC 1.0, USA-
MICS-XC 1.0, NA-MICS-DR 1.1, CDA-MICS-XC 1.1, or USA-MICS-XC 1.1
system, skip the instructions concerning assigning or deleting sets.

To assign ringing sets to all systems except the CDA-MICS-XC 1.0, USA-MICS-
XC 1.0, NA-MICS-DR 1.1, CDA-MICS-XC 1.1, or USA-MICS-XC 1.1:
5. Choose the Edit menu and then the Assign set(s) menu item.

6. Choose the menu item for the mode you are assigning ringing sets to. For
example, choose the Model... menu item to assign mode 1 ringing sets.
The Select ringing set(s) dialog box appears.

7.  Select the DNs of all of the sets that will be Mode 1 ringing sets.

8. Choose

9. If the Auxiliary ringer is a ring for Mode 1, choose the Aux. Ring er check
box.
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Programming
multiple lines

10. Repeat steps 5 to 9 for each service mode you are programming.
Note: If you are programming a T1 Release 1 system, there are six modes to
assign ringing sets to. If you are programming any other type of system,
there are three modes to assign ringing sets to.

To remove assigned sets from a Service mode:
11. Select the set or sets to be deleted.

12. Choose the Edit menu and then the Delete set(s) menu item.

To assign a ringing group (CDA-MICS-XC 1.0, USA-MICS-XC 1.0, NA-MICS-DR
1.1, CDA-MICS-XC 1.1, and USA-MICS-XC 1.1 systems only):

1. Choose the drop list arrow beside the Ringing gr oup field and then choose
the number of the ringing group assigned to this mode.

2. Repeat step 1 for all six modes.

Choose to exit this screen and implement your changes.

Note: To determine the time period when each of the service modes are active,
check the Service Mode section of system programming.

After you have worked through the Line Programming section, you have
completed the programming for one line on the Norstar system.

To continue programming the remaining lines, you can either work through the
Line Programming section for each line in the Norstar system, or use the Copy
Line feature. This feature allows you to copy the programming you have just
completed for one line, to other lines.

The Copy Line feature can be used to program the lines on a Norstar system
quickly and efficiently. Even if all the lines in the Norstar system do not share the
same programming parameters, you should consider using the Copy Line feature
to program all the lines. You can then go to each individual line and change the
parameters that are different.

The Copy Line feature does not copy line name programming. Certain line param-
eters, such as Private to, are not copied from one line to another if the parameter
is already specified at the line to be copied to.

For example, if the line type of Line 04 is specified as Private to set 33, and you
attempt to copy Line 03 attributes to it, the line type remains as Private to set 33. If
however, Line 04 has a line type of pool, when you copy Line 03 attributes to it, the
line type will change to that of Line 03.

Note: Line programming can only be copied between lines that are the same type
and that are physically connected to the KSU. For example, T1 line programming
can only be copied to another T1 line that is connected to the KSU.

For information about what gets copied, see the “Line data copy” section.
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To copy one line's programming to other lines:
1. Select the line you want to copy programming from.

2.  Choose the Edit menu and then the Copy Line menu item.
The Copy Line dialog box appears.

Copy Line
Select line(s] to copy to: Select ine attributes to be copied:
001 Line001 + [ Line Data
ggg t:::ggg [ Service Mode Options
004 Line004 [ Trunk Data
005 Line0D5 . _
006 Line0DG r Line Abilities
007 LineDOD?
008 Line0D8
009 Line003 | cancel || Done |

Figure 6.29 — The Copy Line dialog box

Choose the check boxes of the attributes you want to copy.

4.  Select the line or lines you want to copy programming to.

5. Choose

The programming is copied to the selected lines.

Line data cop y Data copied by selecting Line Data attributes:

. auxiliary ring enable flag

. privacy control flag

. incoming line group numbers

. overflow call routing (OCR) busy flag
. private set DN

. line access (a pool number/public/private)
Data copied by selecting Trunk Data attributes:

. DTMF enable flag (a dial mode)

. full auto-hold flag

. answer mode

. signal mode

. gain mode

. DISA mode

. dial tone detection on line seizure setting
. AC15 loss setting

. recall timing
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. recall at exchange setting
. Automatic Number Identification (ANI) setting
. Dialed Number Identification (DNIS) setting

. loss package setting
Trunk Data is copied in the following two conditions:

. the two trunks must belong to the same trunk cartridge type, and
. the two trunks must be configured with the same trunk mode

Note : You cannot copy the trunk mode using the remote device copy request.
Data copied by selecting Line Abilities attributes:

. alternate restriction filters for all service modes
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Set When you have completed entering system and line programming, you can begin
programming entering set programming information. Refer to the programming record for the
information you need to enter as set programming.
Set programming involves entering information on:
. Line access

. Set abilities (Set abilities 1 and Set abilities 2 for NA-MICS-DR 1.1,
CDA-MICS-XC 1.1, and USA-MICS-XC 1.1 systems)

. Buttons and status
. Personal speed dial
. Call services

Each area of information is entered into the Norstar system through a dedicated
screen. Refer to Figure 6.3 for an overview of the different areas of set program-
ming.

Before you can access a set programming screen, you must first select the set
you want to program.

To select a set using the mouse, move the mouse pointer onto the set you want to
program and press the mouse button.

To select a set using the keyboard, press and the cursor keys until the set
you want to program is highlighted.

After you have entered information in one of these screens, you can:

«  Choose to implement your changes and move to the next pro-

gramming screen.

«  Choose to implement your changes and move to the previous

programming screen.

«  Choose to cancel all new programming changes and return to

the System Pr ogramming Over view screen.

«  Choose to implement the new programming changes and

return to the System Pr ogramming Over view screen.

Note: The steps described in this section assume that you are starting from the
System Pr ogramming Over view screen. If you are not, return to the System
Programming Over view screen or use | Met  Jor|  Back | to move
to the appropriate programming screen.

Impor tant: Before you begin set programming, you must program the set type.
Refer to Installed equipment earlier in this section for instructions.

When you are programming a set, the KSU must disable the set to change some
of the parameters. If any of the sets being changed are busy (i.e. on a call), that
set cannot be disabled and the programming cannot be changed. Norstar
Manager will display an error message indicating that the change was not made.
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Line access The Line access screen shown applies to an M7324, M7310, or M7208 set. If you
are programming an ATA or an M7100 set some fields that appear on the sample
screen below will not appear on the screen on your monitor.

To enter line access information:
1. Select the set you want to program
2. Choose the Program menu and then the Set menu item.

3. Choose the Line Access menu item. The Line Access screen appears.

[E Morstar Manager-Set Programming B
Edit Help
Line Access

Lines assigned Ringing lines Line pool Incoming line
access groups Prime line:
Line -] Line j‘ Pool & ILG 01 * Intercom z
- P Pool B ILG 02
o001 Lnel]l]1 ool L!neI][H Pool C ILG 03
002 Line0D2 002 Line002 Pool D ILG 04
003 Line003 003 Line003 :300: E :tg g?
004 Line0D4 006 Line00G Pool J LG 08 Intercoms: [»2 -]
005 LineD05 - 007 LineDO7 -

Line/set filters Answer DNs
Line Filter Mode 1 | Mode 2 | Mode 3 | =] Set Ringing - |
001 Line001 ol 99 Mone 98 I—I 2222  Monigue On -
004 LineD04 Mone Mone ol Mone [ 2232  Jean On
006 LineD06 02 Mone Mone Hone | 2245 Pepe On
008 LineD0Dg Mone MNone Mone o = 2247  Angela On =
0 off]
Mame: 2221 DN: 2221
Sypstem ID:
Customer Mame: Cancel I | Done I
| Ready [ [ | 10/7/96 1:2705FM |

Figure 6.30 — The Line Access screen

To add line appearances:

1. Choose the Edit menu and then the Add Line appearance... menu item.
The Specify line(s) dialog box appears.

2. Select the lines the programming record indicates are assigned to this set.

3. When you have selected all the lines that are to be assigned to the set,

choose

The Line Access screen appears with the assigned lines in the Lines
assigned box.
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To delete line appearances:
1. Select the line appearances to delete.
2.  Choose the Edit menu and then the Delete Line appearance menu item.

Note : What happens when deleting line appearances in Norstar Manager
differs slightly from what happens in set based administration (Feature
*CONFIG). In Norstar Manager, if a line is assigned as a line appearance
and a line filter, then deleting that line from the line appearances will auto-
matically delete the line from line filters as well. In set based administration,
the line is not automatically deleted from line filters.

To add ringing lines to a T1 Release 1, CDA-MICS-XC 1.0, USA-MICS-XC 1.0,
NA-MICS-DR 1.1, CDA-MICS-XC 1.1, or USA-MICS-XC 1.1 system:

1. Choose the Edit menu and then the Add Ringing line(s)... menu item.
The Specify Ri nging line(s) dialog box appears.

Note: If you are not programming a T1 Release 1, CDA-MICS-XC 1.0, USA-
MICS-XC 1.0, NA-MICS-DR 1.1, CDA-MICS-XC 1.1, or USA-MICS-XC 1.1
system, select the Ringing field of a line that is a ringing line and choose
On. To change the line to a non-ringing line, select Off. When you are
finished assigning ringing lines, proceed to adding line filters.

2.  Select the line or lines that should be ringing lines for this set.

3.  After you have selected all the ringing lines for this set,

choose

The Line access screen appears with the assigned lines in the Ringing
lines box.

To delete ringing lines from a T1 Release 1, CDA-MICS-XC 1.0, USA-MICS-XC
1.0, NA-MICS-DR 1.1, CDA-MICS-XC 1.1, or USA-MICS-XC 1.1 system:
1.  Select the line or lines you want to assign as non-ringing.
2. Choose the Edit menu and then the Delete Ringing line menu item.
The selected lines are removed from the Ringing lines box.
To add line filters:

1. Choose the Edit menu and then the Add Line fi lter... menu item.
The Specify line fi lter(s) dialog box appears.

2. Select the lines assigned to this set that have a filter.

3. When you have selected all the lines that have a filter assigned,

choose

The Line access screen appears with the selected lines in the Line /Set
filters box.

To add Line/Set filters:

1. Select the Filter field of a line in the Line/set fi Iters box and type the filter
number assigned.

2. Ifyou are programming a T1 Release 1, CDA-MICS-XC 1.0, USA-MICS-XC
1.0, NA-MICS-DR 1.1, CDA-MICS-XC 1.1, or USA-MICS-XC 1.1 system,
repeat step 1 for each of the six service mode filters for this line.
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3. Repeat steps 1 and 2 for each line in the Line/set fi Iters box.

To delete line filters:
1. Select the line filters to delete.

2. Choose the Edit menu and then the Delete line fi Iter menu item.

To add line pool access

1. Choose the Edit menu and then the Add Line pool access... menu item.
The Specify line pool(s) dialog box appears.

2.  Select the line pools that are assigned to this set.

3. When you have selected all the line pools that are assigned to the set,

choose

The Line access screen appears with the assigned line pools in the Line
pool access box.

To delete line pool access:

1. Select the line pools to delete.

2. Choose the Edit menu and then the Delete line pool access menu item.

To add ILGs:

1. Choose the Edit menu and then the Add ILG menu item.
The Specify ILG(s) dialog box appears.
Note: Incoming line groups are only available for T1 Release 1, CDA-MICS-
XC 1.0, USA-MICS-XC 1.0, NA-MICS-DR 1.1, CDA-MICS-XC 1.1, and USA-
MICS-XC 1.1 systems. If you are not programming a T1 Release 1, CDA-
MICS-XC 1.0, USA-MICS-XC 1.0, NA-MICS-DR 1.1, CDA-MICS-XC 1.1, or
USA-MICS-XC 1.1 system, proceed to changing the prime line.

2. Select the incoming line groups that are assigned to this set.

3. When you have selected all the incoming line groups that are assigned to

the set, choose

The Line access screen appears with the assigned incoming line groups in
the Incoming Line Gr oups box.

To delete ILGs:

1. Select the ILGs to delete.

2. Choose the Edit menu and then the Delete ILG menu item.

To add Answer DNs:

1. Select the Set field of the Answer DNs box and type the DN of a set that
can be answered from this set.

2.  Select the Ringing field of the same set and choose either On or Off.
3. Repeat steps 1 and 2 for each Answer DN.
To change the prime line, choose the drop list arrow beside the Prime line field

and then choose the prime line for this set.
Remember : Only lines that are assigned to the set can be made prime lines.
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To change the number of intercom keys, choose the drop list arrow beside the
Intercom s field and then choose the number of intercom lines specified in the
programming record.

Choose to exit this screen and implement your changes.

Set abilities The Set Abilities screen shown applies to an M7324, M7310, or M7208 set. If
you are programming an ATA or an M7100 set, some fields that appear on the
sample screen below, do not appear on the screen on your monitor.

Note: If you are programming a NA-MICS-DR 1.1, CDA-MICS-XC 1.1, or USA-
MICS-XC 1.1 system, the corresponding programming is entered from the Set
Abilities 1 and Set Abilities 2 screens.

To enter Set abilities programming:

1. Select the set you want to program.

2. Choose the Program menu and then the Set menu item.

3. Choose the Set Abilities menu item. The Set Abilities screen appears.

[ Morstar Manager-5 et Programming HAEE
Help
Set Abilities "
a e: Pickup group: I *None J
™ Auto handsfree Page: [»On d
[¥ Handsfree answerback Page zone: | » Zone 1 jJ
[ Priority call Set lock: I »None jJ
[" Augiliary ringer Call forward on busy to: [Hone jl
[ Redirect ring Forward no answer to: |[Mone jl
[ Allow redirection Forward to delay: (=3 jJ nings
-Set Filters . .. I r J
t dial zet: | » =
Mommal: ﬁ2 d fee
Mode LT <] Control set ID: [Z21__ 221 =l
Hotline Progr.
J Hotline lype:l *Hone j
Mode 3:[[13 =l | o I
nternal :|Mone <
Made 4T 1] : 3
External line: one <
Mode 5: 00 =l
External digit}'
Mode 6: I 0 d P = Pause
Name: 221 DN: 221 | Back I | Next I
System ID:
Customer Mame: | Cancel I | Done I
| Ready | | | 10/9/96 1:00:41 PM |

Figure 6.31 — The Set Abilities screen

4, If Full handsfree is to be enabled, choose the Full handsfree check box.

If Auto handsfree is to be enabled, choose the Auto handsfree check box.
Note: You must choose Full handsfree before you can choose Auto hands-
free.
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10.
11.

12.

13.
14.

15.

16.

17.

18.

19.

20.

21.

22.

If Handsfree Answerback is to be enabled, choose the Handsfree
answerbac k check box.

If Priority Call is to be enabled, choose the Priority call check box.

If Auxiliary Ringer is to be enabled, choose the Auxiliar y ring er check box.
If Redirect Ring is to be enabled, choose the Redirect ring check box.

If Allow Redirect is to be enabled, choose the Allo w redirection check box.

If this set is an ATA, choose the drop list arrow beside the ATA tones field
and choose either Suppress tones or Allow tones.

Note: The ATA tones field is not available for Modular DR5, T1 Release 1,
CDA-MICS-XC 1.0, USA-MICS-XC 1.0, NA-MICS-DR 1.1, CDA-MICS-XC
1.1, or USA-MICS-XC 1.1 systems.

Choose the drop list arrow beside the Normal field and then choose the
number of the filter assigned to this set.

Note: If you are not programming a T1 Release 1, CDA-MICS-XC 1.0, USA-
MICS-XC 1.0, NA-MICS-DR 1.1, CDA-MICS-XC 1.1, or USA-MICS-XC 1.1
system, ignore this step and proceed to step 14.

Repeat step 12 for all six service mode filters.

Choose the drop list arrow beside the Pickup group field and then choose
the number of the Pickup group this set is assigned to.

Choose the drop list arrow beside the Page field and then choose either On
or Off to enable or disable the page feature.

Choose the drop list arrow beside the Page zone field and then choose the
number of the Page zone specified in the programming record.

Choose the drop list arrow beside the Set lock field and then choose either
None, Full or Partial.

Select the Call forwar d on b usy to field and type the DN specified on the
programming record. To choose one of the default DNs, choose the drop list
arrow beside this field and select the specified DN.

Select the Forwar d no ans wer to field and type the DN specified on the
programming record. To choose one of the default DNs, choose the drop list
arrow beside this field and choose the specified DN.

Choose the drop list arrow beside the Forwar d to dela y field and then
choose the number of rings before the set is considered unanswered and is
call forwarded.

Select the Set filter field and type the number of the set filter. To choose one
of the default filters, choose the drop list arrow beside this field and choose

the specified filter.

Note: This field is not available for T1 Release 1, CDA-MICS-XC 1.0, USA-

MICS-XC 1.0, NA-MICS-DR 1.1, CDA-MICS-XC 1.1, or USA-MICS-XC 1.1

systems.

Choose the drop list arrow beside the Direct dial set field and then choose
the number of the Direct dial set specified in the programming record.
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23.

24,

25.

26.

27.

28.

Select the Control set ID field and type the DN of the control set. To choose
one of the default DNs, choose the drop list arrow beside this field and
choose the specified DN.

Note: This field is only available for T1 Release 1, CDA-MICS-XC 1.0, USA-
MICS-XC 1.0, NA-MICS-DR 1.1, CDA-MICS-XC 1.1, and USA-MICS-XC 1.1
systems.

Choose the drop list arrow beside the Hotline type field and then choose
None (if the hotline is not enabled), Internal, or External.

If hotline type is Internal, select the Internal DN field and type the DN that is
specified as the Hotline.

If hotline type is External, choose the drop list arrow beside the External
line field and choose either prime, the line number, or the line pool code to
use for the Hotline.

Note: Only lines or line pools that are assigned to this set can be chosen.

If hotline type is External, select the External digits field and type the digits
shown on the programming record.

If DND on busy is to be enabled, choose the DND on busy check box.

Choose to exit this screen and implement your changes.

Set abilities 1 The Set Abilities 1 screen is available to NA-MICS-DR 1.1, CDA-MICS-XC 1.1,
and USA-MICS-XC 1.1 systems only. If you are programming a different type of
system, the corresponding programming is entered from the Set Abilities screen.

The screen shown applies to an ATA, M7324, M7310, M7208, or an M7100 set.

To enter Set abilities 1 programming:

1.
2.
3.

Select the set you want to program.
Choose the Program menu and then the Set menu item.

Choose the Set Abilities 1 menu item. The Set Abilities 1 screen appears.
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= MNorstar Manager-Set Programming v

Help
Set Abilities 1
-Call Forwarding
Call forward on busy to: |Hone E Link:| O |*
Forward no answer to: |None E LNR:|*0On 5

Forward to delay: I 3 :I rings SNH:I *0n :I

~Hotline Progr.

Haotline type:| » None Iil ATA Answer Timer:|*7 k4
Internal DN: | None E Mszg Indicate:| *None |

External line:| Mone E

External digits:
P = Pause
;lame: :-IDunique DN: 221 | Back I | Mext I
yztem |D:

Customer Mame: | Cancel I | Done I

Ready [ [ [ [

17707796 13:13:01

Figure 6.32 — The Set Abilities 1 screen

4,

10.

11.

12.

Select the Call forward on busy to field and type the DN specified on the
programming record. To choose one of the default DNs, choose the drop list
arrow beside this field and select the specified DN.

Select the Forwar d no ans wer to field and type the DN specified on the
programming record. To choose one of the default DNs, choose the drop list
arrow beside this field and choose the specified DN.

Choose the drop list arrow beside the Forwar d to delay field and then
choose the number of rings before the set is considered unanswered and is
call forwarded.

Choose the drop list arrow beside the Hotline type field and then choose
None (if the hotline is not enabled), Internal, or External.

If hotline type is Internal, select the Internal DN field and type the DN that is
specified as the Hotline.

If hotline type is External, choose the drop list arrow beside the External
line field and choose either prime, the line number, or the line pool code to
use for the Hotline.

Note: Only lines or line pools that are assigned to this set can be chosen.

If hotline type is External, select the External digits field and type the digits
shown on the programming record.

Choose the drop list arrow beside the Link field and then choose if Link
feature access is On or Off.

Choose the drop list arrow beside the LNR field and then choose if Last
Number Redial is On or Off.
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13. Choose the drop list arrow beside the SNR field and then choose if Saved
Number Redial is On or Off.

14. Choose the drop list arrow beside the ATA Answer Timer field and then
choose the number specified in the programming record.

15. Choose the drop list arrow beside the Msg Indicate field and then choose
either None, Lamp or Tone.

Choose to exit this screen and implement your changes.

Set abilities 2 The Set abilities 2 screen is available to NA-MICS-DR 1.1, CDA-MICS-XC 1.1,
and USA-MICS-XC 1.1 systems only. If you are programming a different type of
system, the corresponding programming is entered from the Set abilities screen.

The screen shown applies to an ATA, M7324, M7310, M7208, or an M7100 set.

To enter Set abilities 2 programming:
1. Select the set you want to program.
2. Choose the Program menu and then the Set menu item.

3. Choose the Set Abilities 2 menu item. The Set Abilities 2 screen appears.

= Morstar Manager-Set Programming v
Help
Set Abilities 2
[~ Full handsfree Pickup group: I * None IEI
[" Auto handsfree Page: m
[X Handsfree answerback p : I = 1 |;I
[ Priority call Sl one —
[ Auziliary ringer Set lock: | » None E
[% Redirect ring Direct dial set: |*1 i
[ Allow redirection Control set ID: | 221 Monique E
[” DMD on busy
Set Filters
Mode 1:[11 [2] Mode 4:[00 B
Normal: [02 (2] Mode 2:[12 (2] Made 5: |00
Mode 3: |13 E Mode 6: |00 E
Mame: Monique DN: 221 | Back I | Mext I
System ID:
Customer Mame: | Cancel I | Done I
Ready [ [ [ [ 17/07/96 13:14:07

Figure 6.33 — The Set Abilities 2 screen

4, If Full handsfree is to be enabled, choose the Full handsfree check box.

5. If Auto handsfree is to be enabled, choose the Auto handsfree check box.
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Buttons and
Status

10.
11.
12.

13.

14.

15.

16.

17.

18.

19.

If Handsfree Answerback is to be enabled, choose the Handsfree
answerbac k check box.

If Priority Call is to be enabled, choose the Priority call check box.

If Auxiliary Ringer is to be enabled, choose the Auxiliar y ring er check box.
If Redirect Ring is to be enabled, choose the Redirect ring check box.

If Allow Redirect is to be enabled, choose the Allo w redirection check box.
If DND on busy is to be enabled, choose the DND on busy check box.

Choose the drop list arrow beside the Pickup group field and then choose
the number of the Pickup group this set is assigned to.

Choose the drop list arrow beside the Page field and then choose either On
or Off to enable or disable the page feature.

Choose the drop list arrow beside the Page zone field and then choose the
number of the Page zone specified in the programming record.

Choose the drop list arrow beside the Set lock field and then choose either
None, Full or Partial.

Choose the drop list arrow beside the Direct dial set field and then choose
the number of the Direct dial set specified in the programming record.

Select the Control set ID field and type the DN of the control set. To choose
one of the default DNs, choose the drop list arrow beside this field and
choose the specified DN.

Choose the drop list arrow beside the Normal field and then choose the
number of the filter assigned to this set.

Repeat step 18 for all six service mode filters.

Choose to exit this screen and implement your changes.

The Buttons and Status screen shown applies to an M7324 set. If you are
programming another model of set, some fields that appear on the sample screen
below do not appear on the screen on your monitor.

To enter Buttons and status programming:

1.
2.
3.

Select the set you want to program.
Choose the Program menu and then the Set menu item.

Choose the Buttons and Status menu item. The Buttons and Status
screen appears.
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[ Morstar Manager-5 et Programming HAEE
Edit  Program button Help

Buttons and Status

Button assignments for M7310

lAutodial 2233 2233
Blank

lAutodial 2234 2234
lAutodial 2235 2235
lAutodial 2223 2223

lAutodial 2236 2236
lAutodial 2224 2224

lAutodial 2222 Monique

Autodial 2237 2237
Autodial 2225 2225

Autodial 2238 2238
Autodial 2226 2226

Autodial 2239 2239
Autodial 2227 2227

Autodial 2240 2240
Autodial 2228 2228

Autodial 2241 2241
Autodial 2229 2229

Autodial 2242 2242
Autodial 2230 2230

Autodial 2243 2243
Autodial 2231 2231

Autodial 2244 2244
Autodial 2232 Jean

001 Line001 Answer 2245 Pepe
002 Line002 Answer 2232 Jean
003 Line0D3 Answer 2222 Monique
004 Line0D4 Intercom

Answer 2247 Angela Intercom

Pre-dial mode: | » Standard Dial J

Language: | » Englizh j

Forwarded to: |N|:|ne

Do not disturb: | » O j
Background music: | » OFf j

Ring volume: m

Ring type: [ =1 j

:

Contrast: I ] j
Set status: I Idle

Name: 2221 DN: 2221 | Back
System 1D: —
Customer Mame: | Cancel

| Ready [ [ |

| 10/7/96 1:37:49 PM |

Figure 6.34 — The Buttons and Status screen
4.  Choose the drop list arrow beside the Do not disturb field and then choose
either Off or On.

5. Choose the drop list arrow beside the Pre-dial mode field and then choose
one of the pre-dial mode options.

6. Choose the drop list arrow beside the Background m usic field and then
choose either Off or On.

7. Choose the drop list arrow beside the Ring v olume field and then choose
one of the ring volume digits.

8. Choose the drop list arrow beside the Ring type field and then choose
desired ring type to be used on this set.

9. Choose the drop list arrow beside the Contrast field and then choose the
desired contrast level to be used by the display on the set.

10. Choose the drop list arrow beside the Langua ge field and then choose the
desired language.

The Forwar ded to and Set status fields are display fields. You cannot edit these
fields.

The Forwar ded to field indicates if this set has call forwarding enabled. If it does,
the DN the calls are forwarded to is shown.
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Removing a button
assignment

Assigningane w
feature

The Set status field indicates what state the set is currently in (e.g. busy or idle).
The status shown in this field is the status of the set when you opened the
Buttons and Status screen, it does not automatically update. To get the current

status, choose | Update Status

The Buttons and Status screen is not available if you are programming a set that
is not currently connected to the KSU.

Note: Choosing only updates the Set status field. The other fields
are only read from the set when you enter the Buttons and Status screen.

The appearance of the Buttons and status screen depends on the type of set
you are programming. For example, when you are programming an M7324 set,
the Buttons and Status screen shows you what features and buttons can be
assigned to that particular set.

The following paragraphs deal with the various functions of the Buttons and
Status screen. This screen allows you to:

. remove button assignments

. assign new features

. assign inside and outside autodial

. program dual memory buttons on an M7310 set

. program CAP buttons (for an M7324 set only)

If your monitor does not show the Buttons and Status screen, refer to Buttons
and Status earlier in this section. To remove a button assignment:

1. Select the button you want to delete the assignment from.

2. Choose the Edit menu and then the Remove assignment menu item.
The button assignment is changed to a blank button.

To assign a new feature to a button:
1. Select the button you want to assign a new feature to.

2. Choose the Program b utton menu and then the Feature... menu item.
The Program Fe ature Button dialog box appears.

3. Choose the drop list arrow beside the Feature field, and then choose the
feature to be assigned to this button.

4 Choose

The button assignment box shows the feature you selected.

Note: If an option is required for the feature chosen in step 3, the Feature
Option dialog box appears. Choose the drop list arrow beside the Options

field and then choose the appropriate option. Choose to

return to the Buttons and Status screen.
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Assigning outside To assign an outside autodial to a button:
autodial 1. Select the button you want to assign the outside autodial to.
2.  Choose the Program b utton menu and then the Outside autodial... menu
item. The Program Outside A utodial button dialog box appears.

3.  Select the Number text box and then type the outside autodial number.
Note: You can enter Link/flash, Run/stop, Wait for tones, Pause, and
Programmed Release codes within the number, but remember these codes
may use up to two spaces within the number. The maximum length for the
speed dial number is 24 digits.

4.  Choose the drop list arrow beside the Line field and then choose the line or
line pool used by outside autodialer.

5. Choose

The button assignment changes to the phone number you entered.

Assigning inside To assign an inside autodial to a button:
autodial 1.  Select the button you want to assign the inside autodial to.
2. Choose the Program b utton menu and then the Inside autodial... menu
item. The Program Inside A utodial button dialog box appears.

3.  Select the text box and type the inside autodial number.
Note: An inside autodial number is the DN of another set on the Norstar
system.

4 Choose

The button assignment changes to the Autodial number you typed in step 3.
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Exchanging b utton
assignments

Programming dual
memor y buttons

Changing CAP
programming

To exchange the position of two button assignments:
1. Select the two buttons to exchange assignments between.

2. Choose the Edit menu and then the Exchang e assignment menu item.
The button assignments are exchanged.

Note: The Exchang e assignment menu item is available only when two buttons
are selected, and both buttons can be moved. Some buttons cannot be
exchanged, including buttons used for Intercom, Handsfree, or Answer DNs.

On the M7310 sets, there are 12 dual memory buttons. These buttons are repre-
sented by the 12 pairs of button assignment slots in the upper portion of the
Button assignments box. The top slot of the button assignment pair is the feature
or autodial number accessed using the shift button on the telephone.

Assign features and autodial numbers to the dual buttons using the procedures
described in the preceding paragraphs.

CAP programming can only be performed on M7324 sets equipped with a CAP
module. Refer to Installed equipment , in this section, for instructions on defining
the set type.

CAPs must attached to the Norstar system and enabled before you can program
them. If you try to program a CAP that is not attached or enabled, an SQL -434
error message “this set doesn’t have a CAP attached” will appear.

A CAP should be initialized if you are moving the CAP from one Norstar systems
to another. If you do not, Norstar Manager may get a “no record found” error when
trying to display the CAP information. To initialize a CAP, hold down the two
buttons on the bottom right and the two buttons on the bottom left of the CAP
while the display is flashing (immediately after you connect the CAP).

To program a CAP module:

1. Choose

The CAP buttons screen appears.
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¥ Morstar Manager-Set Programming [_ (O]
Edit  Program button Help
CAP Buttons

Blank #utodial 2233 cthroat Autodial 2245 2245 Autodiz
\Autodial 2222 2222 Autodial 2234 2234 Autodial 2246 2246 Autodiz
\Autodial 2223 2223 Autodial 2235 2235 Autodial 2247 2247 Autodiz
lAutodial 2224 2224 Autodial 2236 2236 Autodial 2248 2248 Autodiz
lAutodial 2225 2225 Autodial 2237 2237 Autodial 2249 2249 Autodiz
\Autodial 2226 2226 Autodial 2238 2238 Autodial 2250 2250 Autodiz
\Autodial 2227 2227 Autodial 2239 2239 Autodial 2251 2251 Autodiz
\Autodial 2228 2228 Autodial 2240 2240 Autodial 2252 2252 Autodiz
lAutodial 2229 2229 Autodial 2241 2241 Autodial 2253 2253 Autodiz
lAutodial 2230 2230 Autodial 2242 2242 Autodial 2254 2254 Autodiz
lAutodial 2231 2231 Autodial 2243 2243 Autodial 2255 2255 Autodiz
\Autodial 2232 2232 Autodial 2244 2244 Autodial 2256 2256 Autodiz
| | |

Ready [ [ [

9/11/96 5:11:17 PM

Figure 6.35 — The CAP buttons programming screen
2. Select the button you want to assign a feature to.

Features and autodials are assigned to CAP buttons using the same procedures
used to assign features and autodials to set buttons. When you have completed

making changes to the CAP button programming, choose to return

to the Buttons and Status screen.

Personal speed To enter Personal speed dial programming:

dials 1. Select the set you want to program
2. Choose the Program menu and then the Set menu item.

3. Choose the Personal Speed Dial s menu item. The Personal Speed Dial s
screen appears.
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[ Morstar Manager-5 et Programming HAEE
Edit Help

Personal Speed Dials

Code Optional Line Phone number =]
4307355804 -

72 Pnme 4037358125

¥3 PoolG 3065322277

74 Pnme 6049409454

75 PoolJ 63933478

76  Pnme 4163459050

78 Prime 111

F = Link/Flash P = Pause R = Programmed Release

Reach Through Codes
[ # = Run/Stop W =Wait for dial tone

Name: 2221 DN: 2221 | Back I | Next I
System 1D: — —
Customer Mame: | Cancel I | Done I
| Ready [ [ [ [10/7/96 1:35:18 PM |

Figure 6.36 — The Personal Speed Dials screen

To add a Personal speed dial:
1. Choose the Edit menu and then the Add speed dial(s)... menu item.

2.  Select the speed dial code or codes you want to add.
3. Choose

To program a Personal speed dial:

1. If required, select the Optional Line field and then choose the line or line
pool this speed dialer will use.

2. Select the Phone number field of the speed dial code to add.

3.  Type the speed dial numbers indicated on the programming record. You can
enter Link/flash, Programmed Release, Pause, Wait for tones, and Run/stop
within the number, but you should remember some of these codes use two
spaces within the number. The maximum length for the speed dial phone
number is 24 digits.
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To delete a Personal speed dial:
1. Select the Personal speed dial to delete.

2. Choose the Edit menu and then the Delete speed dial(s) menu item.

Choose to exit this screen and implement your changes.

Call services  To enter Call services programming:
1. Select the set you want to program.
2. Choose the Program menu and then the Set menu item.

3. Choose the Call Services menu item. The Call Services screen appears.

[ Morstar Manager-5 et Programming HAEE
Edit Help
Call Services

Lines assigned
Auto log calls 2l | Show external Ymsg | 2] - )
001 Line001 (001 Line001 —|  Logging option: | IRRYYIRF r
002 Line0D2 002 Line0D2 First display: I »Mame j
003 Line003 003 Line003
L d:

004 Line004 004 Line004 ek |
005 Line0D5 Log space: Il]
006 Line00G Auto bumping: I—_|“' o r
007 Line00?

Name: 2221 DM: 2221

System ID:
Customer Mame: | Cancel I | Done I
| Ready | | | 10/7/96 1:2924PM |

Figure 6.37 — The Call Services screen

To add lines that will provide Call Service information to this set:

1. Choose the Edit menu and then the Add Auto Log Lines... menu item.The
Lines dialog box appears.

2.  Select the line or lines to be logged by this set.

3. Choose

The selected lines are added.

To delete lines that provide Call Service information to this set:

1. Select the line or lines to be deleted.
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2.

Choose the Edit menu and then the Delete Auto Log Lines menu item.
The selected lines are deleted.

If you subscribe to an external voice message center, a notification message is
sent to you when one of your lines has a message waiting. To add lines that show
a message is waiting at the external voice message center:

1.

Choose the Edit menu and then the Add External VMsg Lines... menu
item.

Select the line or lines that will show if a message is waiting.

Choose

The selected lines are added.

To delete lines that provide external voice message service to this set:

1.
2.

Select the line or lines to be deleted.

Choose the Edit menu and then the Delete External VMsg Lines menu
item.
The selected lines are deleted.

To program Call services options:

1.

Choose the drop list arrow beside the Log ging option field and then choose
the Call Logging option used by this set.

Choose the drop list arrow beside the First display field and then choose
the information that will be shown on the first line of the Call log display.

Select the Log password text box and type the password for the Call log.

Select the Log space text box and type the size of Call Log for this set.
Note: If you enter a Call Log size larger than the maximum, Norstar Manager
automatically defaults to the maximum amount available.

Choose the drop list arrow beside the Auto bumping field and choose ON
to activate the Auto bumping feature or OFF to disable it.

Choose to exit this screen and implement your changes.
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Programming When you have worked through the Set programming section you have
multiple sets completed the programming for one set on the Norstar system. To continue
programming the remaining sets, you can either work through the above sections
for each set on the Norstar system, or use the Copy set feature.

The Copy set feature can be used to program all sets on a Norstar system quickly
and efficiently. Even if all the sets in the Norstar system do not share the same
programming parameters, you should consider using the Copy set feature to
program the same type of sets. For example, you can program one M7310 set,
then copy its programming to all the M7310 sets. You can then go to each set indi-
vidually and change any parameters that are different.

Impor tant: You can copy any type of set to any type of set. If the set types are
identical, all fields will copy. If the set types are different, certain fields will not
copy. You can copy to sets that aren't physically connected to the KSU but only
some fields will copy, meaning virtual set copying is not supported by Norstar
Manager.

Note: For more information on what gets copied, see the “Set data copy” section.

To copy set programming:
1. Select the set you want to copy programming from.

2. Choose the Edit menu and then the Copy Set... menu item.
The Copy Set dialog box appears.

Copy Set

Select set(z] to copy to: Select zet attributes to be copied:

2221 2221
2222 2222
2223 2223

ggg; ggg; [~ Button assignments

2226 2226 [ Call Services
2227 2227

2228 2228
2229 2229
2230 2230
2231 2231 [+]

[ Line Access
[" Abilities

[ [+

| Cancel I | Done I

Figure 6.38 — The Copy Set dialog box

Choose the check boxes of the attributes you want to copy.

4.  Select the sets you want the attributes copied to.

5. Choose

The programming for one set is copied to the selected sets.

Set data cop y Copying all four attribute groups is the same as the Copy Set feature invoked from
C.Ext Copy under Admin .

Data copied by selecting Line Access attributes:
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. prime line index

. line appearance flags

. line ring preference flags

. answer keys DNs

. answer key ring flags

. line pool access flags

. number of intercom keys

. set based incoming line group data

. originating line ID number
Data copied by selecting Abilities attributes:

. hands free enable flag

. hands free answerback enable flag
. auxiliary ringer enable flag

. page zone number

. call pickup group number

. forward no answer destination set DN
. call forward delay

. priority call enable flag

. short DTMF tones receive flag

. allow ATA tones flag

. ATA tones set indicator flag

. set lock data (also updates restrictions)
. auto handsfree enable flag

. forward on busy destination DN

. direct dial telephone set ID

. cable loss status

. auto-connect info

. page feature enable flag

. selective line redirection enable flag
. ring splash enable flag

. do not disturb (DND) on busy flag

. dialing restrictions filters

. alternate restriction filters

. line/set filters

. link feature access (LINK)

. saved number redial (SNR)
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. last number redial (LNR)
. ATA answer timer
. (Message) Msg indicate

Data copied by selecting Button Assignments attributes:

. personal speed dial DNs

. autodial keys and programmed keys

. autodial DNs

. language ID

Note: User data, speed dial numbers, buttons and status, applies to the physical
set both at the source and the destination.

Data copied by selecting Call Services attributes:

. CLASS Message Waiting receivership flags
. auto-logging flags (line selection)

. preferred incoming calling line 1D (ICLID) display
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Mobility
programming

Mobility programming is available only for CDA-MICS-XC 1.0, USA-MICS-XC 1.0
CDA-MICS-XC 1.1, and USA-MICS-XC 1.1 systems. If you are programming a
different type of system, skip to the RAD programming section.

Note: Mobility programming is not available for NA-MICS-DR 1.1.

Mobility programming involves entering information about:

. Portable registration

. Mobility setup

. Cells

. Re-evaluation

. Software codes (USA-MICS-XC 1.0 and USA-MICS-XC 1.1 only)

Each area of information is entered into the Norstar system through a dedicated

screen. Refer to Figure 6.3 for an overview of the different areas of mobility
programming.

After you have entered information in one of these screens, you can:

«  Choose to implement your changes and move to the next pro-

gramming screen.

e Choose to implement your changes and move to the previous

programming screen.

«  Choose to cancel all new programming changes and return to

the System Pr ogramming Over view screen.

+  Choose to implement the new programming changes and

return to the System Pr ogramming Over view screen.

Note: The steps described in this section assume that you are starting from the
System Pr ogramming Over view screen. If you are not, return to the System
Programming Over view screen or use | Met Jor[  Back | to move
to the appropriate programming screen.
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Portable  To change Portable data:

registration 1. Choose the Program menu and then the Mobility menu item.

2. Choose the Portable Registration menu item. The Portable Registration
screen appears.

[E Morstar Manager - Portables H[E= E
Edit Help

Portable Registration | :
Registration status

System LID: [5BF6 oLt plalls j'
2637 Mot registered
Registration password: [FEELTH 2638 Not registered
2639 Mot registered
. ) 2640 Mot registered
[ Allow registration 2641 Not registered
2642 Mot registered
2643 Mot registered
2644 Mot registered
2645 Mot registered
2646 Mot registered
Portable credits: 0 of 0 2647 Mot registered
2648 Mot registered
2649 Mot registered
2650 Mot registered
2651 Mot registered i

System: Modular
Customer name: MICS 1.1

System location: Telephone room
System ID: 1115551235 Cancel ||  Dome |

Ready | | | [10/7796 12:51:31 PM |

Figure 6.39 — The Portable Registration screen

3.  Select the Registration pass word field and type in the registration pass-
word listed on the programming record.

4.  Choose the Allo w registration check box to allow portables to register.

The fields in the Registration status box show if a portable is registered with the

system. If a portable registered with the system should not be registered, you can

change its status to not registered. To change the status of a portable to not
registered:

1. Select the portable or portables
2. Choose the Edit menu and then the Deregister por tables menu item.
The registration status is changed to Not registered.

The registration status shown is the status of the portables when you opened the
screen. To get the current status, choose

Choose to exit this screen and implement your changes.
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Mobility setup To change radio data:
1. Choose the Program menu and then the Mobility menu item.

2. Choose the Mobility Setup menu item. The Mobility Setup screen

appears.
Help
Mobility Setup
Radio configuration
| Cell Radio | Antenna type =]
System LID: I3 MHone 07011 Intemal L

None 07012 Internal
None 07021 Internal
MNone 07022 Internal
None 07031 Internal
None 07032 Intemnal

UTAM Status: UTAM Codes Required Hone 07041 Intemnal
None 07042 Internal

Radio Creditz: 0 of 0O None 07051 Internal
None 07052 Internal
None 07061 Internal
None 07062 Internal
None 07071 Internal
None 07072 Internal
None 07081 Internal
None 07082 Internal =
System: Modular
Customer name: MWICS 1.1 | Back I | Mext I
System location: Telephone room
g System ID: 111 5I:"551 235 LCancel I | Done I
Ready [ [ | 1047796 12:52:26 PM |

Figure 6.40 — The Mobility Setup screen
3. Select the System LID field and type in the System LID listed on the
programming record.

4.  Select the Cell field for the radio you want to change. Choose the cell
number assigned to this radio.

5.  Select the Antenna type field for the radio you want to change. Choose
either Internal or External.

6. Repeat steps 4 and 5 for each radio.

The UTAM status and Radio credits fields are display fields that are only used
on Norstar-PLUS USA-MICS-XC systems. You cannot edit these fields.

The UTAM status field indicates if system can use the radio credits listed in the
Radio credits field.

The Radio credits field indicates the current number of radio credits remaining

from the total number of radio credits in the system. As you add radios, the
number of current radio credits available is decreased.

Choose to exit this screen and implement your changes.
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Cells Use the Cells screen to select a cell then view the Neighbor s screen for that cell.
From the Neighbor s screen you can view and change the neighbor status of cell
neighbors and cell radio neighbors.

To access neighbor data:
1. Choose the Program menu and then the Mobility menu item.

2. Choose the Cells menu item. The Cells screen appears.

[E Morstar Manager - Mobility HEE
View neighbors Help
Cells

Cell
Cell <]
2
3
4
4]
b
7
8
9
10
11
12 =
System: Modular
Customer name: MICS 1.1
System location: Telephone room
System ID: 1115551235
Ready [ | 1047796 12:53:29 PM |

Figure 6.41 — The Cells screen

3. Select the cell you what to view neighbor data for.

4.  Choose the View neighbor s menu. The Neighbor s screen appears.
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= Morstar Manager - Mobility -~

Help

Meighbors
Cell neighbors Cell radio neighbors
Cell Meighbor Status Cell Meighbor Status

System: Modular
Customer name: Mega Etiquette Customer

System location: Telephone room
System ID: 1115552345 Done I

Ready | | [ 11/29/95 10:38:16 AM

Figure 6.42 — The Neighbors screen

5. Inthe Cell neighbor s scroll region, select the Status field for the cell you
want to change and choose either Distant or Neighbor. Repeat this step for
each cell neighbor you are programming.

6. Inthe Cell radio neighbor s scroll region, select the Status field for the cell
you want to change and choose either Distant or Neighbor. Repeat this step
for each cell radio neighbor you are programming.

7. Choose to exit the Neighbor s screen and implement your

changes.

Choose to exit the Cells screen.
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Re-evaluation Use the Re-evaluate screen to run or schedule a re-evaluation of the mobility
configuration of a CDA-MICS-XC 1.0, USA-MICS-XC 1.0, CDA-MICS-XC 1.1, or
USA-MICS-XC 1.1 system. To re-evaluate the mobility configuration:

1. Choose the Program menu and then the Mobility menu item.

2. Choose the Re-evaluation menu item. The Re-evaluate screen appears.

Re-evaluate
rStatus

Execution: Disabled

Scheduling: Not scheduled

rDate & time

Date [yy/mm/dd] Time [hh:mm] 19951110 00:01

LCancel I Schedule I | Bun now I

Figure 6.43 — The Re-evaluate screen

In the upper portion of the Re-evaluate screen are two fields which show the
status of the mobility re-evaluation: the Execution field and the Schedul ing field.

The Execution field shows you if a re-evaluation is needed. If “Required” is in the
Execution field, you should run or schedule a re-evaluation.

The Schedul ing field shows you if a re-evaluation has already been scheduled. If
“Scheduled” is in the Schedul ing field, a re-evaluation is scheduled to run.

To run a re-evaluation, choose The re-evaluation of the mobility

configuration will start immediately.

To schedule a re-evaluation:
1. Select the Date & Time field.

2. Enter the date and time the re-evaluation is to start.
Note: The start date and time must be later then the current KSU date and
time.

3. Choose

Note: Only one date and time can be used for a scheduled re-evaluation. A
dialog box will appear if a re-evaluation has already been scheduled. You
can then choose to use the previous date and time for the re-evaluation or
the date and time you have just entered.

Choose to exit this screen and implement your changes.

Norstar Manager for Windows™ User Guide



6-72 Section 6: Programming a Norstar system

Entering Software codes are codes used to upgrade a USA-MICS-XC 1.0 or USA-MICS-
software codes XC 1.1 system _by adding more portable telephones or functionality. The Software
Codes screen is used to enter these software codes.

Before you begin, make sure your monitor shows the System Pr ogramming
Overview screen.

To enter a software key:

1. Choose the Program menu and then the Mobility menu item.

2. Choose the Software Codes menu item. The Software Codes screen

appears.
[E Morstar Manager - Software Codes AEE
Help
Software Codes
Previously entered codes
Codel-Code2-Code3 ﬂ System Security Number [SSN]: 08134727
Codel-Code2-Code3
Mew Code:
System: Modular
Customer name: MICS 1.1 Apply
System location: Telephone room
System ID: 1115551235 [ cancetl || Done |
Ready [ [ [10/7/96 12:55:18 PM |

Figure 6.44 — The Software Codes screen
3. Select the New Code field and enter the new software code.

Note: Contact your telephone company representative or Norstar distributor
for details on obtaining a software key.

4. Choose to add the software key.
Choose to exit this screen and implement your changes.
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you previously used the origina , you should be aware of the following
RAD if ious| d the original RAD hould b f the followi
Programming differences between the original RAD and the Global RAD:

. In a direct connection, the RAD is connected to the Norstar Manager PC
using a serial cable. On the original RAD this cable connects to a 25-pin con-
nector. On the Global RAD the serial cable is connected to a 9-pin connec-
tor.

. The original RAD is powered from the KSU or a Station Auxiliary Power Sup-
ply (SAPS). The Global RAD has a dedicated power supply that must be
connected before it can be used.

. The original RAD uses a KSU line or a dedicated CO line connected directly
to the RAD to answer Norstar Manager calls. The Global RAD uses a KSU
line only.

. The Global RAD may be programmed from a Norstar set to auto-answer any
KSU line (001 to 999), even off-core lines. When programmed from Norstar
Manager, the auto-answer line is limited to on-core lines only.

Note: Norstar Manager can only display line numbers from 001 to 255. If the
auto-answer line has been programmed from a Norstar set to a line greater
than 255, the KSU line n umber = e xternal line field on the RAD Admin
screen is used to indicate that the line number is outside of the Norstar Man-
ager range.

. The Global RAD can be programmed from a Norstar set to use a separate
KSU line for alarm reporting. When programming line numbers for the Global
RAD from Norstar Manager, the alarm reporting line is set to the same line
as the auto-answer line.

. The Global RAD has different valid ranges for the number of rings, retry time
and number of retries. If you enter a number from Norstar Manager that is
outside of the valid range, the Global RAD will set the parameter to the near-
est valid value.

. The Global RAD’s delay before auto-answering is measured in seconds.
Norstar Manager measures the delay before auto-answering in full ring
cycles. When Norstar Manager reads the delay time from the Global RAD,
the number of seconds is divided by six to get the number of full ring cycles.
Any remaining seconds are discarded. When a new delay time is entered
from Norstar Manager, the number of rings entered is multiplied by six to get
the value in seconds.

To avoid confusion, FastRAD programming should be done using the Remote Set

tool and (o] [*] [*¥]. However, if you program the FastRAD with Norstar
Manager, you should keep in mind the following special considerations:

. For direct connections, keep the baud rate at the default setting (9600).
Although the FastRAD can support connections up to 19200, choosing a
higher rate for a direct connection (when the PC is connected directly to the
RAD) does not increase the speed of the connection.

. When changing the password for a FastRAD, the new password must be 8 to
10 digits long. Any password less than 8 digits is rejected, but no error mes-
sage appears and you still have to use the old password to connect to the
ICS.
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. Alarm baud rate options for the FastRAD do not appear with their correct val-
ues in Norstar Manager. For example, the 300 setting is actually 1200. To
avoid confusion, FastRAD programming should be done using the Remote

Set tool and 0] *][*].

After the RAD is installed at the customer's site, its programming can be changed
using a dedicated Norstar Manager screen.

However, you should be careful when you change RAD programming. Changing
certain RAD programming parameters can make it impossible to re-establish an
on-line session with the remote Norstar system. Table 6.1 outlines where you
should be careful when you make changes to the RAD programming.

Action

Caution

Changing the
RAD password

When using a Start on-line session, the changed RAD
password is automatically updated in the System Details .
If using Quick connect, record the new password so you
can use it to make a quick connection, if necessary, and
update System Details .

Changing the

If the RAD uses a KSU line and you change the line

(not available on
the Global RAD)

KSU line number, make sure the RAD phone number in the System
Details screen matches the new line's phone number. If
you do not match these numbers, you cannot make an on-
line connection. (Notel)

Changing If you disable Automatic ans wer of all incoming calls

automatic you will be unable to make an on-line connection without

answer having someone at the remote site reprogram the RAD for
you. (Notel)

Changing If you change the connection from KSU line to External

the RAD line, and the RAD is not physically configured for a CO

connection line connection, the physical configuration must also be

changed by someone at the customer site. After this
physical change is made, you must enter the new RAD
phone number in the System Details screen before you
can make an on-line connection. (Notel)

Table 6.2 — RAD programming cautionary notes

Notel: If you encounter these problems, you can use an operator assisted
connection to access the KSU and correct the programming parameters.

Before you begin, make sure your monitor shows the System Pr ogramming

Overview screen.

1. Choose the Program menu.

2. Choose the RAD menu item.
The RAD Programming screen appears.

Note: Two different RADs can be used with Norstar Manager: the RAD and
the Global RAD. When you choose the RAD menu item, Norstar Manager
automatically detects which type of RAD is being used and displays the
correct RAD Programming or Global RAD Pr ogramming screen.
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RAD

The following steps describe programming for a RAD.

= Norstar Manager-RAD Programming ME

Help

RAD Programming

rRAD Connection

RAD password: E

[~ Automatic answer of all incoming calls

Mumber of rings to answer: I 3 :I

KSU line number: | » KSU line 001 |EI

~Alarm Reporting

. . Interval between retries: I =15 :I
[ Automatic reporting of alarms

HNumber of retries: I 5 :I
Alarm monitoring number 1: I

Baud rate: m
Alarm monitoring number 2: I Parity: m

Customer Hame: Modular T1 System

System: Modular

KSU Location: Telephone Room |

System ID: 1115551234 LCancel || Done |

Ready | | [ 11/10/95 11:02:54 AW

Figure 6.45 — The RAD Programming screen

1.

Select the RAD pass word field and enter the RAD password listed in the
programming record.

If you want the RAD to automatically answer the designated line, choose the
Automatic ans wer of all incoming calls  check box.

Note : Automatic Answer must be enabled to make a remote connection
without assistance from someone at the KSU site.

Choose the drop list arrow beside the Number of rings to ans  wer field then
choose the number of rings the RAD waits before automatically answering a
call.

Choose the drop list arrow beside the KSU line n umber field then choose
the line that the RAD will answer. You can choose External for a line
connected directly to the RAD or any KSU line number.

If you want the RAD to report alarms to an alarm center, choose the
Automatic repor ting of alarms check box.

Note: If you enable alarm reporting, you must enter at least one of the alarm
monitoring numbers.

Select the Alarm monitoring n  umber 1 field and enter the telephone
number of the first alarm center the RAD will report alarms to.

Select the Alarm monitoring n umber 2 field and enter the telephone
number of the second alarm center the RAD will report alarms to.

Choose the drop list arrow beside the Inter val between retries field then
choose the number of minutes the RAD waits after a failed attempt to
contact the alarm center before attempting again.
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Global RAD

10.

11.

Choose the drop list arrow beside the Number of retries field then choose
the number of times the RAD will attempt to contact the alarm center.

Choose the drop list arrow beside the Baud rate field then choose the baud
rate RAD will use to send an alarm message to the alarm center.

Choose the drop list arrow beside the Parity field then choose the type of
parity the RAD will use when reporting alarms.

Choose to exit this screen and implement your changes.

For detailed information about the RAD programming, see the RAD Installation
Guide.

The following steps describe programming for a Global RAD.

[E Morstar Manager-Global BAD Programming HAEE
Help
Global RAD Programming
rRAD Connection
Sypstem ID: |1115551235 Spztem Name: IMl:lduIal
RAD password: |1115551235
Seconds to wait before answerning: I"13 j
[ Aut tic answer of all incoming calls;
Answer on line number: | »KSU Line 001 J
-Alarm Reporting
[~ Automatic reporting of alarms
Alarm monitoring number 1: Min. to wait before retiying: | »15 j
Alarm monitoring number 2: Number of retries: | *5 j
Baud rate: | » 300 j
Report alarms on line number: | ™ K5U Line 001 jJ Parity: | » None J
System: Modular
Customer Mame: MICS 1.1
K5U Location: Telephone room
System ID: 1115551235 Cancel | | Done ]
Ready [ [ [ | 1047796 12:53:34 PH |

Figure 6.46 — The Global RAD Programming screen

1.

Select the System ID field and enter the system ID number listed in the
programming record.

Select the System name field and enter the system name listed in the
programming record.

Select the RAD pass word field and enter the RAD password listed in the
programming record.

If you want the RAD to automatically answer the designated line, choose the
Automatic ans wer of all incoming calls  check box.

Note : Automatic Answer must be enabled to make a remote connection
without assistance from someone at the KSU site.
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10.

11.

12.

13.

14.

Choose the drop list arrow beside the Seconds to wait bef ore ans wering
field then choose the number of seconds the RAD waits before automatically
answering a call.

Choose the drop list arrow beside the Answer on line n umber field then
choose the line number that the RAD will answer.

If you want the RAD to report alarms to an alarm center, choose the
Automatic repor ting of alarms check box.

Note: If you enable alarm reporting, you must enter at least one of the alarm
monitoring numbers.

Select the Alarm monitoring n  umber 1 field and enter the telephone
number of the first alarm center the RAD will report alarms to.

Select the Alarm monitoring n  umber 2 field and enter the telephone
number of the second alarm center the RAD will report alarms to.

Choose the drop list arrow beside the Report alarms on line n umber field
then choose the line number that the RAD will use to report alarms.

Choose the drop list arrow beside the Min. to wait bef ore retr ying field then
choose the number of minutes the RAD waits after a failed attempt to
contact the alarm center before attempting again.

Choose the drop list arrow beside the Number of retries field then choose
the number of times the RAD will attempt to contact the alarm center.

Choose the drop list arrow beside the Baud rate field then choose the baud
rate RAD will use to send an alarm message to the alarm center.

Choose the drop list arrow beside the Parity field then choose the type of
parity the RAD will use when reporting alarms.

Choose to exit this screen and implement your changes.

For detailed information about the RAD programming, see the RAD Installation
Guide.

Note: The Global RAD can also be administered through the RAD Administration
screen of the Remote Set tool . See Remote Tools User Guide.

To change the programming for a FastRAD, use the Remote Set tool and

(o] (*] [*]. If you use Norstar Manager to program a FastRAD, any pass-
word that does not use 8 to 10 digits is rejected, and the baud rate settings do not
match the values you are shown. Avoid problems by using the Remote Set tool
option.
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Peripheral
Programming

Using the Voice
Mail Programming
screen

Using the Voice Mail Pr ogramming screen, you administer the Norstar Voice Mail
Interface (VMI), the Norstar Station Message Detail Recording (SMDR) and the
Norstar voice mail systems, such StarTalk and Norstar Voice Mail. The Voice Mail
Programming screen emulates a Norstar telephone interface, which allows you
to use the following programming feature codes:

Feature Code Description

(0][0]) VMI administration programming
(9] Feature Code Checklist (voice mail systems)
(o] SMDR administration programming

o] Open Mailbox (voice mail systems)

(9] Operator Status (voice mail systems)

(o] System Administration (voice mail systems)

o] Date and Time (voice mail systems)

(9] Directory Number (voice mail systems)

T The voice mail feature codes (o] to (o] are the default codes. If the
system you are programming is not using the default codes, use the Feature Code Checklist code to
determine the new codes.

Table 6.3 — Voice Mail feature codes

Most programming tasks that can be done from a Norstar telephone using these
feature codes can be done from the Voice Mail Pr ogramming screen. The excep-
tion is voice recording and play back.

Note: For information about programming the SMDR, VMI or a voice mail system,
see user documentation for that product.

Before you begin, make sure your monitor shows the System Pr ogramming
Overview screen.

To program SMDR, VMI, or a voice mail system:
1. Choose the Program menu.

2. Choose the Voice Mail menu item.
The Voice Mail Pr ogramming screen appears.
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[E Morstar Manager-Voice Mail Programming

Yoice Mail Programming

Log: [" Send As Digits [F4)

QUIT RETREY OK

(el 1] [a)[wi[e][a][x][x][u]1][e][e]
[a)[s][e]e][a][x][+][][L]

E zl|=xllc|lv
nan [2)x]e]x](s]{n]{u].]

B Mote: Only feature codez F9- are accepted.

System: %
Customer Mame:
K5U Location:
System 1D: Exit [ESC)
Ready [ [ [ | 10/9/96 1:24:49 PM |

Figure 6.47 — The Voice Mail Programming screen
3.  Enter the feature code and start programming the device.

When you are programming, the buttons on the left hand side of the screen work
exactly the same as the buttons on the telephone. You can choose these buttons
using the mouse or you can type the corresponding button on the keyboard. For

example, to choose the center display button, you can choose it using the mouse

or press

The alphabetic keys that appear on the right side of the screen work in two
different modes:

. When the Send As Digits (F4) field is empty, the alphabetic keys send
alphabetic characters. This is useful when you are entering letters such as
the name of mailboxes.

. When there is an “x” in the Send As Digits (F4) field, the alphabetic keys
send numbers. The numbers sent correspond with the numbers and letters
shown on the Norstar telephone dial pad. For example, when you type
admin, the digits that appear on the screen are 23646.

Choose to exit this screen.
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Backing up and restoring Norstar 7
system Inf ormation

Intr oduction Norstar system programming is protected when you back it up frequently. If data is
lost, backed up Norstar programming can be quickly restored to a KSU.

When you perform a backup, Norstar Manager retrieves a complete copy of all
programming information from the Norstar KSU, and stores it in the Norstar
Manager database.

You use the Backup feature when you:

. add a customer with an existing Norstar system to the Norstar Manager
database

. are offering to backup customer programming as a service
. want to update the system database with the current programming data
When you restore a customer's programming, a complete copy of a customer's

Norstar system programming, stored in the Norstar Manager database, is sent to
the customer's KSU.

You use the Restore feature when the Norstar system has lost all its program-
ming.

When you perform a restore, the Norstar system is put in maintenance mode for
the duration of the restore process.

This section explains how to perform a backup or restore operation.
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How bac kups
work

Performing a
backup or
restore

Cautions when
performing a
backup or r estore

Norstar Manager stores up to two different copies of a Norstar system's program-
ming. These different copies include:

Current
This version contains the same programming that was in the KSU at the time of
the last backup or restore.

Archive
If enabled, this version stores the current copy prior to the last backup.

Backups are treated as an assembly line. When a backup is performed, the infor-
mation stored in the Current version is moved to the Archive version.

You can perform a backup or restore immediately or schedule it for a later date
and time.

Note: Backup and restore are not available for Compact ICS 1.0. Use the Backup
and Restore tool included in Norstar Remote Tools to perform backup and restore
operations for Compact ICS and Modular ICS, version 2.0 or higher.

When you perform a backup, the customer's Norstar system may slow down, but it
remains completely operational. However, when you perform a restore, the
customer's Norstar system is non-operational and call processing is suspended
during the restore process.

We suggest you perform restores during non-business hours, and warn the
customer that the Norstar system will be non-operational. You should also
schedule backups for non-business hours so that the Norstar Manager PC is free
for you to perform other functions during working hours. The amount of time it
takes for a backup or restore to complete depends on the size and configuration of
the Norstar system, and the baud rate your PC is using.

If you perform a backup, a copy of the customer's Norstar system programming is
stored in the Norstar Manager database. This copy can be used to restore the
customer’s Norstar system in the event of complete programming loss.

If you perform a restore, a copy of the customer's Norstar system programming is
loaded from the Norstar Manager database into the Norstar system.

When Norstar Manager runs a restore, all of the sets are put in maintenance
mode. Programming data from the Norstar Manager database is then loaded into
the KSU memory. After the data is loaded, Norstar Manager takes the sets out of
maintenance mode. If a scheduled restore fails to complete due to an error, the
sets will be left in maintenance mode and the KSU will be left with corrupted
programming data. These two conditions can leave the KSU inoperable.

There are three different conditions that can cause a restore to fail:
. excessive noise or network failure

. a power fail or hardware error on the Norstar Manager PC or LAN
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. a power fail or hardware error on the Norstar KSU or RAD

Because a failed restore can render a KSU inoperable, it is important to ensure
the restore completes successfully. If you have a restore that fails, start an on-line
session and use the maintenance functions described in Section 10 to check
what state the KSU is in. If the KSU is operable and no lines or sets are disabled,
end the on-line session and schedule another restore to start after the customer's
working hours. It may also be advisable to warn the customer that his KSU may
have problems until you can perform another restore. The new restore will ensure
that all of the correct programming data is loaded into the KSU. If the KSU is inop-
erable (in maintenance mode or has lines or sets disabled), initialize the KSU, end
the on-line session and start another restore immediately. If this second attempt to
run a restore fails, you must send a technician to the customer site to troubleshoot
the Norstar system and its connections.

CAPs must be attached to the Norstar system and enabled before you attempt a
backup or restore. If you are performing a restore, the CAP must also be on the
same port as it was when the backup was performed.

The line buttons on an Enhanced CAP are restored in the default order (the first
available buttons on the CAP) regardless of the order in which the lines were
programmed originally.

When restoring DR5 systems, the sets must be equipped for external autodials to
be restored.

Scheduling a Usually you schedule a backup for a later date and time when you are offering a
bac kup or restore backup service. For example, you can schedule a backup of system data at the
beginning of each week or month.

When you have several Norstar systems to backup, you should schedule the
backups to run overnight. This method prevents any degradation of service on the
Norstar system that is being backed up.

Usually you schedule a restore for a later date and time unless the KSU requires
information from the Norstar Manager database immediately.

Impor tant: After a restore process is successfully completed, you must wait at
least 10 minutes before attempting to make another on-line connection to the
Norstar system you just restored data to.

Before you begin, make sure the Systems Director y screen appears on your
monitor. To perform a backup or restore:
1. Select the Norstar system you want to back up or restore.

2. Choose the Scheduler menu and then the Run/Submit Job menu item.
The Submit Job screen appears.
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= Submit Job v~

Help
Submit Job
rCurrent Selections
System I1D: 1115551234 Job queue: Local
‘Date & Time
Date [py/mm/dd] Time [hh:mm) 95711720 16:23
Job Connection
Job type: I »Backup Iil RAD phone number: I 1115551234
Copy type: IPEumpIete copy IEI Baud rate: | 9500
Repeat every: IPDu not repeat IEI
Save archive: I *Yes Iil

Time difference: 0.0

rMotes

Cancel I | Bun Now I | Submit I

Ready | | | [ 11/20/95 4:25:34 PM

Figure 7.1 — The Submit Job dialog box

3.  Select the Date & Time field and enter the date and time the backup or
restore will start. The date and time must be entered in the format yy/mm/dd
hh:mm (e.g. 93/02/25 02:58) with any single digit year, month, day, hour or
minute preceded by a zero.

Note: The slash (/) and colon (;) are entered automatically.

Impor tant: The time you enter into this field is the time the job will start
according to your Norstar Manager PC. If there is a time difference between
your site and the Norstar system site, check the Time diff erence field to
ensure you do not accidentally schedule the job to start during the cus-
tomer's work hours.

4.  Choose the drop list arrow beside the Job type field and then choose either
Backup or Restore.

5. Choose the drop list arrow beside the Copy type field and then choose
Complete cop .
Note: Complete copy is the only option available for this field.

6. Choose the drop list arrow beside the Repeat every field and then choose
the interval between repeated backups. If you do not want this job repeated,
choose Do not repeat .

7. Choose the drop list arrow beside the Save archive field and then choose
either Yes or No. If you choose Yes, the programming currently stored in the
database will become the archive copy. If you choose No, the programming
currently stored in the database is deleted.

Note: This field is only used if you are performing a backup.
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8. If you want to use a RAD telephone number that is different than the one
entered on the System Details screen, select the RAD phone n umber field
and type the new telephone number. For more information on the RAD
phone number, see Section 5.

9. If you want to use a baud rate that is different than the one entered on the
Systems Details screen, choose the drop list arrow beside the Baud rate
field and then choose the baud rate used for this backup or restore. For more
information on baud rates, see Section 5 .

10. Select the Notes field and type any notes for this backup or restore.

11. ChOOSG| Bun Now I or | Submit I

Note: If you are using a local Job Scheduler, the connection parameters are listed
on the System Details screen of your PC. If you are using a network Job Sched-
uler, the connection parameters are listed on the System Details screen of the
network server.

After the backup or restore is scheduled, you must access the Job Queue screen
and activate the Job Queue. Until the Job Queue is activated, no scheduled
backups or restores will be completed. For more information about the Job
Queue, see Job Queue later in this section.

Scheduling a bac kup In some cases backups need to be scheduled to run on a regular basis. For
to repeat instance a customer may want his system backed up every month. This can easily
automaticall y be done using the Repeat Every field on the Submit J ob screen.

The Repeat Ever y field allows you to schedule a backup to run every day, every
week, every two weeks and every month. When you choose every day, the backup
will be run at the same time every day. When you choose every week or every two
weeks, the job is run at the same time and the same day (e.g. 9:00 pm on
Monday). When you choose every month, the backup is run at the same time and
date every month (e.g. 9:00 pm on the 5").

To stop the backup from repeating, choose Do not repeat from the Repeat every
field. You must also check the Job Queue screen to see if the backup has already
been submitted to the Job Queue. If it has, you must remove the backup from the
Job Queue. For information about removing a backup from the Job Queue, see
Deleting a job later in this section.

Note: Once the backup is scheduled, you must access the Job Queue screen
and activate the Job Queue. Until the Job Queue is activated, no scheduled
backups will be completed. For more information about the Job Queue, see Job
Queue later in this section.
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Running the bac kup or
restore immediatel y

Restoring an Ar chive
copy

Job Queue

Before you run a backup or restore immediately, make sure the Submit Job
screen appears on your monitor. When you want to run a backup or restore imme-
diately:

1. Enter the job information on the Submit Job screen.

2. Choose

The backup or restore will start immediately.

In certain situations you may need to restore an Archive copy of the customer’s
Norstar system programming. To do this you must first make the Archive copy the
current copy.

To restore an Archive copy:
1. Move to the Systems Director y screen.
2. Select the desired Norstar system.

3. Choose the Scheduler menu and then the Undo Last Bac kup menu item.
The Archive copy of the Norstar system programming becomes the Current
copy.

Note: The Undo Last Bac kup menu item is not available unless you create
an Archive copy of the Norstar system programming. To create an Archive
copy you must choose Yes for the Save archive field when you backup the
Norstar system.

4.  Complete the restore using the procedure described in the preceding sec-
tions.

When you schedule a job (backup or restore), you must change to the Job Queue
screen to run them. This screen shows what jobs are scheduled. If you do not
access this screen, scheduled jobs are considered pending and will not run.

Two separate Job Queues are available on Norstar Manager: the Local Job
Queue and the Network Job Queue. The Local Job Queue operates on your PC
and only contains jobs that you submitted to the queue. Your PC is also the only
one that can run the scheduled jobs. The Network Job Queue operates on the
network server and contains jobs submitted by you and other network users. Any
Norstar Manager PC on the network can run jobs scheduled on the Network Job
Queue. To change which Job Queue you are using, you must change the Job
Queue path field on the Preference Settings screen. For more information about
the Preference Settings screen, see Section 3, Norstar Mana ger default
settings .

Before beginning, make sure the Systems Director y screen appears on your
monitor. To open the Job Administrator:

1. Choose the Scheduler menu and then the Job Queue menu option.
The Job Queue screen appears.

Norstar Manager for Windows™ User Guide



Section 7: Backing up and restoring Norstar system information 7-7

[E Morstar Manager-Job Queue HAEE
Job  Queue Help

Job Queue

Customer Hame Syztem ID Job deszcription Date & Time Status =]
MICS 1.1 1115551235 Backup 9610071349 HReady -
T1 Release 1 1115554545 Restore 9610071350 Ready
T1 Release 1 1115554545 Backup 9610071350 Ready
48 2276663456 Backup 9610071350 Ready
Compact 6661234567 Backup 9610071351 Ready

I | Update I

Ready [ [ [ [ 1077796 1:51:25 PM

Figure 7.2 — The Job Queue screen

The Job Queue screen lists all Norstar systems scheduled for a backup or
restore. Each backup or restore in the list is called a job.

Each job on the Job Queue is listed with its Customer name, System ID, whether
it is a backup or restore, when the job is scheduled to occur, and its status. The
possible status messages are listed below.

. Ready — The job has been scheduled and is waiting to be run.
. Running — The job is currently being run.

. Done — The Job has been completed successfully.

. Cancelled — The job was stopped by a Norstar Manager user.

. Error — An error occurred while the job was being run. If this status message
appears, check the Job inf o dialog box by choosing the Job menu and then
the Status menu item.

Completed jobs are not deleted from the Job Queue. The jobs are left on the
screen so you can view the status of the completed jobs.

The maximum number of jobs that can be on the Job Queue is 8500. To prevent
the Job Queue from becoming too full, you should delete completed jobs after you
have confirmed that they have run successfully. To remove the completed jobs,
use the delete procedure described later in this section.
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Running a job

Starting the Job
Queue

Stopping the Job
Queue

Editing a job

Jobs that are scheduled to repeat automatically are treated like a series of sepa-
rate jobs. Each time the job is scheduled to repeat, another job is added to the Job
Queue. This allows you to check if the previous job has completed successfully
and see when this job will be run again.

The Job Queue screen allows you to perform several tasks on the jobs shown.
You can run a job, start the queue, stop the queue, edit jobs, delete jobs and
check on the status of the job.

From the Job Queue screen you can run any job listed on the queue without
running the entire queue. The job can be in any position on the queue, not just the
job at the top of the queue. To run a job:

1. Select the job to be run.

2. Choose the Job menu and then the Run menu item.
The selected job will start immediately.

Note: This option is not available if another job is currently being run.

Before the jobs listed on the Job Queue will run at their scheduled times, the
gueue must be started. Once started, the Job Queue will run until you stop it. To
start the Job Queue:

1. Choose the Queue menu and then the Run menu item.

When the Job Queue is running, the display prompt Job Queue Running
appears in the status bar at the bottom of the screen.

To stop the Job Queue, choose the Queue menu and then the Stop menu item.
The Job Queue stops processing the scheduled jobs.

Note: You must stop the Job Queue from running before you can leave the Job
Queue screen.

The information entered on the Submit Job screen can be edited from the Job
Queue screen. To edit this information, choose the Job menu and then the Edit
menu item. The Edit J ob screen is displayed and you can edit any of the informa-
tion about the selected job. The Edit Job screen has the same fields as the
Submit Job screen. For more information about the fields on the Edit Job
screen, see Scheduling a bac kup or restore , earlier in this section.
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Deleting a job

Resubmitting a job

Checking the
status of a job

The Job Queue screen allows you to remove pending or completed jobs from the
Job Queue. To remove a job from the Job Queue:

1. Select the job, or jobs, you want to remove.

2.  Choose the Job menu and then the Delete menu item.
The job, or jobs, are removed from the queue.

After a job has completed or failed to complete due to an error, you can resubmit
the job. To resubmit a job:

1. Select the job you want to resubmit.

2. Choose the Job menu and then the Resubmit menu item.
The job status is changed to Ready and the job will run again.
Note: You can assign the job to run immediately, or assign the job to run later
by defining a start time and placing it in the Job Queue .

The Resubmit feature is most useful for job that have failed due to an error. Once
you have fixed the problem that caused the error, you can use this feature to
submit the job again without leaving the Job Queue screen.

The Job inf o dialog box shows a more detailed account of the status of a particu-
lar job. To show this screen, choose the Job menu and then the Status menu
item. The Job inf o dialog box is shown.

Job info

Customer: MICS 1.1
System ID: 1115551235
Job type: Backup Start: 961007134955

Status: Ready Duration: 00:00:00

Job status:

[ Bey ]| Done ]

Figure 7.3 — The Job info dialog box

None of the fields on this dialog box can be edited. They are for information
purposes only.

If a job has failed for any reason, you can attempt to run it again by choosing the
Retry action button.
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Job Queue err or The error messages that appear on Job inf o dialog box are explained in the
messages Norstar Mana ger Error Messa ges file. This file uses the application Microsoft

Windows™ Write (Windows 3.1) or WordPad (Windows 95). See your Windows
documentation for an explanation of how to use this program.
To access this file in Windows 3.1:
1. Move to the Windows Program Manager.

Open the Norstar Mana ger program group.

Open the Norstar Mana ger Error Messa ges file.

Scan through the list of error messages to find the one you require.

o b W DN

When you are finished with the error message file, close the file and return
to Norstar Manager.

To access this file in Windows 95:
1. Click Start.

2. From the Program menu, select the Norstar Mana ger program group and
the Norstar Mana ger Error Messa ges file.

Scan through the list of error messages to find the one you require.

4.  When you are finished with the error message file, close the file and return
to Norstar Manager.
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Intr oduction Norstar Manager provides you with powerful utilities that allow information to be
duplicated quickly, without error. Norstar Manager provides two methods for dupli-
cating Norstar system information. These methods include:

. copying Norstar system information from an existing system to a new system
. copying Norstar system files to another database on the file server, your
PC's hard drive, or a floppy disk

This section explains how to copy Norstar system information and copy Norstar
systems between directories.

Cop ying When you copy Norstar system information, you are copying all of the system,

Norstar line, and set programming from an existing Norstar system to a new Norstar
system. Copying Norstar system information is useful if you are repeatedly config-
SyStem uring a similar type of system. By copying Norstar system information from an

information existing Norstar system that is similar, much of the programming for that new
system will be done. To complete the new system programming, you simply
change the programming parameters that are different between the two systems.

Before you begin, make sure the Systems Director y screen appears on your
monitor. To copy system information:

1. Make sure the Norstar system you want to copy programming from exists on
the Norstar Manager database. If it does not, follow the instructions in
Section 4 to add a new system. Then follow the instructions in Section 7 to
make a backup of the Norstar system.

2. Select the Norstar system you are copying system information from.

3. Choose the Edit menu and then the Copy System Details menu item.
The Copy System Details screen appears.
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Requirements f or
copying Nor star
systems

[E Morstar Manager-Copy System Details HAEE
Help
Copy System Details System ID: oy

Customer Name: IHICS 1.1

K5U Location: ITeIephune room

Address: |327 Main Street

Contact: |Monique
Phone number: 1115551235
Install date [pypy/mm./dd): @I
RAD phone number: [1115551235

BAD pazsword: |55555
Remote time difference: I 2.0 j hours from local ime

Type of system: |Modula[
Software version: |MICS 1.1 [NASCDAJUSA]

System language: I English/French J
Mote; |Motify Monique before a backup or restore. |j
Cancel I | Done I
Ready [ [ [ | 10/7/96 1:54:50 PM |

Figure 8.1 — The Copy System Details screen

4.  Type the new customer System ID.

5.  Enter the remaining information for the new customer.
Note: Refer to Section 4 for instructions on using this screen.

6. When you have completed your changes, choose

7. Follow the instruction in Section 7 to restore the programming to the new
Norstar system.

8.  Follow the instructions in Section 5 and Section 6 to start an on-line
session and change the programming parameters that are different on the
new system.

The programming for a Norstar system can only be copied to a Norstar system
with the same system type and software version. For example, a Centrex+ system
can be copied to any other Centrex+ system, but not to a Modular DR5 or
Compact DR5 system.
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Copying Nor star You can copy Norstar system files from one location to another, using the Copy
system fi les System(s) feature. This feature copies system files stored in the Norstar Manager
database on your PC's hard drive, or file server, to another location such as the
floppy drive on your PC, or another directory.

Note: If you are backing up files for Compact ICS 2.0, Modular ICS 2.0 or other
system through Remote Tools, you may have to copy the backed up files manually.
See your Windows documentation or online help for information about copying
files.

Before you begin, make sure the Systems Director y screen appears on your
monitor. To copy a Norstar system to another location:
1.  Select the Norstar system you want to copy.

2. Choose the Edit menu and then the Copy System(s) menu item.
The Copy System(s) dialog box appears.

Copy System[z]

Destination: I C:ACUSTOMER

System ID:

Status:

| LCancel I | Done I

Figure 8.2 — The Copy System(s) dialog box

3. Type the full pathname of the destination directory that you want the system
copied to. If you are copying the Norstar system to a floppy disk, change the
pathname of the destination directory to include the name of the floppy disk
drive (e.g. A:\backup ).

4. Choose

Norstar Manager copies the selected Norstar systems to the destination directory.
The dialog box shows you the status of the operation.

Impor tant: Some Norstar systems may be too large to be copied on to smaller
floppy disks. Use high density floppy disks to copy these systems.

Copying system fi les To copy system files to a floppy disk, copy the file ksu.db from the path <installed
to a floppy disk dir>\<system id>\current\ ksu.db . For example, copy
c:\wnor s3\12345678.90\current\ ksu.db to a floppy disk.

Note: ksu-db for a 12 port system is often greater than 1.44 Mb and thus the copy
to floppy may fail. If this happens, use a third party archiving tool, such as PKZIP,
to compress the ksu.db file. Then manually copy the compressed file to a floppy
disk(s) using DOS or Windows'" File Manager. The user receiving this archived
file must use a decompression tool, such as PKUNZIP, to decompress the file.
The archived file can be decompressed into the appropriate destination directory
on the target PC.
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Deleting a Nor star
system fr om the
director y

Upgrading to a
T1 Release 1
system

How to upgrade a
system

When you delete a Norstar system from the Norstar Manager directory, all record
of programming for this system is removed form the directory. To delete a Norstar
system:

1. Select the Norstar system you want to delete.
2. Choose the Edit menu and then the Delete System(s) menu item.

3. Choose

The Norstar system is removed from the Norstar Manager directory.

The Upgrade Database feature of Norstar Manager is provided to aid you in
upgrading from an 8X24 to a 0X32 system. It saves hours of programming time by
retaining the set programming and most of the system and line programming.

Note: See the Programming parameter s changed section for a description of
which programming parameters are changed.

The Upgrade Database feature will only convert Modular DR5 systems to T1
Release 1 systems. This feature is not available for Compact DR5 or 3X8 DR5
systems. Make sure the system to be upgraded has been upissued to DR5 v9.20
or CTX+ v9.21 or greater.

Impor tant: Before restoring information from the Norstar Manager database to
the 0X32 modular system you MUST:

. use Feature *CONFIG to manually program the trunk types to match the
database being restored

. ensure the database hardware list matches the physical configuration of the
KSU

To upgrade a system:

1. Perform a backup of the Modular DR5 system that will be upgraded.
This ensures that you have the most current programming information.

Move to the Systems Director y screen.

w

Use the Copy System(s) feature, described earlier in this section, to make a
copy of the Modular DR5 system.

Select the Modular DR5 system you are going to upgrade.
Choose the Edit menu and then the Upgrade Database... menu item.

Install the T1 Release 1 system.

N oo g &

Access Feature *CONFIG and set the parameters associated with trunk
cartridge types to match the trunk modes that will be restored from the
Norstar Manager database.
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10.

11.

12.

13.

Move the amphenol connector from the 8X24 system to the 0X32 system,
matching the module numbers. The core amphenol must go to the 24 port
connector on the 0X32 system.

Note: If the amphenol connectors are not moved, CAPs cannot be restored.

Remove all Call Identification Interface equipment and M7900 sets.

Restore the upgraded database to the 0X32 KSU.
Note: See Section 7 of this guide for more information about performing a
backup or restore.

Select the new 0X32 system from the Systems Director y screen and
choose the File menu and then the Start On-line Session menu item.

Move to the System Pr ogramming Over view screen and ensure the phys-
ical mapping of the lines and sets is the same as the KSU being installed.

Configure the parameters that are cleared or defaulted as appropriate.
See the Programming parameter s changed section for a description of
which parameters are cleared or defaulted.

Upgradingto a To upgrade DR5 to a MICS-XC system, a database upgrade must be performed
MICS-XC system and restored to a T1 system before doing the core software upgrade.
Note: You must add a new customer to backup the newly upissued core software.

Features .

Upgrade Systems provides a mechanism for porting KSU programming from
a 8X24 system to a 0X32 T1 Release 1 system.

The only upgradable systems are Modular DR5 or Centrex+ systems. This
feature is disabled for all other systems in the directory.

This feature can be accessed in the System Directory.

Programming Using Norstar Manager, you should be able to make the programming changes
Parameter s required to complete the upgrade in approximately 10-15 minutes.

changed

The following parameters are automatically changed by the Upgrade Database

feature:

The off-core modular 8X24 lines are converted to 0X32 off-core analog lines.
The programming parameters for each of these lines are not changed.

All of the on-core 0X32 lines are defaulted to analog lines.
The Installer and Admin passwords are reset to 0X32 default values.
New 0X32 fields, lines and sets are given default values.

The 16 new DNs (8 B1 and 8 B2 channels) are given the first available DN
starting with the same prefix digit as the first previously existing DN.

F72 Timed Release buttons are removed (blank).
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. F72 reach through codes (T) are removed from System speed dials, Per-
sonal speed dials, Vmsg telephone numbers, and external autodials.

. On an unexpanded 8X24 system 2-digit DNs are converted to 3-digit DNs
after an upgrade, using the prefix digit of the first DN as the new prefix digit
of all DNs on the 0X32 system.

. Call Identification Interface equipment is removed from the Hardware List.

. M7900 sets are removed from the database.

T1 upgrade . Modular 8X24 DR5 lines are mapped to 0X32 T1 lines. The trunk cartridge
parameters are set to match the trunk modes.

. The F810, Centrex Make Busy, button is removed during DR5to T1
upgrades.

Centre x upgrade . The Centrex Transfer/Conference and Complete Conference Feature Access
Codes are removed during upgrades.

. New DNs do not have any lines assigned.
. All Trunk/Line programming is preserved.

. The F810, Centrex Make Busy, button is not removed during DR5 to
Centrex upgrades.
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Intr oduction A Norstar Manager report is a list of the programming for a Norstar system. A
report may also provide wireless and maintenance information. Reports can be
printed out on a printer or stored in an ASCII file. You can open the ASCII file with
a standard text editor and print or edit the data.

Norstar Manager creates reports containing three kinds of programming informa-
tion: system programming, set programming and line programming. You can
specify that these reports list all of the information stored in the Norstar system or
only part of it. You can also specify that reports only list information about certain
lines or sets.

Two types of maintenance report are available: the System Test Log and the
System Admin Log. More information about these logs is provided in Section 1 0.

Printing Before you begin, start an on-line session and make sure the System Pr ogram-
system, set ming Over view screen appears on your monitor. To print a report:
or line 1. Select the lines or sets the report will be created from. This step is not nec-
. essary for printing a report on system programming.
programming Note: The maximum number of lines or sets you can select is 50.

repor ts 2. Choose the Reports menu and then the Generate Repor ts menu item.

3. Choose the Generate R eports menu item. The Generate R eports screen
appears.
Note: On CDA-MICS-XC 1.0, USA-MICS-XC 1.0, NA-MICS-DR 1.1, CDA-
MICS-XC 1.1 and USA-MICS-XC 1.1 systems, choose the Generate
Reports menu item and then the Standar d Repor ts menu item. The Stan-
dard Repor ts screen appears. This screen has the same fields as the
Generate Repor ts screen.
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Section 9: Norstar Manager reports

= Morstar Manager-Generate Reports v

Help

Generate Reports

[¥ System Reports

[¥ Line Reports [X Set Reports
[" Set Line Access
[ Set Abilities
[” Buttons and Status
[C Set Personal Speed Dials
[" Set Call Services

[ Inventory Set Details

[~ Call Handling [ Line Data

[ Miscellaneous 1 [ Target Lines

[ Trunk Data

[ Line Abilities

[ Line Service Modes

[ Inventory Line Details

[ Miscellaneous 2

[C Service Modes

[ Filters

[ Passwords

[ System Speed Dials

C) Use cumrently selected lines

C Use cunently selected sets
@ Use all lines ® U :

[ Remote Access Packages

[" Hardware List

[ Inventory Summary

[™ Trunk Cartridge
[ Destination Codes [ Printer [ File
[ Routing Table
| Done I | FPrint I

Ready [ [ [ [

11410495 10:58:47 AM

Figure 9.1 — The Generate Reports screen

4,

Choose the check boxes of the programming information you want included
on the report.

If you choose the System Repor ts check box, all of the system reports are
printed. Similarly, if you choose the Line Repor ts check box all of the line
reports are printed and if you choose the Set Repor ts check box all of the
set reports are printed.

If you do not want to print all of the reports, do not select the System
Reports, Line Repor ts, or Set Repor ts check boxes. Only choose the
check boxes of the individual reports you want to print.

Choose the Use all lines check box if you want the report to contain
programming information for all of the lines. Choose the Use currentl y
selected lines check box if you want the report to contain programming
information for the lines you selected on the System Pr ogramming Over -
view screen.

Note: If you choose Use currentl y selected lines , the line reports available
will vary depending on the lines you selected. If you select trunk lines, the
Target Lines report is unavailable and will not print. If you select target lines,
the Trunk Data and Line Abilities reports are unavailable and will not print.

Choose the Use all sets check box if you want the report to contain
programming information for all of the sets. Choose the Use currentl y
selected sets check box if you want the report to contain programming infor-
mation for the sets you selected on the System Pr ogramming Over view
screen. Only sets that are currently on the Hardware List screen are
printed.
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Printing
wireless or
maintenance
repor ts

Note: Since you cannot select both lines and sets on the System Pr ogram-
ming Over view screen, a single report cannot contain both selected sets
and selected lines. However, a single report can contain both line and set
information if you choose either Use all lines or Use all sets .

7. Choose the Printer check box and/or the File check box.

8. Choose to print the report to the printer or file.
Note: If you chose the Printer check box in step 7, the report will start to

print.
9. If you chose the File check box in step 7, the file selection dialog box will
appear.
File Hame: Directories: “
I report_rpt chwnorsmagr =

Cancel

+ | *
= wnorsmar
£ 11155512.34
£ 111595512.45
£ 1115552345
£ 11159554444
£ 11155566.66

Drives:

IEC: |EI

Save File as Type:
|Report Files (*.RPT] [ #]

Figure 9.2 — File selection dialog box

10. Enter the name of the file and select the directory where you want the file
stored.

11. Choose

To exit from the Generate Repor ts screen and return to the System Pr ogram-

ming Over view screen, choose

This report is only available for CDA-MICS-XC 1.0, USA-MICS-XC 1.0,
NA-MICS-DR 1.1, CDA-MICS-XC 1.1 and USA-MICS-XC 1.1 systems. Before
you begin, start an on-line session and make sure the System Pr ogramming
Overview screen appears on your monitor. To print a report:

1. Choose the Reports menu and then the Generate Repor ts menu item.

2. Choose the Wireless and Maintenance Repor ts menu item. The Wireless
and Maintenance Repor ts screen appears.
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= Morstar Manager-Wireless and Maint Reports -~

Help

Wirelezs & Maintenance Reports

[ Maintenance Reports

[ Portable Registration [ Admin Log

[ Mobility Setup [~ System Log
[ Cells
[~ Software Codes
X Printer [ File
Done I | Frint I
Ready | | [ 11/28/95 2:24:32 PM

Figure 9.3 — The Wireless and Maintenance Reports screen

3.  Choose the check boxes of the programming information you want included
on the report.
If you choose the Wireless Repor ts check box, all of the wireless reports
are printed. Similarly, if you choose the Maintenance Repor ts check box all
of the maintenance reports are printed.
If you do not want to print all of the reports, do not select the Wireless
Reports or Maintenance Repor ts check boxes. Only choose the check
boxes of the individual reports you want to print.

4, Choose the Printer check box or the File check box.

5. Choose to print the report to the printer or file.
Note: If you chose the Printer check box in step 4, the report will start to
print.

6. If you chose the File check box in step 4, the file selection dialog box will
appear.

Note: The Software Codes report is unavailable for CDA-MICS-XC 1.0 and
CDA-MICS-XC 1.1 systems. All Wireless Reports are unavailable for
NA-MICS-DR 1.1 systems.
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Printer s

Printing ke y cap
labels

= Save File As
File Hame: Directories:
I report.rpt c:vwnorsmgr
Cancel
¥ = eh +
F= wnorsmar

£ 11155512.34
£ 11155512.45
3 11155523.45
£ 11155544 44
3 11155566.66

Dnves:

IEC: Iil

Save File as Type:
IHepult Files [*.RPT] |5|

Figure 9.4 — File selection dialog box

7. Enter the name of the file and select the directory where you want the file
stored.

8. Choose

To exit from the Wireless and Maintenance Repor ts screen and return to the

System Pr ogramming Over view screen, choose

Reports and key cap labels can be printed to any printer supported by Microsoft®
Windows™. However, there are a few restrictions on using printers:

. When you are using a dot matrix printer with the generic printer driver, the
printer must be set to use compressed mode.

. The generic printer driver will not work with a laser printer.

. When you are printing a report using a laser printer, you can use a land-
scape or portrait orientation. If you use a landscape orientation, the font size
used will be larger and less information will fit on a page.

Although a dot matrix printer can be used to print key cap labels, we recommend
using a laser or inkjet printer due to the improved print quality.

Key cap labels are printed using the information stored in the Norstar KSU. The
labels show the name of the feature, line or internal autodialer. They also show the
number dialed for an external autodialer. The maximum length of the labels is ten
characters. Due to this size restriction, feature names are abbreviated and
external autodialer numbers are truncated where necessary. If the set is
programmed to use the alternate language, the key cap labels are printed in the
alternate language.

Key cap labels are printed on a printer or saved in a ASCII file. The ASCII file can
be modified using a standard text editor and printed later.
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Note: Although you can use any paper to print key cap labels, we recommend
that you use the Norstar Mana ger Key Cap Templates . These templates are
designed to match the way the Key Cap Printing Utility prints the labels. They are
also perforated for easy removal of the labels after printing. A laser printer or ink-
jet printer is required to print using the Norstar Mana ger Key Cap Templates .

Before you begin, make sure your monitor shows the System Pr ogramming
Overview screen. To print key cap labels:

1. Select the sets you want to print key cap labels for. The maximum number of
sets you may select to print at one time is 50. Key labels are not printed for
sets that are not currently connected to the KSU.

Note: If a CAP module is assigned to any of the sets specified, the key cap
labels for the CAP are also printed. Also, if the CAP module has more than
30 line appearances assigned to it, the key labels will be printed on both
halves of the Key Cap Template.

2. Choose the Reports menu and the Print K ey Caps ... menu item.
The Print K ey Caps dialog box appears.

Print Key Caps
" File
X Printer
| LCancel I | Print I

Figure 9.5 — The Print Key Caps dialog box

3. Choose the Printer check box to print the key cap labels to a printer or
choose the File check box to print the key cap labels to a file. You can print
key cap labels to both a file and the printer by selecting both check boxes.

4. Choose to print the report to the printer or file.
Note: If you chose the Printer check box in step 3, the report will start to
print.

5. If you chose the File check box in step 3, the Key cap file selection dialog
box will appear

= Save File As
File Hame: Directories:
I report kc c:vwnorsmgr
_Eancel
¥ = er +
F= wnorsmar

£ 11155512.34
£ 11155512.45
3 11155523.45
£ 11155544 44
3 11155566.66

Save File as Type: Dnves:
[Key CapFiles -kC)  [3] [=c: B

Figure 9.6 — Key cap file selection dialog box
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6. Enter the name of the file and select the directory where you want the file
stored.

7. Choose

8.  When applying the key labels to the sets, use the button inquiry feature
([Feature ] [*][0]) to determine where each key label should be placed.

Impor tant: Only use printers that fully support Windows™ 3.1 and the standard
Windows™ fonts to print key cap labels.

Adjusting the ke y  Different makes of laser printers will vary slightly in how they position text on a
cap label printing page. If your printer does not align the text on the key cap labels properly, you will
have to change the key label setup.
To change the key label setup:

1. Move to the Print K ey Caps dialog box.

2. Choose

The Setup K ey Caps dialog box appears.

Setup Key Caps

Printer: HP Lazerdet 1115i PostScript

Horizontal Offset: II]_I]I]I]I]
Vertical Dffset: Il]_l]l]l]l]

| LCancel I | Save I

Figure 9.7 — Setup Key Caps dialog box

3.  Select the Horizontal Offset text box and enter an offset in inches.
The horizontal offset is the number of inches the key cap text will be shifted
to the right along the width of the key cap template. To shift the text to the
left, enter a negative number into this field. The maximum horizontal offset is
eight inches.

4.  Select the Vertical Offset text box and enter an offset in inches.
The vertical offset is the number of inches the key cap text will be shifted
down on the key cap template. To shift the text up on the key cap template,
enter a negative number into this field. The maximum vertical offset is eight
inches.

5. Choose

The offsets you have entered will be saved in a file on the Norstar Manager
default directory.

Note: If you change your default directory, you must copy the key cap setup
files to the new default directory or re-create them. Key cap setup files are
the files in the default directory that end with the extension .KCP.

Norstar Manager for Windows™ User Guide



9-8 Section 9: Norstar Manager reports

The key caps setup files are specific for each type of printer. If you are using more
than one printer, you may have to enter offsets for each printer. If you need to
make more than one setup file, Norstar Manager will keep track of which setup file
belongs to which printer.

Show Inventor Y  The Show Inventor y screen shows the devices that are currently connected to
the KSU. For a Modular KSU, the Show Inventor y screen shows which modules
screen .
are connected. It also shows how many lines or sets are connected to each
module. On Compact DR5 and 3X8 DR5 KSUSs, this screen only shows how many
lines and sets are connected.

From this screen you can also access a summary of the lines and sets that are
connected to the KSU.

To view the Show Inventor y screen:

1. Choose the Reports menu and then the Show Inventor y menu item.
The Show Inventor y screen appears.

[E Reports-5how Inventory AEE
Help

Show Inventory

Module Trunk Cartridge Installed Yacant
Number Type | 1 | 2 | 3 | Line Set Line Set |;|
1 Core 0 2 0 30 =
2 Core = X 8 0 40 0
3 Unused 0 0 0 0
4 Unused 1] 0 0 0
5 Unused 0 0 0 0
6 Unused 1] 1] 1] 1]
7 Unused 1] 0 0 0
8 Unused 1] 1] 1] 1]
Total lines: 48 Totals 8 2 40 30

System: Modular
Customer Name: MICS 1.1
System ID: 111565612356

Yiew Set details I | Done I

| Ready | | | 10/7/36 1:5930FM |

Figure 9.8 — The Show Inventory screen

To get detailed information about the lines or sets on this system, choose either

IView %ine delailsl or | View %el details I
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Intr oduction Maintaining a Norstar KSU site involves responding to problems when they occur
and using Norstar Manager to find a solution. Norstar problems are reported in
two ways:

. a customer telephones the Norstar Manager operator with a problem
. the RAD reports an alarm to a dedicated reporting device

If the problem cannot be solved from the Norstar Manager PC, a technician can
be sent to do the repairs on site.

This section explains how to perform maintenance on a Norstar installation.
Solving specific Norstar system problems using Norstar Manager is covered in
Section 1 1.

Maintenance Once a problem is reported, it can be investigated using the maintenance func-
tions in Norstar Manager. In a maintenance session, you can:

. check the System version

. query the port status

. run a connectivity test

. check the provision status

. run a loopback test

. check the System Test log

. check the System Admin log
. check the Network log

. change the clock sources

. check the CSU statistics

. check the module status
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Determining the
System Version
number

Querying the Port
status

Before you can perform any of these maintenance functions, you must establish
an on-line connection with the Norstar KSU. Refer to Section 5 of this guide for
instructions on connecting to a Norstar KSU.

Note: On Compact DR5 and 3X8 DR5 systems, the only maintenance functions
available are checking the System version and the port status.

The System Version feature allows you to view the version number of the software
in your Norstar system.

Before you begin, make sure your PC has an on-line connection with the Norstar
KSU. To view the System version number:

1. Choose the Maintenance menu and then the System Version ... menu
item.
The System Version dialog box appears.

System Yersion

K5U System version: 30pL11

System: Modular
Customer Mame: MICS 1.1
K5SU Location: Telephone room
System ID: 11156551235

Figure 10.1 — The System Version dialog box
For more information about the System version, see the Norstar Installer Guide .

Note: The version number can also be seen on the System Test Lo g screen and
the System Admin Log screen.

You query the port status when you want to evaluate the status of individual sets
or lines on the Norstar system. Checking the port status allows you to:

. check the status of any set or line

. disable or enable sets and lines
Note: Disabling or enabling lines can interrupt service at the Norstar KSU site.

Note: Enabling a disabled port is the same as enabling all the ports on the
module.

Before you begin, make sure your PC has an on-line connection with the Norstar
KSU. To check the port status:
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1. Choose the Maintenance menu and then the Port Status menu item.
The Port Status screen appears.

Statuz  Ports Help
Port Status
Port DN/Line Type Status | =]
|1I]1 2221 M7310 Idle
101-2 None Unequipped Idle
224 Hone Unequipped Idle
224-2 MNone Unequipped Idle
225 025 Line CO Hybrid Idle
226 026 Line CO Hybrid Idle
227 027 Line CO Hybrid Idle
228 028 Line CO Hybrid Idle
229 None Unequipped Idle
229-2 Hone Unequipped Idle
230 None Unequipped Idle
230-2 Hone Unequipped Idle
271 None Hneauinned Idle hl
System: Modular
Customer Mame: MWICS 1.1
K5U Location: Telephone room
System ID: 1115551235 Update Status I | Done I
Ready [ [ | 10/7/96 2:05:30 PM |

Figure 10.2 — The Port Status screen
2. Choose the Ports menu and then the Select Ports to View menu item.
The Specify P orts dialog box appears.

3.  Select the port you want the status for by selecting the ports from the list of
ports or by entering a range of ports in the From and To fields.

4. Choose

The status of the selected ports appears on the Port Status screen.
When you no longer want to view the status of certain ports, you can remove them
from the Port Status screen. To remove ports:
1. Select the port or ports you want to remove.

2. Choose the Ports menu and then the Remove Ports menu item.
The selected ports are removed from the screen.

You can view a summary of the ports shown on the Port Status screen. To view a
summary:

1. Choose the Ports menu and then the Port Summar y menu item.
The Show Inventor y screen appears.

The Show Inventor y screen that appears only shows a summary of the
ports selected on the Port Status screen. For more information about the
Show Inventor y screen, see Section 8 of this guide.
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Hardware Info
dialog bo x

You can change the status of the ports using the Status menu. To change the
status of a port:

1. Selectthe ports.
2. Choose the Status menu and then the Enable or Disable Now menu item.

Impor tant: Always check to ensure that the port you are going to disable is
idle. When you choose Disab le Now, the selected port is disabled immedi-
ately and any call on that port is lost.

Caution : Do not disable the port the RAD is connected to. If you disable the
RAD port, the Norstar Manager session is immediately terminated and
Norstar Manager will not be able to access the KSU until the port is enabled
by someone at the KSU site.

Note: Do not disable digital lines. Digital lines should be de-provisioned.
For more information about de-provisioning lines, refer to Checking the
provision status later in this section.

3. Choose Update Status

To exit from this screen and return to the System Pr ogramming Over view

screen, choose

The Hardware Inf o dialog box provides additional information about the lines and
sets that are connected to the Norstar KSU. For all devices connected to the KSU,
the Hardware Inf o dialog box shows the port number, DN, name, type, version
number, add-on device (e.g. CAP and BLF), and add-on version number.

Before you open the Hardware Inf o dialog box, you must select one or more ports
on the Port Status or System Pr ogramming Over view screen. The Hardware
Info dialog box will then show details about the lines and sets connected to the
selected modules.

To view the Hardware Inf o dialog box:

1. Choose the port or ports you want to view additional information about from
the Port Status or System Pr ogramming Over view screen.

2. Choose the Ports menu and then the Hardware Info menu item. The
Hardware Inf o dialog box appears.
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Hardware Info

Port DM /Line Type Yersion | Add-ol n
1011 2221 Monique M7324 OGPEED3 Mone
101-2 Mone Unequipped Hone
1021 2222 Carol M7310 OGREBO0 Mone
102-2 MNone Unequipped Mone
106-1 2226  Patick M7310 OGPCEDE  Mone
106-2 Mone Unequipped Mone
110-1 2230 James M7310 1 None
110-2 Mone Unequipped Hone n

Figure 10.3 — Hardware Info dialog box

Note: There may be a delay before the Hardware Inf o dialog box appears. The
length of the delay becomes longer if you select more ports.

Running a A connectivity test is usually performed when you suspect a voice connection is
connectivity test faulty. This test determines if the fault exists in the KSU, expansion modules, or
Time Compression Multiplexing (TCM) line.

Note: The connectivity test is only available for Modular DR5 and Centrex+
systems.

Impor tant: The connectivity test interrupts service on the line or device it is
testing. Users should be warned before a connectivity test is performed.

Before you run a connectivity test, make sure your PC has an on-line connection
with the Norstar KSU and the Port Status screen appears on your monitor. To run
a connectivity test:

1. Select the lines and/or sets you want to test.
The maximum you can test is 16 lines or sets.

2. Choose the Connectivity Test... menu.
A warning dialog box appeatrs.
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Possible service disruptions on: 0 line[s] in use

Test results will be output to the display. Iz it OK to begin the

test?

=== CAUTION ===

This test will temporarnily disable all ines on modules
selected. Remote connection will drop if the BAD line is on
a selected module.

1] set(s] in use

LCancel

Figure 10.4 — The Connectivity Test caution dialog box

3. To continue with the connectivity test, choose

After a few minutes (depending on the number of ports you have selected for the
test) the connectivity test results appear on your monitor.

Note: Do not disconnect any of the sets while they are being tested. If you do, the
connectivity test will not run.

= Morstar Manager-Maintenance = |*

Help

Connectivity Test

System version: 30MULDY
Real time processor: 30GEBG03

Port

DM/Line Results +

104

Hone

Set Problem

Customer Ma

System

System: Modular
me: Modular DR5 Customer
K5SU Location: Electrical room

Ib: 116554444

Ready

11/28/95 4:37.01 PM

Figure 10.5 — The Connectivity Test screen

The Connectivity Test screen lists a result message for every port you tested.
Table 10.5 lists all of the possible messages and what each message means.
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The results for a Connectivity test can only be shown once. After you leave the
Connectivity Test screen, you cannot access these test results again. You can,
however, access the results again from the System log.

Impor tant: Do not run a Connectivity test on the port the RAD is connected to. If
you do, the KSU will drop the call to the RAD. Norstar Manager will still appear to
have an on-line session, however you will not be able to perform any programming
or maintenance functions.

Impor tant: When you are using a Remote or Operator assisted connection, run
Connectivity tests on the expansion modules only. Do not test any port on the core
KSU. A Connectivity test on a port on the core KSU can only be run using a Direct

connection.

Message Meaning
InvPort You have entered a port number that does not have a
device or line connected.
Set Problem Passed — The KSU station port is receiving signals properly.

If the device has no voice connection, the problem is with
the device.

Trunk Problem

Passed — The KSU trunk port is receiving signals properly. If
the trunk has no voice connection, the problem is likely the
external line, the 25-pair cable, or the cross-connect.

Trunk Cartridge
Problem

Passed — The Trunk Cartridge (TC) is receiving signals
properly. If the trunk has no voice connection, the problem is
likely with the TC, the external line, the 25-pair cable, or the
cross-connect.

TCM KSU Fault

Failed — There is no signaling to this KSU-based device, but
other devices on the KSU work. The problem is likely with
the TCM line, the device, the 25-pair cable to the KSU, or
the cross-connect.

TCM EC Fault

Failed — There is no signaling to this Station Module (SM)
based device, but other devices on this SM work. The
problem is likely in the TCM line, the 25-pair cable to the
SM, the cross-connect, or the SM.

DS KSU Fault

Failed — There is no signaling to any KSU-based device.
The problem is likely with the 25-pair cable to the KSU or
with the cross-connect.

DS EC Fault

Failed — There is no signaling to any device on this Norstar
bus. The problem is likely with the 25-pair cable to the
module, the module, the DS-30 cable, or the Expansion
Cartridge (EC).

KSU A08 Fault

Failed — A fault was detected in the KSU. Replace the KSU.

EC A08 Fault

Failed — A fault was detected in the Expansion Cartridge.
Replace the Expansion Cartridge.

Table 10.1 — Connectivity test result messages

Norstar Manager for Windows™ User Guide




10-8 Section 10: Maintaining a Norstar KSU

Checking the
provision status

The Provisio n Status screen shows all of the digital lines connected to a KSU
and indicates which lines are provisioned. You can also use this screen to provi-
sion another line or remove a line from service.

Note: This screen is only available on T1 Release 1, CDA-MICS-XC 1.0,
USA-MICS-XC 1.0, NA-MICS-DR 1.1, CDA-MICS-XC 1.1 and USA-MICS-XC 1.1

systems.

Before you check the provision status, make sure your PC has an on-line connec-
tion with the Norstar KSU. To view the provision status of the digital lines:

1. Choose the Maintenance menu and then the Provision Status menu item.
The Provision Status screen appears.

Edit Help
Provision Status Trank Status iz

001 Line00O1 Mot digital line

002 LineD0D2 Mot digital line

0032 LineD03 Mot digital line

004 LineDD4 Mot digital line

005 LineD05 Mot digital line

006 LineD06 Mot digital line

007 LineDO7 Mot digital line

008 LineD08 Mot digital line

009 LineDD9 Mot digital line

010 Line010 Mot digital line

011 LineD11 Mot digital line

012 Line012 Mot digital line

N2 ineN1? Mot dinital line hal

System:
Customer Name:
KSU Location:
Spstem ID:

M odular
MICS 1.1

Telephone room
1115551235

Ready

[ 10/7/96 2:06:34 PM |

Figure 10.6 — The Provision Status screen

To provision a digital line:

1.  Select the line you want to provision.

2. Choose the Edit menu and then the Provision line menu item.

To remove a digital line from service:

1. Select the line you want to remove from service.

2. Choose the Edit menu and then the Deprovision line menu item.

Choose to exit from this screen and return to the System

Programming Over view screen.
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Running a Loopback tests are performed on digital lines when you suspect a faulty connec-
loopbac k test tion. To run the loopback tests:

1. Choose the Maintenance menu and then the Loopbac k Tests menu item.
The Loopbac k Tests screen appears.

= Maintenance-Loopback Tests B

Testb500 TesthlD Testbh20 Help
Loopback Tests

Cartridge

Trunk cartridge 1

|Slul iz unequipped or has an analog card.

Trunk cartridge 2

|Slol iz unequipped or has an analog card.

| Update Status I I Done: I
Ready [ | | [ 11710795 12:34:57 PM

Figure 10.7 — The Loopback Tests screen

2. Select a cartridge from the list box.

3. Choose the Test 500 menu and then the Start or Stop menu items.

4. Choose to update the cartridge status display.
5. Choose to return to the System Pr ogramming Over view

screen.

Note: Repeat steps 1 to 5 for the Test 510 and Test 520 menus. You must
complete each test before beginning the next test.

Choose to exit from this screen and return to the System

Programming Over view screen.

Checking the The System Test Log provides you with a list of diagnostic test results, event
System Test Log messages and alarm codes. You use the System Test Log when you want to
identify the cause of a problem.

Before you check the System Test Log , make sure your PC has an on-line
connection with the customer's KSU. To view the System Test Log :
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1. Choose the Maintenance menu and then the System Test Log menu item.
The System Test Log screen appears

[E Morstar Manager - Maintenance HAEE
Help

Spstem Test Log
Software verzion: 30JplL11

Current alarm

Description: |UTAM codes required

Parameters: |2|]2

Time: 19940101 01:25 Clear Alarm |

Description Parameters Date & Time =]
System startup 1 1 19940101 01:23
Power up 299 11 19940101 01:23
Event Entry 6801 9 1 19940101 01:25
UTAM codes required 202 g 1 19940101 O1:25
5 = Severity Rep = Number of repetitions
System: %

Customer name:

System location:

System ID: | Erase Log... I | Done I
Ready [ [ | 10/9/96 1:16:25 PM |

Figure 10.8 — The System Test Log screen

The System Test Log contains three types of entries: tests, alarms, and events.
Each of these entries is shown with a description, a type, a code, a severity rating,
the number of repetitions, and the time it occurred.

The severity rating associated with each alarm or event is used to signify how crit-
ical the alarm or event is. The severity ratings range from 1 to 9, with 9 being the
most critical. Events or alarms with a high severity rating have more impact on the
Norstar system and thus should be dealt with first. For a full description of alarms,
events and severity ratings, see the appropriate Norstar Installer Guide . See
also the Norstar Companion Alarm and Event Code Man ual.

After you have acted on the alarm and event messages, you should erase these
messages from the System log.

To erase the Current alarm, choose
To erase the System log, choose

When you have finished viewing the System log, choose to return

to the System Pr ogramming Over view screen.
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Checking the
System Admin Log

Administration events, such as system initialization or invalid password attempts,
are recorded in the Administration log. This log is useful if you want to check when
a specific event occurred, or check on a Norstar system's activity.

The log holds a maximum of 10 items. When the log is full, new event messages
replace the logged event messages in a chronological order. The oldest event
message in the log is replaced by the new event message.

Before you check the System Admin Log , make sure your PC has an on-line
connection with the Norstar system. To view the System Admin Log :

1. Choose the Maintenance menu and the System Admin Log menu item.
The System Admin Log screen appears.

[E Morstar Manager - Maintenance H[E= E
Help

System Admin Log
Software version: 30plL11

Current alarm

Description: |UTAM codes required

Parameters: |2l]2

Time: 19950101 01:02 Clear Alarm |

Descrniption Parameters Date & Time =]
Restart requested 9 2 19961007 08:03
Morstar Manager entered 450 4 1 19950101 01:07
Config entered 416 221 4 1 19950101 03:19
Morztar Manager entered 450 4 3 19950101 04:00
5 = Severity Rep = Number of repetitions
System: Modular
Cuztomer name: MICS 1.1
System location: Telephone room
System ID: 1115551235 Erase Log._. I | Done I
Ready [ [ [ | 1047796 2:07:43 PM |

Figure 10.9 — The System Admin Log screen

The System Admin Log contains two types of entries: Alarms and Events. Each
of these entries is shown with a description, a type, a code, a severity rating, the
number of repetitions, and the time it occurred.

The severity rating associated with each alarm or event is used to signify how crit-
ical the alarm or event is. The severity ratings range from 1 to 9, with 9 being the
most critical. Events or alarms with a high severity rating have more impact on the
Norstar system and thus should be dealt with first. For a full description of alarms,
events and severity ratings, see the appropriate Norstar Installer Guide . See
also the Norstar Companion Alarm and Event Code Man ual.

After you have viewed the log and dealt with any alarms or events in the log, you
should erase it.

To erase the Current alarm, choose
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Viewing the
Network Log

To erase the Administration log, choose All of the entries on the

Administration log are erased.

To exit from this screen and return to the System Pr ogramming Over view

screen, choose

The Network Lo g screen allows you to view the events and alarms that have
occurred on the digital lines:

Note: This screen is only available on T1 Release 1, CDA-MICS-XC 1.0, USA-
MICS-XC 1.0, NA-MICS-DR 1.1, CDA-MICS-XC 1.1 and USA-MICS-XC 1.1
systems.

Before you begin, make sure your PC has an on-line connection with the Norstar
KSU. To view the Network log:

1. Choose the Maintenance menu and then the Network Log menu item. The
Network Log screen appears.

= Morstar Manager-Maintenance vI —
Help
Network Log
Type Code S Rep Date & Time
| Eraze Log I | Done I
Ready [ [ [ | 1171095 10:51:21 AM

Figure 10.10 — The Network Log screen

After you have viewed the log and dealt with any alarms or events in the log, you
should erase it.

To erase the Network Log, choose All of the entries on the

Network Log are erased.
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Choose to exit from this screen and return to the System

Programming Over view screen.

Viewing the clock  The Clock Sour ces screen allows you to view the clock source used by the digital
sources lines.

Note: This screen is only available on T1 Release 1, CDA-MICS-XC 1.0, USA-
MICS-XC 1.0, NA-MICS-DR 1.1, CDA-MICS-XC 1.1 and USA-MICS-XC 1.1
systems.

Before you begin, make sure your PC has an on-line connection with the Norstar
KSU. To view the clock sources:

1. Choose the Maintenance menu and then the Clock Sour ces menu item.
The Clock Sour ces screen appears.

[ Morstar Manager-Maintenance HAEE
Help

Clock Sources

Clock source TC1: |Netwolk [Primary] Source

Clock source TC2: |Slandh_l,l [Secondary] Source

Spstem: Modular
Customer Mame: MICS 1.1
K5U Location: Telephone room
System ID: 1115551235

Ready | | [ 10/7/96 2:08:50 PM

Figure 10.11 — The Clock Sources screen

The Clock sour ce TC1 field and the Clock source TC2 field show the clock
source used by the digital lines.

Choose to exit from this screen and return to the System

Programming Over view screen.
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Viewing the CSU
statistics

The CSU statistics feature allows you to view statistics for the CSU.

Note: This screen is only available on T1 Release 1, CDA-MICS-XC 1.0, USA-
MICS-XC 1.0, NA-MICS-DR 1.1, CDA-MICS-XC 1.1 and USA-MICS-XC 1.1
systems.

Before you begin, make sure your PC has an on-line connection with the Norstar
KSU. To view the CSU statistics:

1. Choose the Maintenance menu and then the CSU Statistics menu item.
The CSU Statistics screen appears.

= Morstar Manager-Maintenance ~|~

Stats Help
C5U Statistics

Cartridge

1
2

Ready | | | [ 11/21/95 10:27:09 AM

Figure 10.12 — The CSU Statistics screen

To view the performance statistics:
1. Select the cartridge you want to view.

2. Choose the Stats menu and then the Performance Statistics menu item.
The Performance Statistics screen appears.

3.  After viewing the statistics, choose to return to the CSU

Statistics screen.

To view the alarm statistics:
1.  Select the cartridge you want to view.

2. Choose the Stats menu and then the Alarm Statistics menu item.
The Alarm Statistics screen appears.

3.  After viewing the statistics, choose to return to the CSU

Statistics screen.
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To clear the statistics on either the Alarm Statistics or CSU Statistics screen,

choose
Choose to exit from this screen and return to the System

Programming Over view screen.

Checking the The Module Status feature allows you to view the status of each module. You can
module status also use this screen to enable or disable modules

Note: This screen is only available on T1 Release 1, CDA-MICS-XC 1.0,
USA-MICS-XC 1.0, NA-MICS-DR 1.1, CDA-MICS-XC 1.1 and USA-MICS-XC 1.1
systems.

Before you begin, make sure your PC has an on-line connection with the Norstar
KSU. To view the module status:

1. Choose the Maintenance menu and then the Module Status menu item.
The Module Status screen appears.

Statug Help
Module Status
Module Cartridge Status Lines Busy =]
1 Mot a valid TC - Module 0
02 1 Attached 1]
02 2 Attached 0
03 1 Mot a valid TC - Module 1]
04 1 Mot a valid TC - Module 1]
05 1 Mot a valid TC - Module 1]
06 1 Mot a valid TC - Module 0
07 1 Mot a valid TC - Module 1]
1] 1 Mot a valid TC - Module 0
Spstem: Modular
Customer Hame: MICS 1.1
K5U Location: Telephone room
System ID: 1115551235 Update Status || Done |
Ready [ [ | 10/7796 2:09:41 PM |

Figure 10.13 — The Module Status screen

To disable a module:
1. Select the module to disable.

2. Choose the Status menu and then the Disable Now menu item.

To enable a module:
1. Select the module to enable.

2. Choose the Status menu and then the Enable menu item.
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Choose to exit from this screen and return to the System

Programming Over view screen.
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Intr oduction The features of Norstar Manager allow you to provide better service to your
customers. Seven areas where Norstar Manager can help you provide better
service to your customers are:

. installing new systems

. making changes to existing systems
. adding peripherals

. troubleshooting customer problems
. responding to system alarms

. printing reports and key labels

. service contracts

Installing ne w Using Norstar Manager, you can reduce the amount of time it takes to program a
systems new system by copying programming from an existing Norstar system that has

similar programming. For example, one of your customers may be a chain of retail
stores with very similar programming. When you want to program a Norstar
system for a new store in this chain, you simply copy the programming from one of
the stores which has a Norstar system that is already programmed. You then only
have to program the parameters that are unique to the new system. See
Section 8 of this guide for more information about copying Norstar systems.

After the Norstar system is programmed, you can use the report feature to print a
hardware wiring list. The installer can use this list as a reference when connecting
the peripheral devices to the KSU ports.
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Recommended
Norstar
Manager
processes

Changing
Norstar system
programming

Adding
peripherals

There are many ways to use Norstar Manager to install and maintain your base of
Norstar systems. The process we recommend for installing a system is listed
below.

1. Install the Norstar system and RAD. If the system is already installed at the
customer site, then you only need to install the RAD.

2. Add the new customer to the Norstar Manager database.

3.  Program the system using an on-line session then use a backup to copy the
data into the Norstar Manager database. If the system already has program-
ming information stored in the KSU, just perform a backup to copy the data
into the Norstar Manager database.

After the customer has been installed and added to the Norstar Manager data-
base, we recommend you do the following to maintain the KSU programming.

. Schedule monthly backups to capture any programming changes that may
have occurred on site.

. When you use an on-line session to make changes to the programming,
make sure you backup the system to update the copy of programming stored
in the Norstar Manager database.

Norstar Manager can save you time by reducing the number of site trips required
to make programming changes. Using Norstar Manager in an on-line session, you
can change the programming of an existing Norstar system without sending a
technician to the customer site.

Norstar Manager provides you with two advantages when you are adding periph-
erals.

One of the advantages of using Norstar Manager is you can use an on-line
session to check if there are station ports available. This information will help you
to decide on what equipment is required. For example, if there are not enough
station ports available for the additional peripherals, you will have to include a
station module in the upgrade equipment.

Another advantage of Norstar Manager is that you can use an on-line session to
program the additional peripherals before they are shipped. This saves you from
sending a technician out to install a peripheral and then program it. Since the
peripheral is already programmed into the KSU, you can simply ship it to the
customer. After receiving the peripheral, the customer can then plug it into the
correct port and start using it.
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Troub Ieshooting You can find Norstar Manager troubleshooting help on-line. Click on the Norstar
on-line Manager Error Messa ges icon. This brings up a file in Write (Windows 3.1) or
WordPad (Windows 95). Help categories include:

. Connection Error Codes

. Modem Initialization String Problems
. SQL Error Codes

. Data Dictionary Error Codes

. Text Error Codes

Troub Ieshooting Using Norstar Manager for troubleshooting allows you to solve a variety of Norstar
customer system problems from your PC. The following paragraphs show you how to use
Norstar Manager as part of your troubleshooting procedure.
problems
If you are unable to solve a particular problem using Norstar Manager refer to the
appropriate Norstar Installer Guide or the Norstar System Coor dinator Guide
for further instructions.

When you use Norstar Manager to solve problems a customer is having with a
Norstar installation, you should look for information in the following areas:

. Access line or set information by moving to one of the programming screens.
(Refer to Section 6 for information on accessing line and set programming
screens).

. Check the System log and look for system error messages. (Refer to
Section 10 for information on accessing the System log).

. Check the Administration log for system activity. (Refer to Section 10 for
information on accessing the Administration log).

. Query the port status. (Refer to Section 10 for information on querying the
port status).

If you solve a problem by changing Norstar programming in an on-line session,
remember to perform a backup. If you do not perform a backup, Norstar program-
ming stored in the Norstar Manager database will not reflect the KSU.

When you are using Norstar Manager to troubleshoot, remember to:

. Have a copy of relevant Norstar documentation, such as the appropriate
Norstar Installer Guide or Norstar System Coor dinator Guide

. Warn the customer of any procedures that may interrupt or cause delays in
telephone service
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Can’t access
Compact ICS
programming

Autodial/ Personal
Speed Dial b uttons
cannot be
programmed

Dial tone absent
on external lines

Display
unreadab le

To access programming features for Compact ICS, you must be using Remote
Tools software, and the internal RAD (I-RAD) must be enabled.

Autodial buttons cannot be programmed if the Norstar system memory is full.
When a customer phones you with this problem, first check the System Log for an
Event 408 “No memory for another pool” message. If you see this message for the
set in question, tell the customer the Norstar system memory is full and cannot
accept any more speed dial numbers. Refer to Section 10 for instructions on
accessing the System log.

If the System log does not contain this message, check the set's button status. To
check the set's button status follow the instructions for accessing the Buttons and
Status screen in Section 6 .

When no dial tone on external lines is reported, first check the Buttons and
Status screen. Make sure the lines that the customer thinks are external lines, are
programmed as such. Refer to Section 6, Buttons and Status for instructions on
accessing this screen.

If the lines are programmed as external lines:

. Check the Show Inventor y screen to confirm that a Trunk Cartridge for the
line is installed.

. If a trunk cartridge is installed, check the Port status screen to see if the line
is enabled. Enable the Port or DN if it is disabled.

. Run a connectivity test on the line in question and check the results.

If none of these procedures work, you must send a technician to the Norstar KSU
site to check the physical connections between the set(s) and the KSU.

When a customer reports that a set display is unreadable, first check the Buttons
and Status screen. Make sure the contrast level for the set in question is not set
too low.

If the contrast is set too low, use the Contrast field to set the contrast to a higher
level.

If adjusting the contrast level does not solve the problem:

. Use the Port Status screen to disable the set

. Use the Port Status screen to enable the set, and have the customer
confirm that the display is readable

If these procedures do not solve the problem, a site visit is recommended.
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Problems with If a customer reports that Music On Hold or Background Music on a set, or sets, is
Background not working, first check with the installer that a music source was correctly
Music and Music connected to the distribution block when the Norstar system was installed.
On Hold : : : :
Have the customer check that the music source is turned on, is working, and the
volume is turned up.

If adjustments to the music source do not solve the problem:

. If the problem is Background Music, use the Buttons and Status screen to
check the button assignment display to make sure the feature is
programmed onto a button (Feature 86).

. Check the Miscellaneous screen to see if Background Music is enabled. If it
isn't, enable it.

Telephone dead When a customer reports a telephone is dead, first ask the customer to check the
connections at the RJ-11 jack and at the phone.

If these connections are good:

. Check the Port Status screen to make sure the port is enabled, if disabled,
enable it. If the port is enabled, disable it and then re-enable it.

If these procedures do not solve the problem, send a technician to the customer
site to replace the telephone.

Responding to Norstar Manager allows you to respond to alarms reported from remote Norstar

system alarms systems. To receive alarms, program the RAD to report KSU alarms to a terminal
or printer located at your Norstar Manager center. The KSU alarms will be printed
on the printer or terminal with the date and time the alarm occurred and the
System ID number of the KSU affected. After you receive an alarm, you can use
the Norstar Manager maintenance functions to check the KSU for the cause of the
alarm and potential solutions.

For more information about programming the RAD to report alarms, see the RAD
Installation Guide . For more information about the Norstar Manager mainte-
nance functions, see Section 10 of this guide. For information about alarms, see
Section 4 of the Norstar Mana ger for Windo ws ™ Reference Guide . See also
the Norstar Companion Alarm and Event Code Man ual.
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Printing repor ts
and key labels

Norstar Manager reports provide information about the programming for a Norstar
system. On some systems, reports also provide wireless and maintenance infor-
mation. Reports can be used for several purposes.

One use of the reports is to provide the customer with a well organized list of the
Norstar system programming. Using reports has two main advantages over

providing programming records for the customer's records. The first advantage of
using reports is that they always show the latest programming information for the
system. The other advantage of reports is that they can be customized to meet the
customer's needs. For example, areas of programming information can be added
or removed so that only the information that the customer needs is printed.

Reports can also be used to as an overview of the programming parameters when
training new customers.

Another use of reports is to provide a written copy of a specific area of program-
ming that a technician can use when diagnosing a problem.

Norstar Manager also prints key cap labels using the information stored in the
database. Using Norstar Manager to print key cap labels allows you to provide
accurate and professional looking key labels to your customers.

See Section 10 of this guide for more information about reports.
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Service Norstar Manager allows you to provide new service contracts to your customers.
contracts Three examples of new services available through Norstar Manager are: backing
up customer programming, providing monthly remote programming changes and

printing key cap labels.

You can use the backup feature of Norstar Manager to provide a back up service
to your customers. By backing up the customer's Norstar system programming on
a regular basis, you can protect that programming. An option in the Schedule a
Job screen allows you to automatically back up data daily, weekly, bi-weekly, and
monthly, as required by your customer. In the event of a loss of programming, you
can use this backed up data to restore a current version of the programming to
your customer's Norstar system. For more information about backing up Norstar
systems, see Section 7.

You can use the on-line programming capability of Norstar Manager to provide
your customers with programming updates as required. This service would allow
the customer to update Norstar system programming on a regular basis. For large
changes or changes that affect system performance, such as changing the DN
length, you could schedule the changes to be done after the customer's working
hours. This way the changes can be made without affecting the Norstar system
performance.

You can also use the key cap label printing of Norstar Manager to provide addi-
tional service to your customers. When you or the customer changes the button
assignment for a set, you can print out an up-to-date, high quality set of key cap
labels for your customer. For more information about key cap label printing, see
Section 9.
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Appendix A:
Programming Recor ds

Contained in this appendix are the following Norstar Mana ger for Windo ws
Programming Recor ds:

Norstar Mana ger for Windo ws Compact DR5 Pr ogramming Recor d
Norstar Mana ger for Windo ws Modular DR5 Pr ogramming Recor d
Norstar Mana ger for Windo ws 3X8 DR5 Programming Recor d
Norstar Mana ger for Windo ws Ce ntre x+ Programming Recor d

Norstar Mana ger for Windo ws Nor star-PLUS T1 Release 1
Programming Recor d

Norstar Mana ger for Windo ws Nor star-PLUS Centre x Release 1
Programmin g Record

Norstar Mana ger for Windo ws Nor star-PLUS MICS-XC 1.0
Programming Recor d

Norstar Mana ger for Windo ws Nor star-PLUS NA-MICS-DR 1.1, CDA-
MICS-XC 1.1, and USA-MICS-XC 1.1 Programming Recor d

A copy of one of these programming records should be filled out before you
program a system using Norstar Manager for Windows.
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Software The following table describes the names of the various software release and KSU
versions products:
Type of System Soft\c/)v%r?\l;/neigsion Soft,\\fg\rleNZ;res}ion KSU Product Name
3X8 DR5 DR5 3X8 DR5
Compact DR5 DR5 Compact DR5
Compact Disconnect DR5 DR5 Compact Disconnect

DR5

Compact ICS (CICS), CICS/MICS2.0/Other CICS/MICS2.0/Other various

Modular ICS (MICS)

2.0 other

Modular DR5 DR5 Modular DR5
Modular (MICS) Mega ICS CDA-MICS-XC 1.0 CDA-MICS-XC 1.0

Modular (MICS)

Mega Etiquette

USA-MICS-XC 1.0

USA-MICS-XC 1.0

Modular (MICS) Centrex R1 Centrex Release 1 Centrex Release 1

Modular Centrex+ Centrex+ Centrex+

Modular (MICS) 0X32 Release 1 T1 Release 1 T1 Release 1

Modular (MICS) MICSDR 1.1 MICS 1.1 NA-MICS-DR 1.1
(NA/CDA/USA) CDA-MICS-XC 1.1

USA-MICS-XC 1.1

Table A.1 — KSU system and software types

Note: NA stands for North America. CDA stands for Canada. USA stands for United States of America.

CICS/MICS2.0/Other refers to any system in the Norstar Manager customer database which is not supported
by Norstar Manager, but is administered using Remote Tools.

Norstar Manager supports full backup and restore operations for DR 5.1, but only supports remote program-
ming of DR 5.1 configuration features which are common to DR5 and DR5.1. Any new configuration features
found in DR5.1 (additions to DR5 found in DR5.1) must be remotely programmed using the Remote Set tool.
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Access
The method by which you gain entry to the Norstar Manager database or a
Norstar Manager screen.

Action b utton
Performs a specific action. It appears as a small rectangle displayed on a screen
and labeled with the action it performs or the screen it navigates to.

Add system
Adds a new Norstar system to the Norstar Manager database.

Alarm
Indicates an error condition in the KSU.

Analog Terminal Adapter (A TA)

A device that allows analog telecommunication devices, such as a single line tele-
phone, to connect to the Norstar system. Defaults for the ATA are automatically
assigned by the Norstar system.

ASCII (American Standar d Code for Inf ormation Inter change) text file
A standard text file that can be read by several different software programs. When
Norstar Manager prints a report to a file, it puts information in this format.

Backup
The process of making a copy of a Norstar KSU's programming. This copy is then
stored in the Norstar Manager database.

Bloc k
A section of text or data.

Cancel
An operation that terminates an action and returns to the previous screen or
action.
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Cascade men u
Appears when a specific menu item is selected and provides another menu of
options.

Check box
A small box, displayed on a screen, that allows you to turn a setting on or off.
These boxes often appear in groups. Check boxes appear as [].

Command
An action or task.

Communicate
The exchange of information between your PC and a Norstar KSU.

Confi guration
A type of programming that assigns certain settings to a Norstar system, lines,
and sets.

Connection
A link between a KSU and PC. This link is either established through a modem or
directly through an RS-232 connection.

Conventions
The way information is described. For example, using smaller text surrounded by
a box to represent PC keys.

Copy system details
Copies all of the programming information from one Norstar system to another
Norstar system stored in the Norstar Manager database.

Cursor
A flashing character displayed on the screen that tells you where to enter data.

Customer site
The location of a customer's Norstar KSU.

Customer system
A Norstar system used at the customer site.

Data entry
The process of entering Norstar information and programming into the Norstar
Manager database.

Database
A collection of files stored on the PC's hard drive, or server. Norstar Manager uses
these files to store information about a Norstar system.

Default
A pre-set value or setup that is defined by the KSU software.

Delete system
Removes a Norstar system from the Norstar Manager database.
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Device
A printer or monitor external to Norstar Manager.

Diagnostics
Determines what and where a problem is. If you receive an alarm from a remote
site, you would run diagnostics to identify what the trouble is.

Dialog bo x
A window that appears on the screen to perform a specific action or warn you of
an error.

Disable
Turns a feature or option off.

Enable
Turns a feature or option on.

End key
A key on the PC keyboard that moves the cursor to the bottom of a list.

Error messa ge
A window that pops onto the screen and tells you what the error is and what action
should be taken.

Esc
A key on the PC keyboard that cancels a Norstar Manager operation.

Exchang e assignments
Allows you to swap features between buttons on a set.

Execute
Carry out a task.

FastRAD
The latest version of the Remote Access Device (RAD). It offers a faster transmis-
sion rate than the Global RAD as well as improved security features.

Feature
A special characteristic of a Norstar system that allows you to customize a line,
set, or entire system.

Field
An area reserved for data entry. This area is usually found beside a title or name.

Function
A specific task that Norstar Manager performs.

Global Remote Access De vice (Global RAD)
The new Norstar peripheral device which provides Norstar Manager access to a
Norstar KSU.

Hardware
The physical components that make up a computer, printer, RAD, KSU or any
other device being discussed.

Norstar Manager for Windows™ User Guide



Glossary - 4

Help
Provides assistance on how to use Norstar Manager. You can access the Help
screens from any screen in Norstar Manager by choosing the Help menu.

Highlight
When an object is highlighted, the text and background colors change.

Home key
A key on the PC keyboard that moves the cursor to the top of a list.

Icons
Symbols used to indicate certain specifications or states.

ICS
Integrated Communications System.

Installing
The process of starting and setting up Norstar Manager. This term also refers to
the process of installing and setting up a Norstar system.

Internal Remote Access De vice (IRAD)

The RAD that is built into the Compact ICS KSU and must be enabled with soft-
ware keys. When enabled, the IRAD allows remote administration and software
access to Norstar Manager and Remote Tools.

Inventor y
A listing of all lines, sets and other devices on a Norstar system.

ltem
A component of a list or menu.

Job
A scheduled operation, such as a Backup or Restore of a Norstar system.

Job Queue

A screen that displays a list of scheduled jobs waiting to be completed. When you
have scheduled a Backup or Restore, you must access this screen and leave it on
your monitor until the scheduled job is completed.

Key Service Unit (KSU)
The central hardware component in a Norstar system.

Line pr ogramming
Customizes Norstar features such as Dialing Mode and Full Autohold.

List
A collection of records that can be selected and used.

Log ging on
The process of entering the Norstar Manager software application.

M7100 telephone
The Norstar model M7100 telephone that has a single-line display and one pro-
grammable button without an indicator.

Norstar Manager for Windows™ User Guide



Glossary - 5

M7208 telephone
The Norstar model M7208 telephone that has a single-line display and eight pro-
grammable buttons with indicators.

M7310 telephone

The Norstar model M7310 telephone that has a two-line display with three display
buttons, 10 programmable buttons with indicators, and 12 dual programmable but-
tons without indicators.

M7324 telephone
The Norstar model M7324 telephone that has a two-line display with three display
buttons and 24 programmable buttons with indicators.

Maintenance
The process of making sure the Norstar Manager database and remote customer
site are working correctly.

Mandator y field
A field that must contain valid data.

Menu
A list of actions you can choose from.

Modem

A device used by the PC to communicate with a Norstar KSU. It converts a digital
data communications signal into an analog signal that can be transmitted over a
standard telephone line.

Module type
Refers to the expansion products on a Norstar Modular KSU. There are two mod-
ule types: a Station Module and a Trunk Module.

Monitor
The video display terminal that is attached to your PC.

Navigation
Movement between fields or screens in Norstar Manager.

Object
A button or list item that you can manipulate.

On-line

A remote or direct connection between a customer's Norstar KSU and your PC.
Any changes you make to a screen while your PC has an on-line connection, are
also made at the KSU.

Open system database
Displays and provides access to information for a specific Norstar system.

Optional fi eld
A field that does not need to contain data.

Password
A series of characters that allow access to Norstar Manager or the RAD.
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Pathname
The route to a Norstar Manager database. Each database pathname represents a
different directory of Norstar systems stored on the PC's hard drive.

Personal computer (PC)
An IBM, or compatible, micro-computer that runs the Norstar Manager software.

Pgdn key
A key on the PC keyboard that moves the cursor down one page in a list.

Pgup key
A key on the PC keyboard that moves the cursor up one page in a list.

Programming
A process of setting up and selecting features on a Norstar system.

Programming Recor d
A programming guide, found in Appendix A, that provides an area for you to write
a Norstar system's programming down.

Query
Checking the status of a customer's Norstar KSU.

Remote Access De vice (RAD) types
There are four types of device: the original RAD, Global RAD, FastRAD, and the
Internal RAD. The original RAD does not support Remote Tools.

Remote Access De vice (RAD)
A Norstar peripheral device which provides Norstar Manager access to a Norstar
KSU.

Remote site
A customer's Norstar system that is not located in the same area as your PC.

Remove assignments
Allows you to remove features that are assigned to a specific button on a set.

Reset Programming
Returns all programming for a line or set to the original default values.

Report
A listing of Norstar system programming that can be sent to a printer or to an
ASCII file.

Schedule
Determines when a Backup or Restore job should be completed.

Screen
The Norstar Manager display that appears on the PC's monitor.

Select
Identifies a menu item, list item or button as a target for a specific action.
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Set programming
Customizes Norstar features such as Personal Speed Dial and Pickup Group.

Software
A set of instructions known as a program. Programs form the basis of Norstar
Manager and a Norstar KSU.

Software ver sion
Refers to the type of software that a Norstar KSU uses to operate.

Specify System Confi guration
Organizes how station and trunk modules are setup. This setup affects how a
Norstar system is programmed.

Steps
A formula for performing a specific task.

System
A Norstar system.

System Admin Log
Keeps a record of activity on a Norstar system. A record of an invalid password
entry is kept in the System Admin Log.

System Details
A screen display of a customer's Norstar site and system information.

System ID
A series of digits that identify a Norstar system within the Norstar Manager
database.

System Test Log
An area within a Norstar KSU that contains records of alarms and events.

System Pr ogramming Over view
Provides information on Norstar systems, sets and lines. Norstar programming
features are accessed from this screen.

System pr ogramming
Customizes Norstar features such as Call Handling and System Speed Dials.

Systems Director y
The main screen and work area in Norstar Manager. All systems contained in the
database can be accessed from this screen.

Systems list
A collection of Norstar systems that are stored in the Norstar Manager database.
This list is displayed on the Systems Director y screen.

Time Diff erence
The time zone difference between a remote Norstar system and the local time at
the PC.
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Title bar
A thick line that appears at the top of the screen. This bar shows the title of the
Norstar Manager screen that appears on your monitor.

Translate
The process of converting information.

Transmission
The transfer of information from the PC to the KSU.

Troub leshooting
A process used to determine what a problem is and the steps used to fix it.

Trunk Car tridg e
A cartridge that is inserted into a Trunk Module. This device provides a connection
to outside lines.

Valid option
Data that is appropriate for a specific field.
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